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GIRIŞ 

 

Kompýuter tehnologiýasy – iň ýaş ugurlaryň biridir. Kompýuter tehnologiýasynyň 

ösüş taryhy beýlekilere garaňda kän bir uly döwri alýan däldir – 40-50 ýyl. Kompýuter 

tehnologiýasy, tehnikasy diýen adalgalar bolsa ondan hem ýaşdyr. Bilişimiz ýaly, 

ilkibaşda elektron-hasaplaýyş maşyn, hasaplaýyş tehnikasy diýen adalgalar ulanylardy. 20 

ýyldan bäri bolsa EHM diýlen adalga ýuwaş-ýuwaşdan ýitip kompýuter adalga öz 

örnuny berdi, tehnika bolsa öňküler ýaly hasaplaýyş dälde kompýuter tehnikasy 

diýlip atlandyrylýar. 

Kompýuter tehnologiýasy ýaş bolmak bilen, dünýäde öňdebaryjy ugurlaryň 

biri bolup durýar. Häzirki wagtda habarlar-aragatnaşyk tehnologiýalaryň ýokary 

depginde ösýändigi barada aýdylýar. Öýjükli telefon aragatnaşygyň, maglumat 

tehnologiýalaryň ösmegi muňa subut bolup durýar. Şol tehnologiýalaryň düzümine 

çuňlaýyn seredilen mahalynda olaryň kompýuter ugruna esaslanýandygyna göz 

ýetirmek bolýar. 

Öz gezeginde, kompýuterler öz düzüminde tehnikanyň başga ugurlarynyň 

soňky derejelerini jemländir. Bu bolsa onuň bilen işlemegi diňe ýeňilletmän, eýsem 

amatly edip goýýar. 

Türkmenistan dünýä ösüşiniň gapdalynda durman, kompýuter tehnologiýalaryň 

soňky gazananlaryny ulanmaklyga ymtylýar. Ýurdumyzda öňdebaryjy tehnologiýalary 

öwrenmeklik boýunça uly işler alnyp barylýar. Şol işlerde Hormatly Prezidentimiziň 

ýardam bermegi olaryň tiz depginde amala aşmagyny üpjün edýär. Ýurdumyzyň 

Baştutany öz gymmatly wagtyny tygşytlaman dünýäniň ösüşindäki ymtylyşlara üns 

berýär we olaryň has netijelilerini döwletimizde gerekli ugurlarda ornaşdyrylmagyna 

ýardam berýär. 

Täze galkynyşlar zamanasynda ýurdumyzyň islendik pudagyň öňünde täze 

meseleler goýuldy. Şol meseleleri üstünlikli çözmek üçin diňe bir tehnologiýalar 

ýeterlikli däl. Şol tehnologiýalary ulanyp biljek ýokary derejeli hünärmenler zerur. 

Türkmen politehniki instituty öz içinde öhümçilikde ulanylýan birnäçe 

hünärleri jemländir. Olaryň arasynda gurluşyk we binagärlik, himiýa, nebit we gaz 

pudagyna degişli hünärler, ykdysadyýeti dolandyryş, mehanika we energetika bilen 

bagly hünärler, hem-de kompýuter tehnologiýasy. 

Kompýuter tehnologiýalary öz düzümine birnäçe ugurlary we dersleri alýar. 

Olara umuman aýdanyňda maksatnama düzme, multimediýa tilsimatlary, grafika we 

bezeg işleri, tory dolandyrma, amallar ulgamy we maksatnama üpjünçiligi, 

kompýuteriň içki gurluşy we ş.m. degişli etmek bolýar. 

Kompýuterler bir wagtyň içinde birnäçe amallary ýerine ýetirýärler. Mysal 

üçin şol bir wagtyň içinde ol çylşyrymly hasap işleri, çap etmegi, ses çykarmagy, 

faýllar bilen işlemekligi we ş.m. amala aşyryp bilýär. 

Häzirki wagtda kompýuterler önümçiligiň islendik pudagynda giňden 

ýaýrandyr. Şonuň üçin hem hasaplaýyş tehnikasy bilen tanyşlyk talyplaryň haýsy 

hünär boýunça bilim alýanlygyna garamazdan öwrenilýär. 

Ýokarda aýdyşymyz ýaly Täze Galkynyş zamanasy täze talaplary bildirýär. 

Her bir hünäriň öz aýratynlygy bar hem bolsa, onuň kompýuter tehnikasy bilen iş 

salyşýan meseleleri hökman bardyr. 
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Binagärlik hünärini alyp görsek. Çylşyrymly çyzgylar takyklygy, dogrulygy, 

bezegi, köplenç köp mukdarda bolmagy talap edýär. Häzirki wagtda kompýuterde 

ulanylýan maksatnamalaryň arasynda inženerçilik-çyzgy maksatnamalar köp ulanyşa 

eýe bolup durýar. Olaryň hataryna AutoCAD, 3DMAX, ArhiCAD we b. 

maksatnamalar. Olar çyzgylary tiz depginde, ýokary takyklyk bilen, ýokary derejeli 

bezegli we göze ýakymly edip taýýarlamagy mümkin edýär. Eldeki çyzgydan 

tapawutlykda, ýörite çap ediş gurluş arkaly islendik mukdarda çap etmegi mümkin 

edýär, şeýle hem ýalňyşlyklar ýüze çykanda tiz we arassa düzetmegi mümkin edýär.  

Gurluşygyň ugurlary üçin hem bu maksatnamalar peýdaly bolýar, sebäbi diňe 

çyzgylary amala aşyrmakdan tapawutlykda, olar ölçegleri goýmagy, çyzgydaky 

desga materialy ulanmak bilen onuň mukdaryny kesgitlemegi üpjün edýär. 

Kompýuter ugry ykdysadyýetdäki çylşyrymly hasapçylyk işlerini amala 

aşyrmagy hem mümkin edýär. Bu ýere diňe, her kişä belli bolan Microsoft Excel 

maksatnamasyny goşman, birnäçe hasapçylyk işlerini ýerine ýetirmek üçin ýörite 

düzülen maksatnamalary goşmak bolýar. 

Himiýanyň önümçilik proseslerini hasaplama işlerinde hem kompýuteriň 

ulanylýandygyny bellemek bolýar.  

Nebit we gaz ugry öz içine dürli hünärleri alýan hem bolsa, olaryň hemmesiniň 

alyp barýan işlerinde kompýuter serişdeleri ulanylýar. Meselem, geologiýa işleriniň 

netijelerini işläp bejermekde GeoFrame toplumy giňden peýdalanylýar.  

Görüşimiz ýaly kompýuter tehnologiýasy pudaklaryň ählisine özleşdirilipdir 

hem-de adaty teskt redaktorlary ulanmak bilen çäklenmän, öz gönümel ugurlary we 

alyp barýan işleri boýunça zerur kompýuter maksatnamalaryny ulanýarlar. 

Bu bolsa ýene bir gezek, Hormatly Prezidentimiziň, dürli ugurdaky 

hünärmenleriň Täze galkynyş zamanasynda kompýuter tehnikasy bilen giňden iş 

salyşmagyny gazanmak baradaky tabşyryklarynyň onuň öňden görüjilik syýasatynyň 

aýrylmaz bölegidigini görkezýär. 

Beýleki hünärleriň kompýuter tehnikasy bilen işlemegini öwretmegiň esasy 

ugurlary barada gysgaça gürrüň edildi. Öz hünärimiziň – gönümel kompýuter 

tehnologiýasynyň esasy öwrenýän talyplar bilen işlenende aýry usulyýet gerek 

bolýar. 

Eger beýleki hünärler kompýuter tehnologiýalary bilen ulanyjylyk ýagdaýda 

öwredilýän bolsa, kompýuter ugrundaky hünärler has ýöriteleşdirilen, dolandyryjy 

we sazlaýjy wezipeleri ýerine ýetirmeklige gönükdirilen ugur bilen öwredilýär. 

Tekst redaktorlary bilen işlenende ýa-da beýleki bir ulanyjy maksatnamalar 

ulanylanda kompýuter bilen işlemekligiň ussatlygy dürli ulanyjylarda 

tapawutlandyrmaýar. Emma şol maksatnamalaryň işini sazlamakda, 

häsiýetnamalaryny goýmakda ýa-da umuma kompýuteriň işini düzetme işlerinde 

tapawut bildirip durmaly. Mundan başga hem, biz öz hünärimiz boýunça 

talyplarymyza maksatnamalary düzmekligi, maksatnamanyň döredijisi bolmaklygy 

öwredýäris. 

Başgaça aýdanyňda, beýleki hünärli talyplar öz ugrundaky meseleleri işlerinde 

kompýuteri netijeli peýdalanmaga öwredilýän bolsa, kompýuter ugrunda 

kompýuteriň özi bir şol meseläniň biri bolup durýar, sebäbi talyplara kompýuteri 

bejermek, sazlamak, gurnamak, onuň üçin maksatnamalary ýüklemek, kompýuterleri 
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torda sazlamak, kompýuterde maksatnama düzmek we ş.m. 

Emma ýokarda agzalan işleriň ýöriteleşdirilen kompýuter ugrundan işleýän 

hünärmenler üçin gönükdirilen hem bolsa, olar kompýuteriň islendik ulanyjysy 

tarapyndan özleşdirilmegi mümkin. 

Kitap taýýarlanylanda maglumat we bezeg maksatnamalary dersini doly 

öwredip, olaryň dürli işlerde zerur bolan çyzgylary hem-de beýleki maglumatlary 

kompýuter grafikasynyň programmalary arkaly bezemegi, we göze ýakymly 

ýagdaýda çap etmegi öwretmek wezipelerinden ugur alyndy.    

Kitabyň esasy maksady okyjylara ýazgy redaktorlar  we kompýuter 

grafikasynyň programmalary arkaly maglumat we bezeg işleri alyp barmagy, şol 

programmalary utgaşykda işledip dürli bezeg önümlerini taýýarlamagy, işläp 

bejermegi öwretmekdir. 

Kitapda grafiki programmalarynyň has meşhur bolanlary öwrenilip geçilýär. 

Ondan başga hem, neşir önümlerini çykarmakda ulanylmagyň lideri bolan Adobe 

PageMaker programmasynyň grafiki programmalar bilen utgaşmasyna aýratyn üns 

berlen. Kitabyň ýene bir esasy maksady - okyjylaryň öz işlerinde grafikany has 

giňden ulanyp, öz bezeg mümkinçiliklerini artdyrmaklygy bolup durýar. 

Kitap kompýuter tehnologiýasy ugrunda işleýänler we okaýanlar üçin hem 

niýetlenen bolsa, ondan başga höwesjeň adamlar hem peýdalanyp bilner. 
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ADOBE PAGEMAKER PROGRAMMASYNYŇ IŞ MEÝDANYNY GÖZDEN 

GEÇIRMEK. IŞ MEÝDANYNYŇ OTNOSITELLIGI. GURALLAR 

TOPLUMYNYŇ ULANYLYŞY. 
 

1. Adobe PageMaker programmasynyň iş meýdanyny gözden geçirmek.  

2. Iş meýdanynyň otnositelligi.  

3. Gurallar toplumynyň ulanylyşy. 

Häzirki döwürde biziň Garaşsyz ýurdumyzda metbugat gullugyna örän güýçli 

üns berilýär. Biziň Garaşsyz Türkmenistanymyzyň her welaýatynda metbugat 

gullugy hereket edýär. Bu gullugyň üsti bilen biz her gün ýurdumyzda we dünýäde 

bolup geçýän täzelikler bilen tanyşyp durýarys. Metbugat gullugynyň bir bölegi 

hem poligrafiýadyr. Poligrafiýa önümçiliginde ulanylýan kompýuter 

programmalarynyň bize bellileriniň bimäçesiniň üstünde durup geçeliň. 

Ol programmalaryň biri hem PageMaker-dir. PageMaker-iň bize belli bolan 

görnüşleri, ýagny PageMaker 4.0, PageMaker 5.0, PageMaker 6.0, PageMaker 6.5, 

PageMaker 7.0 bardyr. Bu programmanyň üsti bilen häzirki döwürde dünýäniň 

hemme ýerinde diýlen ýaly gazýetdir-žurnallar, kitapdyr-broşýuralar we ş.m ýerine 

ýetirilýär. PageMaker programmasynda beýleki programmalar ýaly özüniň gurallar 

paneli boly ar. Şol gurallar panelini ulanmak bilen biz tekstleriň üstünde her-hili 

amallar geçirip bolýar. Meselem, tekstleriň formatynyň üstünde işlemek. Mundan 

başga-da suratlary tekste ýerleşdirmek, suratlaryň ölçegini üýtgetmek, obýektleriň 

üsnünde işlemek we ş.m. ýaly işleri geçirip bolýar. 

 Poligrafiýa önümçiliginde esasy orný eýeleýän programmalaryň biri hem 

Adobe PhotoShop-dyr. Bu programmada grafiki faýllaryň üstünde birnäçe amallar 

ýerine ýetirilýär. PhotoShop programmasy esasan surtlary redaktirlemek üçin 

niýetlenendir. Bu programmanyň ýene bir mümkinçilikleriniň biri hem suratlary 

montaž etmekdir. Bu usulda her hili reklamalar, wizitkalar we beýleki işleri ýerine 

ýetirmek bolýar. Mundan başgada surata uly bolmadyk tekstleri ýerleşdirmek işlerini 

hem amala aşyryp bolýar. PhotoShop programmasynda esasy üns bermeli 

bölümleriň biri hem reňkleriň üstünde işlemekdir. Biz belli bolşy ýaly: Grayscale, 

Indexed Color, RGB Color, CMYK Color, Lab Color, Multichannel we ş.m. 

režimleri bardyr. Ýene-de bu programmada bellemeli bölümleriň biri hem 

filterlerdir. Bu bölüm suratlary montaž etmekde ulanylýar. Umuman PhotoShop 

programmasy' poligrafiýa önümçiliginde esasy programmalaryň biri bolup gažýar. 

Poligrafiýa önümçiliginde esasy orný eýeleýän programmalaryň ýene-de biri 

CorelDraw-dyr. CorelDraw programmasy poligrafiýada reklama obýektlerini 

taýýarlamak, suratlaryň östünde dizan etmek, tekstleri her hili görnüşde 

owadanlamak- we ş.m ýaly işleri geçirip bolýar. Bu programmada hem PhotoShop 

programmasy ýaly birnäçe mümkinçilikleri bardyr. Munuň hem ozone degişli 

filtirleri bolýar. Şol filterleriň üsti bilen dizaýn işleri ýerine ýetirilýär. Häzirki 

döwürde CorelDraw programmasy poligrafiýada esasy ulanylýan programmalaryň 

biridir. 

Bu programmalardan başga-da Adobe Acrobat, FineReader, Adobe 

ImageReady ýaly programmalar hem giňden ulanylýar. 
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Adobe PageMaker programmasynyň iş meýdanyny gözden geçirmek. 

PageMaker programmasynyň iş meýdanynda: instrumentler paneli, garfiki we 

tekst obýektleri dolandyryjy gurallar, sahypa sanyny görkezijiler, ölçeg abzallary 

(Rulers), ulanyşda tekstleriň stilleri we reňkleri görkeziji panel, ulanylýan iş 

meýdany we beýlekileri hödürleýär. 

 

 
 

 

Ýokardan PageMaker programmasynyň iş meýdany görkezilendir. Şu iş 

meýdanynyň üsti bilen biz gerekli tekstdir suratlary ýerleşdirip bilýäris. Şu ýerde uns 

bermeli zatlaryň biri hem, ýagny Microsoft Office ýaly sahypany awtomat goýman, 

eýsem ony özüň bermeli bolýar. 
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Gurallar toplumynyň ulanylyşy. 

Iş meýdanyna gurallar toplimyny getirmek üçin Windows->Show Tools 

girmeli. Eger iş meýdanyndan gurallar toplumyny aýyrmak üçin Windows->Hide 

Tools girmeli. 

A-Tekst we grafiki obýektleriň. üstünde işlemek. 

Ýagny grafiki we tekst obýektleri bellemek we gerekli ýerine 

süşürmek. B-Bellenen obýektleri aýlamak (berlen gradiusa • 

aýlamak). C - Bir nokadyň üstünden islendik tarapa çyzyklar 

çyzmak. D - göniburçlyk çyzmak üçin ulanylýar. E-Ellips we 

töwerek çyzmak üçin ulanylýar. F - Köpgranlyk gurmak üçin 

ulanylýar. G - Sahypany ekranda. gerekli ýerine süşürmek 

ýa-da gipertekstli salgylamalara girmek üçin ulanylýar: H -

Tekstleri bellemek we redaktirlemek üçin ulanylýar. I - 

Grafiki obýektleri gerekli şlçegiňde kesmek üçin ulanylýar. J 

- Wertikal we gorizontal çyzyklary çyzmak öçin ulanylýar. K 

- Figurany burçlara bölüp çyzmak. L - Sahypany gerekli 

ölçegiňde görkeziş ölçegiňi ulaltmak ýa-da kiçeltmek.  

A. Pointer tool( +Fl) 

B. Rotating tool ( + F2) 

C. Line tool ( + F3) 

D. Rectangle tool ( + F4) 

E. Ellipse tool ( + F5) 

F. Polygon tool ( + F6) 

G. Hand tool ( + F7), Constrained-hand tool (  + + drag) 

H. Text tool ( + +Fl) 

I. Cropping tool (  + + F2)  

J. Constrained-line tool ( + + F3)  

K. Rectangle frame tool (  + + F4)  

L. Ellipse frame tool (  + + F5)  

M. Polygon frame tool (  + + F6)  

N. Zoom tool ( + + F7) 

 

Tejribe işleri 

Adobe Page Maker maksatnamasyny Windows amallar ulgamyna ýülemek 

we ony aktiwirlemek (ýumuş hemme talyplar üçin deň edip berilýär): 

a) Programmanyň gurnalýan görnüşini saklaýan bukjany kesgitlemek. 

b) Readme atly *.txt ýa-da *.doc faýlyny okap görmeli 

c) Setup.exe ýa-da install.exe faýly goýbermeli. 

d) Next, Ýes, Ok, Continue, Accept, Finish, Далее, Да, Продолжить, Согласен, 

Готово düwmejiklere basmak bilen programmny ýüklemek 

e) Bukjada ýerleşen faýldan seriýa nomeri alyp gerek ýerde ony girizmek 

f) Crack bukjasyndan Crack.exe faýlyny goýbermek 
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REŇKLERIŇ ÜSTÜNDE IŞLEMEK. SAHYPANY GÖZDEN GEÇIRMEK. 

SAHYPANYN GÖRNÜŞLERINI SAÝLAMAK. GURALLAR TOPLUMYNYN 

GYSGALDYLAN GÖRNÜŞLERINI ULANMAK. 
1. Reňkleriň üstünde işlemek. 

2.- Sahypany gözden geçirmek. 

3. Sahypanyn görnüşlerini saýlamak. 

4. Gurallar toplumynyn gysgaldylan görnüşlerini ulanmak. 

Reňkleriň üstünde işlemek. 
Iş meýdanyna gurallar toplimyny getirmek üçin Windows^Show Colors (Ctrl-J) 

girmeli. Eger iş meýdanyndan gurallar toplumyny aýyrmak üçin Windows->Hide 

Colors (Ctrl-J) girmeli. 

 

 
 

Bu bölümde biz reňkleriň üstünde geçirilýän işlere seredip geçeris. Ýagny bu 

gural PageMaker programmasynda islendik obýektlere reňk bermek üçin 

niýetlenendir. Suratda görkezilişi ýaly birinjisi (çepde)-ştrihleri reňklemek, ikinjisi 

(ortada) - islendik teksti ýa-da obýekti reňk bilen doldurmak, üçünjisi (sagda) -

birnäçe obýektleri ýa-da ştrihleri bilelikde reňklemek. 

Eger-de siz reňklenen obýewktleriň reňkini üýtgetjek bolsaňyz, onda 

PageMaker öňki duran reňki aýyrýar we taze 

bellenen reňki guýýar. Islendik ilkibaşda guýlan 

reňkden galan tegmilleri hem beýleki çalşylan 

reňk bilen doldurýar. Mundan başga-da gerek 

bolmadyk reňkleriňizi aýryp bilýärsiňiz. 

Haçanda, Siz reňki aýranyňyzda PageMaker 

islentik tekste ýa-da grafiki obýektlere gara 

reňki ulanýar. Bellik: Siz [None], [Paper], 

[Black] we [Registration] - reňkleri hiç-hili 

öçürip bilmeýärsiňiz. Ýene bir üns bermeli 

zatlaryň biri hem EPS formatda import edilen 

grafiki faýllary öçürip bilýärsiňiz, eger-de EPS 

grafikasy ulanyşdan aýrylan bolsa. 

Reňkler guralynda görkezilen reňkleri Color Options menýusyna girip 

üýtgedip bolýärsiňiz. PageMaker programmasynda reňkleriň RGB (Red, Green, 

Blue), HLS (Hue, Lightness, Saturation), CMYK (Cyan, Magenta, Yellow, Black) 

režimleri bardyr. 
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Sahypany gözden geçirmek. Sahypanyň görnüşlerini saýlamak. 

Boş ýerde Master sahypany döretmek üçin: 

Window menýudan -> Show Master Pages saýlamaly. 

Siz ekranyňyzda şu aşakdaky şekili görersiňiz: 

 
 

Belli bir sahypada ulanmasaňyz Master sahypasy hiç-hili effektiwlik döretmez 

Master sahypasyny döretmegiň asyl manysy, haçahda Siz sahypalarda grafiki we 

tekst obýektleri ulanmaly bolanyňyzda gerek bolýar. Meselem sahypany nomerlemek 

ýa-da sahypanyň islendik ýerinde grafiki obýekti goýmak. 

 
Master sahypany ulanylmadyk ýagdaýy (çepde), Master sahypany ulanylan 

wagty (sagda). 

PageMaker programmasynda sahypa goşmak üçin sahypa sanyny görkeziji 

listiň üstüne syçanjygyň sag düwmejigini basmaly, şonda Add One Page - bir sahypa 

goşmak, Insert Pages - birnaçe sahypa goşmak (ýagny sahypanyň öňüne (before) ýa-

da yzyna (After) goşmak), Remove Pages - sahypany ýa-da sahypalary aýyrmak. 
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Master sahypasynda siz beýleki sahypalar ýaly islendik operasiýalary geçirip 

bilersiňiz, ýöne siz bu sahypany üýtgewsiz etmelisiňiz. Yokarky suratda Master 

sahypasy görkezilen. Master sahypasy iki bölümden, ýagny çepki (L) we sagky (R) 

durýar. Master sahypasynyň iki režimi bardyr, ýagny iki sahypaly (L,R) we bir (R) 

sahypaly. 

 
A. Düwmejigi ulanmak. B. Paragraiyň düwmejiklerini hödürleýär. C. Şriftleri 

saýlamak. D. Tipleriň ölçegini saýlamak. E. Harplaryň arasyny saýlaýjylar. F. 

Kerningi saýlamak. G. Stiliň tipini görkeziji düwmejikler. H. Saýlow düwmejigi. I. 

Ýerleşdiriji düwmejikler. J. Setiriň arasyny sazlaýjy düwmejik. K. Harplary 

gorizontal ölçegini üýtgediji düwmejik. L. Esasy saýlanan obýektleri üýtgetmek. 

 
A. Düwmejigi ulanmak. B. Paragraiyň düwmejiklerini hödürleýär. C. 

Paragraiyň stilini saýlamak. D. Kursoryň indikatory. E. Yüzlenmäniň ilkinji saýlawy. 

F. Saýlowdan soň öňe we yza süýşürmek. G. Setkäniň ölçegini bermek. H. Teksti 

ýerleşdiriji (dogmlaýjy) düwmejik. I. Çep tarapdan saýlamak. J. Sag tarapdan 

saýlamak. K. Setkä dogurlamak. 

Special Characters 

RESULT  ACTION 

Bullet (.) Alt+ 8 

Copyright symbol (©) Alt + G 

Ellipsis (...) Alt + 0133 (on numeric keypad, Num Lock on) 

Degree (°) Alt + 0176 (on numeric keypad, Num Lock on) 

Iparagraph(¶) Alt+ 7 

Open typographer's 

quotations (") 

Alt + + [ 
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Close typographer's 

|quotations (") 

Alt + + ] 

Open single quotations (`) Alt + [ 

Close single quotations (') Alt + ] 

Foot mark (') Ctrl + Alt + ' 

Inch mark (") Ctrl + Alt + + " 

Registered trademark (®) Alt + R 

Trademark (TM) Alt + 0153 (on numeric keypad, Num Lock on) 

Section (§) Alt+ 6 

Page number Ctrl + Alt + P 

Em space Ctrl + + M 

En space Ctrl + + N 

Thin space (1/4 em) Ctrl + +T 

Nonbreaking (fixed) space Ctrl + Alt + spacebar 

Forced line break or soft 

ireturn 

 + Enter 

Discretionary (soft) hyphen Ctrl + + - 

Nonbreaking hyphen Ctrl + Alt+ - 

Nonbreaking slash Ctrl + Alt + / 

Em dash Alt + + - 

En dash Alt + - 

English pound (£) Alt + 0163 (on numeric keypad, Num Lock on) 

Japaneseyen (¥) Alt + 0165 (on numeric keypad, Num Lock on) 

 

Tejribe işleri 

File menýusynyň buýruklary arkaly döredilýän sahypanyň ölçeglerini 

üýtgetmek: 

1) A4 formatda boş sahypany döretmek 

2) Ini 220 mm, beýikligi 114 mm boş sahypany döretmek 

3) Rugsady 150 dpi bolan boş sahypany döretmek 

4) Ini 18 inches, beýikligi 9 inches bolan boş sahypany döretmek 

5) Sahypanyň rugsadyny ulaltmak 

6) Sahypanyň rugsadyny kiçeltmek 

7) Sahypanyň gyralarynyň ölçegini üýtgetmek 

8) Sahypanyň çäklerini aýyrmak 

9) Sahypanyň çäklerini üýtgetmek 

10) A3 formatda boş sahypany döretmek 
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TEKSTIŇ WE GRAGIKANYŇ ÜSTÜNDE IŞLEMEK. WINDOWSHADES 

KOMANDASYNYŇ ÜSTÜNDE IŞLEMEK. SAHYPALARYŇ ARASYNDAKY 

HEREKETLER. SAHYPANY GOŞMAK WE AÝYRMAK. 

 

1. Tekstiň we gragikanyň üstünde işlemek. 

2. Windowshades komandasynyň üstünde işlemek. 

3. Sahypalaryň arasyndaky hereketler. Sahypany goşmak we aýyrmak. 

Adobe PageMaker programmasynda ýörite teksti ýygmak üçin test redaktory 

bardyr. Ol Edit menyusynda ýerleşýän Edit layout (Ctrl-E) komandasy ýerine 

ýetirýär. Edil Microsoft Office ýaly tekstleriň üstündäki ammallar geçirip bolýar. 

Eger PageMaker programmasyna ýerleşdirilen teksti redaktirlejek bolsaň, onda tekst 

režimine girip redaktirleseň has amatly bolýar. Bu tekst redaktory haçanda uly 

göwrümli tekstleriň üstünde 

işlenende ulanylýar. 

Meselem, şeýle ýagdaýlar 

gabat gelýär, ýagny tekstde 

käbir harplary ýa-da 

simwollary degişli 

harplardyr simwollara 

bölmeli bolýar. 

Adobe PageMaker-iň 

tekst redaktorynda faýýlary 

tekst režimine geçirmek 

üçin File menyusynda 

Export komantasynda d 

Text bölümi saýlamaly. 

Şondan soň Export 

Document penjiresinden Save as type bölüminden Text-only komandany saýlamaly. 

Tekst saýlanyp alnandan soňra, indiki mesele teksti nähili formatda ýerleşdirmeli 

diylen mesele ýüze çykýar. Teksti ýerleşdirmek: 

 

1. Ilki bilen teksti sahypada hähili goýmaly, onuň üçin işçi meýdanynda 

ýerleşdirilen instrumentlar panelinde obýektleriň üstünde işlemek bölümine geçmeli. 

 2. Tekst saýlanyp alnandan soňra teksti ýerleşdirmek. 

 3. Obýekti gerekli ýeriňe süýşürmek. Munuň üçin tekstiň üstünde syçanjygyň 

çep düwmejigini basyp durmaly (surata seret) we belle bir wagtdan soňra obýekti 

alyp gerekli ýeriňe süýşürmeli (syçanjygyň çep düwmejigi basylgy ýagdaýda 

bolmaly). 
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Isiendik teksti ýerleşdirmekligiň ýene bir usuly instrumentler panelinden tekst 

(T) düwmejigini saýlamaly. Ondan soňra teksti ýerleşdirjek obýektiňi görkezmeli 

(Surata seret). Obýektiň üstünde işlemek bülümden tapawutlylvkda bu ýagdaýda siz 

tekstiň granisalaryny görüp bilmeýärsiňiz. 

 

 

 

 

 

 

 

 

 

 

 

Adobe PageMaker programmasynda ramkalary (frame) döretmek. Munuň üçin 

Element menýusynda ýerleşýän Frame komandasynyň Frame Options bölümine 

girmeli. Aşakda suratda görkezilen. 

 

 

 

 

 

Ýene bir bellemeli zatlaryň biri hem sahypada ýerleşdirilen surata tekst 

ýerleşdirmek. Suratdan görşüňiz ýaly tekst obýektleriniň ýerleşdirilişi görkezilen. 

 

The 
rabbit 
hole went 
straigbt 
on like a 
tunnel for 
some waj 
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Surata tekst goýlanda hem edil beýleki tekst obýektleriň üstünde geçirilýän 

operasiýalar ýaly edilýär. Islendik ýagdaýda teksti gerekli ýeriňe süýşürmek we 

tekstiň ölçegini üýtgetmek bolýar. 

 

Windowshades komandasynyň üstünde işlemek. 
Windowshades - bellenip alnan tekstiň granisalaryny we gorizintal obýektleriň 

depelerini baglanyşdyrýar. 

 

A. Windowshades-iň boş halkajygy, ol obýektiň ýokarky çägini we tekstiň 

başlangyjyny görkezýär. B. Boş halkajyk, ol obýektiň soňy bolmak bilen tekstiň hem 

soňuny görkezýär. C. Bu ýerde "+" belgisi obýektiň beýleki obýekt bilen 

baglanyşygyny görkezýär. D. Bu ýagdaýda tekstiň dowamynyň bardygyny görkezýär 

(dowam etdiriji belgi). E. Tekst ýerleşdirilen obýektiň ölçegini üýtgetmek. 

 

Sahypalaryň arasyndaky hereketler. Sahypany goşmak we aýyrmak, 
PageMaker programmasynda sahypa nomer goýmak Alt+Ctrl+P (Ctrl+Shift+3) 

üsti bilen amala aşyrylýar. Munuň üçin ilki bilen tekst režimine (T) geçmeli, 

sahypany goýjak ýeriňizi görkezmeli. Mundan başga-da sahypada nomeriň ýanynda 

islendit tekstiňizi ýerleşdirip bilersiňiz. 

 

 

A 

D E 

B 
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Sahypany goýmak prosessi Master sahypada bolup geçýär. Egerde sahypaňyz 

ikileýin bolsa (LM, RM), onda hersi üçin aýratyn sahypa goýmaly diýen komandany 

ulanmaly bolýar. 

 
 

PageMaker-de sahypa goşmak ýa-da aýyrmak üçin Layout menýusynda Insert 

Pages-sahypa goşmak (Ctrl+Alt+Shift+G) ýa-da Delete Pages-sahypany aýyrmak 

komandalary ýerine ýetirýär. Mundan başga-da sahypanyň aşak tarapynda sahypany 

görkezijinin üstüne syçanjygy eltip sag düwmejigi basmak ýeterlikdir. Layout 

menýusynda ýene bir komandanyň biri hem Go to Page - bu gerekli sahypaňa çalt 

geçmek üçin ulanylýar. Mundan başga-da Sort Pages komandasy bardyr, bu 

sahypalary sortirowka etmek üçin ulanylýar. 

 

Tejribe işleri 

File menýusynyň buýruklary arkaly döredilen ýa-da açylan sahypanyň 

ölçeglerini üýtgetmek: 

1) Sahypany A3 formatdan A4 formada geçirmek 

2) Sahypany A4 formatdan A3 formada geçirmek 

3) Rugsady 150 dpi bolan sahypany 300 dpi edip goýmaly 

4) Ini 18 inches, beýikligi 9 inches bolan sahypany ini 9 inchesç beýikligi 18 

inches ölçegde goýmaly 

5) Sahypanyň rugsadyny ulaltmak 

6) Sahypanyň rugsadyny kiçeltmek 

7) Sahypanyň gyralarynyň ölçegini üýtgetmek 

8) Ölçegleri inches-den mm-e geçirmek 

9) Ölçegleri mm-den inces-e geçirmek 

10) Sahypany Story ýagdaýa getirmek 
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DEFINE STYLES KOMANDASYNY ULANMAK. MASTER SAHYPASYNY 

DÖRETMEK WE ULANMAK. 

1. Define Styles komandasyny ulanmak. 

2. Master sahypasyny döretmek we ulanmak. 

 

Define Styles komandasyny ulanmak. 
Adobe PageMaker programmasy hem Microsoft Office programmasyndaky 

ýaly stilleriň üstünde işlemäge mümkinçilik berýär. Stiliň ýerine ýetirýän işleri teksti 

gerekli formatda formatirlemekdir. 

Stiliň döredilişi: 

1. Stili döretmek üçin Type menýusynda Define Styles (Ctrl-3) komandasynda 

girmeli. Suratda görşüňiz ýaly PageMaker programmasynyň öz hödürleýän 

bölümlerini görýärsiňiz. 

 
 

  Eger stili özüňizçe üýtgetmek isleseňiz, onda Define Styies penjirede ýerleşýän 

öňki stilleri aýyrýarsyňyz. Ony aýyrmak üçin Remove komandasyna girmeli.(Surata 

seret). Kursoryň duran ýerinde ýerleşýän stili Remove düwmejigi basmak bilen 

aýyryp bolýar. 
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3. Gerekli stiliňi döretmek üçin New düwmejige girýärsiňiz, ol ýerde siz Styles 

Options penjiresine girýärsiňiz. 

 
4. Styles Options penjiresinde ýerleşýän Name diýen bölüme Siz stiliň adyny 

berýarsiňiz, meselem, "sozbaşy". 

 
5. Indiki ädimimiz, ýagny döretjek stilimiziň nähili şriftde, şriftiň ölçegi, şriftiň tipi 

(Normal, Bold, Italic,Underline, Reverse, Strikethru), şriftiň reňki, tekstdäki setirleriň 

arasy, harplaryň träkleri (No trac, Very loose, Loose, Normal, Tight, Very tight), 

ýagny harplaryň duruş ýagdaýlary. 

 

 
 

6. Indiki bölümde, ýagny Paragraph Spesifications, bu bölümde teksti nähili formatda 

ýerleşdirmeli, ýagny teksti çepeden näçe aralykda goýmak (Left), tekste abzas 

goýmak (First) we sagadan näçe aralykda goýmak (Right), şol sanda tekstiň ýokary 

we aşak çägi nähili bolmaly (Before, After). Bu penjirede ýene-de bir bölüm, ol hem 

Alignment-dir. Bu komanda teksti gerekli ýeriňde ýerleşdirmek işini ýerineýetirýär 

(Left, Center, Right, Justify, Force justify). Dictonary bölümde esasan dil saýlanýar, 

bu bölüm haçanda tekste bogunlaryň üstünde işlenende ulanylýar. Mundan başga-da 

Options bölümi bardyr. Bu bölüm özgezeginde setir bilen, sütün bilen, sahypa bilen, 

penjireler bilen we ş.m. bilen işlenilende ulanylýar. 



 17 

 
7. Paragraph Specifications penjiresinde Rules diýen düwmejigi basmak bilen 

Paragraph Rules penjiresine girýäris. Bu penjirede esasan setirde ýerleşen tekstleriň 

üstünden ýa-da aşagyndan çyzyk çyzmak işini ýerine ýetirýär. Bu çyzyklaryň reňki, 

galyňlygy nähili bolmaly diýen bölümleri hem öz içine alýar. Suratdan görşüňiz ýaly 

bu bölüm hem öz içine birnäçe bölümleri akýar. Meselem, Options menýusy, bu 

bölüm setiriň ýokarsyndan (Top) we aşagyndan (Bottom) goýmaly ýerleri 

kesgitleýär. 

 
8. Define Styles penjiresinde ýerleşýän ýene bir düwmejik Tabs-dyr. Bu düwmejigiň 

ýerine ýetirýän işi, ýagny tekstleriň arasynda goýulýan boş öýjükleriň ölçegini 

bermekdir. 

 
 

9. Iň soňky düwmejigimiz Hyphenation-dyr. Ol haçanda sözleriň bogunlarynyň 

üstünde işlenende uianylýar. Meselem, sözleri boguna bölmek, dil saýlamak. 
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Master sahypasyny döretmek we ulanmak. 

Biz Define Styles bölümi özleşdirenimizden soňra Master sahypany döretmek 

galýar. Haçanda tekstiň üstünde işlenende PageMaker programmasynda ilkinji 

nobatda tekst nähili ýagdaýda bolmalydygyny kesgitlemeli, şondan soňra tekstiň 

stilini düzmeli. Master sahypasynda düzülen tekst şol faýlyň hemme sahypalaryna 

degişlidir. 

 

Tejribe işleri 

Ýalňyşlyklar bilen işlemek. Neşir işlerini üýtgetmek, ýok etmek we yzyna 

gaýtaryp getirmek. 

1) Sahypany çap edilýän formatda dogry goýmak 

2) Sahypany çap edilýän rugsada dogry goýmak 

3) Faýlyň açylmagynda ýüze çykýan ýalňyşlygy döredip, soňra kesgitlemek 

4) Sahypa obýektler göçürilende çykýan ýalňyşlyklary düzetmek 

5) Tekstiň harplarynyň dury görkezilmeýändigini düzetmek 

6) Preferences menýusy arkaly emeli näsazlyklary döretmeli 

7) Emeli döredilen näsazlyklary düzetmek 

8) Şrift bilen baglanyşykly ýalňyşlyklary düzetmek 

9) Sahypa ýatda saklanylanda ýüze çykýan näsazlyklary düzetmek 

10) Nädogry tekstiň formatirlenmesini yzyna gaýtarmak 
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ELEMENT MENÝUSE. FRAME, ARRANGE, TEXT WRAP, IMAGE, 

POLYGON SETTINGS, ROUNDED CORNERS. 
 

1. Element menýuse. 

2. Frame, Arrange, Text Wrap, Image, Polygon Settings, Rounded Corners. 

 

Adobe PageMaker programmasynda Element menýusy grafiki bölümler 

bilen işlenende ulanylýar. Element menýusy öz düzümine: Fill, Stroke, Fill and 

Stroke, Frame, Arrange, Align Objects, Text Wrap, Group, Ungroup, Lock Position, 

Unlock, Mask, Unmask, Image, Polygon Settings, Rounded Corners, Link Info, Link 

Options, Non Printing, Remove Transformation ýaly bölümleri öz içine alýar. 

 

Frame 

Siz PageMaker-iň döreden islendik obýektlerini gurallar paneliniň üsti bilen 

süýşürip, ölçegini ulaldyp we kiçeldip bilýärsiňiz. Haçanda tekst redaktirlenende 

onuň ölçeglere hiç-hili täsiri ýokdur. Tekstdir grafiki faýlyň ölçegi üýtgedilende 

aşakdaky görkezijä girmeli 

Element > Frame > Change to Frame. 

 
PageMaker-de çyzylan göniburçlyk (çepde) we frame tarapyndan çalşylan 

gönüburçlyk (sagda). 

Tekst ramkalarynyň tekst bloklardan aratapawudy: 

• Tekstiň ýerleşişini göz öňüne tutup tekstleri biri-birine baglamak; 

• Teksti täzeden üýtgetmek, ýagny goşmak, aýyrmak, tekstiň formatyny 

üýtgetmek we ş.m tekstiň başlangyç uzynlygyny saklamak; 

• Tekstiň wertikal dogrulygyny saklamak (tekst mümkin esasy sütünlere we 

ýokary çägine deňleşdirilen bolmagy); 

•  Islendik obýektler - göniburçlyk, owal ýa-da köpburçlyklar tekstiň 

formatyny üýtgetmegj .mümkin 

Tekst ramkalary uly göwrümli tekstler ýerleşdirilende (gazetler we žurnallar) 

ilki bilen şol tekstleriň tutjak göwrümi göz öňüne tutulýar. 
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Arrange 
PageMaker obýektleriň üstünde işlenende, ýagny bir sahypa ýerleşdirilende 

obýektleri biri-biriniň üstünden ýerleşdirmeli boly ar. Şeýle ýagdaýda zakaz edijiniň 

talabyna görä ýerleşdirilýär. Yöne gerek bolsa talaplary üýtgedip hem bolýar. 

Sahypada goýlan obýektleri tutmak Ctrl düwmejigiň üsti bilen amala aşyrylýar. 

 
 

Obýekt yzky bölümde (çepde), obýekt obýektleriň ortasynda (oitaky) we 

obýekt obýektleriň öňünde (üstünde) (sagda). 

Haçanda obýekt öçürilende onuň beýleki obýektler bilen başlangyç 

arabaglanyşyklaryny aýyrmaly, şondan soň öçürmeli. 

Text Wrap 
Islendik publikasiýalarda wizual hereketleri etmek üçin islendik grafiki 

obýektiň töweregine tekstleri ýerleşdirmekdir. 

Grafiki obýektleriň töweregine teksti ýerleşdirmk: 

1. Grafiki obýektleri saýlamaly; 

2. Choose Element > Text Wrap. 

 

 
 

3. Wrap opsiýasynyň ortaky nyşanjygy basmaly (sagky nyşanjyk aktiw däldir). 

4. Tekst Flow bölümden gerekli nyşanjygyňy saýlamaly. 

Çepki nyşanjykda tekst grafiki simwola geçýär we teksti indiki sahypadan 

dowam etdirýär. Ortaky nyşanjyk teksti grafiki simwola geçirip teksti şol sahypada 

dowam etdirýär. Sagky nyşanjyk grafiki obýektleriň töweregine teksti ýerleşdirýär. 
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5. Tekst bilen grafiki obýektleriň arasyny görkeziji Standoff in komandasy. Gerekli 

ýagdaýynda tekst bilen grafiki obýektiň aralygyny öz eliň bilen hem sazlamaga 

mümkinçilik berýär. 

6. Eger-de tekstiň töweregine başga bir teksti ýerleşdirjek bolsanyň onda 

Element menýusyndan Group komandasyna girmeli. Group komandasy tekstili blogy 

grafiki simwollara öwürýär. Şondan soň grafiki simwola öwrülen teksti beýleki 

tekstiň gerekli ýerinde goýup Text Wrap komandanyň üsti bilen ýerleşdirip bolýar. 

 

7. Eger grafiki obýektiň üç tarapyna tekst ýerleşdirmeli bolsa, onda grafiki 

obýekti sahypanyň çep ýa-da sag tarapyna dogurlamaly. 

 

Image 
PageMaker reňkli suratlary RGB režiminden CMYK režimine çenli üstünde 

işlemäge mümkinçilik berýär. TIFF formatly suratlarda CMYK režimini täzeden 

dikeltmäge (ýokary hilli) mümkinçilik berýär. 

PageMaker-de suratyň üstünde işlenilende Element->Image komandasyna girmeli. Ol 

ýerde üç bölüm Image Control, CMS Source we PhotoShop Effects bardyr. Şolaryň 

üsti bilen suratlary redaktirläp bolýar, ýöne suratyň formaty mümkin boldugyça TIFF 

format bolmalydyr. 
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PageMaker CMYK režimini döredýär ýa-da TIFF formatyň başlangyç reňkini 

goýaldýar ýa-da solaldýar. Täze surat capa çykmazdan öň görmäge mümkinçilik 

bolýar. Eger gerek bolsa siz faýlyň öňkisi bilen arabaglanyşyk gurnap bilersiňiz. 

 

Tejribe işleri 

QuarkXPress we Microsoft® Publisher® 97-2000 dokumentlerini öwrüjileriň 

üsti bilen Adobe PageMaker programmasynda açmak (ýumuşlar ikä bölünip 

talyplara paýlanýar): 

1) QuarkXPress öwrüjiň üsti bilen Adobe PageMaker programmasynda 

resminama açmak 

2) Microsoft® Publisher® 97-2000 öwrüjiň üsti bilen Adobe PageMaker 

programmasynda resminama açmak 
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TYPE MENÝUSY. CHARACTER, PARAGRAPH, INDENTSVTABS, 

HYPENATION, ALIGNMENT KOMANDALARY. 
1. Type menýusy. 

2. Character, Paragraph, Indents\Tabs, Hypenation, Alignment komandalary. 

Adobe PageMaker programmasynyň Type menýusynda esasan tekst režimlerinde 

işlenende ulanylýar. Bu ýerde tekstleriň ölçegini, görnüşini, tekstdäki setirleriň 

arasyny we ş.m baradaky komandalar ýerleşdirilendir. 

Type menýusy öz düzümine: Font, Size, Leading, Type Style, Expert Kerinig, 

Expert Traking, Horizontal Scale, Character (Ctrl-T), Pharagraph (Ctrl-M), 

Idents/Tabs (Ctrl-I), Hyphenation, Augment, Style, Defme Styles bölümleri alýar. 

Font komandasynda Windows operasion ulgamynyň dikeldýän şriftleri 

ýerleşdirilen. Mundan başga-da özüňe gerekli şriftleri hem goşmak bolýar. Şrift 

goşulanda Start düwmejigiň kömegi bilen Settings bölümde ýerleşýän Control Panel 

penjiresine girmeli, ol ýerde Fonts diýen bölüme girmeli. Şol ýerde Windows 

operasion ulgamynyň dikelden hemme şriftlerini görmek bolýar. Eger-de özüňize 

gerekli şrifti dikeltjek bolsaňyz onda Fonts bölümde ýerleşdirilen File^Install New 

Font bölüme girmeli. 

Size komandasy bu tekstiň ölçegleri bilen işleşýän bölümdir. Bu bölümde iň 

kiçi 6 we iň uly 72 san belgileri görkezilendir. Adobe PageMaker harplaryň 

ölçeginiň üstünde 4-den 650-ä çenli aralykdaky ölçegleri öz içine alýar. Eger-de 72-

den uly ölçeg bermekçi bolsaňyz, onda Other komandasynyň üsti bilen ýerine 

ýetirilýär. 

  Character Specifikations bölüminde bir wagtda tekstiň hemme häsiýetleriniň 

üstünde durlup geçilýär. Meselem, Font bölüminde özüňe gerekli şriftleri saýlamak 

bolýar, şol sanda Size bölüminde hem gerekli ölçegiňi saýlamak bolýar. 

 
 

Leading bölümi tekstdäki setirleriň aralygyny görkeziji bölüm. Bu bölümde 

setirleriň arasy Auto režiminde durýar, gerek bolsa omy hem üýtgetmek bolýar. 

Mundan başga-da Horiz scale bölüminde harplaryň ölçegiňi (masştabyny) görkeziji 

bölüm. Bu bölümde hem harplaryň ölçegi Normal režiminde durýar. Tint bölüminde 

harplara reňkleri guýmagyň göterim görnüşi görkezilen, bu ýerde awtomat 100% 

durýar. Eger gerek bolsa özüňçe göterimi üýtgedip bolýar. Type Style bölümi öz 

düzümine Normal, Bold, Italic, Underline, Reverse, Strikethru bölümleri alýar. 

Bu bölümler tekastleriň ustende amallar geçirilende ulanylýar. Position bölümi tekst 
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obýektierini tekstiň derejesinde ýa-da indeksinde goýmak üçin ulanylýar. Başdaky 

ýagdaýy Normal režiminde bolýar. Ol öçüne Superscript, Subscript bölümleri 

alýar. Case bölümi tekstleri baş harpa geçirmekde ulanylýar, ol öz düzümine 

Normal, All Caps, Small Caps bölümleri alýar. Onuň hem başlangyç ýagdaýy 

Normal režiminde bolýar. Track bölümi tekstde ýerleşen harplaryň aralygyny 

kesgitleýär. Ol öz düzümine No track, Very Loose, Loose, Normal, Tight, Very 

Tight bölümleri alýar. Onuň hem başlangyç ýagdaýy Normal režiminde bolýar. 

 

 
 

 Paragraph Specifications bölümi tekst we grafiki obýektleriň üstünde amallar 

geçirýär. Meselem, islendik obýekti cepe, orta ýa-da saga süýşürmeli bolanda şu 

bölümden peýdalanylýar. 

 

  Idents bölümi obýektlere abzas goýmak ýa-da çepden we sagdan boş ýer 

goýmak ýaly işleri şerine şetirýär. Ol öz düzümine Left, First we Right bölümleri 

alýar. Bu bölümlerde olçeg millimetr (mm) hasabynda bolýar. Paragraph space 

bölümi Before we After bölümleri öz içine alýar. Bu bölüm setirleriň üstünde 

işlenende ulanylýar. Yagny Before - setiriň öňünden gerekli ýer goýmak, After bolsa 

setiriň soňundan. Alignment bölümi obýektleri gerekli ýeriňe süşürmek üçin 

ulanylýar. Ol öz düzümine Left, Center, Right, Justify, Force Justify bölümleri 

alýar. Dictonary bölümi dil saýlamak bölümidir. Bu bölüm tekstdäki harplaryň haýsy 

bölüme degişlidigini görkezýäi. Beýle diýildigi latyn ýa-da krill harplarydyr. Düzgün 

boýunça None režiminde durýar. Mundan başga-da Us English, Russian bölümleri 

bardyr. Eger tekst latyn harplarynda bolsa, onda Us English režimini saýlamaly. Bu 

bölümiň umuman ýerine ýetirýän işi sözleri we sözlemleri boguna bölmekde 

ulanylýar. Options bölümi öz düzümine Keep lines together, Column break 

before, Page break before, Include in table of contents, Keep with next lines, 

Widow control lines, Orphan Control lines bölümleri alýar. Mysal hökmünde 

Include in table of contents bölüme seredip geçeliň. Bu bölüm haşanda meselem 

kitap edilende ulanylýar. Bu bölüm kitabyň mazmuny edilende ulanylýar. Ýagny söz 

başynyň näçenji sahypada ýerleşýändigini awtomat hasaplaýar we ekrana çykarýar. 
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  IndentsYTabs bölümi sözleriň arasyndaky ölçegi goýlanda ulanylýar. 

Meselem, tablisalar edilende. Gerek bolsa sözleriň arasyny özüňçe öýtgedip bolýar. 

Hypenation bölümi tekstdäki sözleri boguna bölmekde ulanylýar. Onuň iki režimi 

On,Off we üç düzgüni bolýar: Manual only, Manual plus dictionary, Manual plus 

algorithm. 

 
 

Alignment komandasy öz düzümine Align Left (Ctrl-Shift-L), Align Center 

(Ctrl-Shift-C), Align Right (Ctrl-Shift-R), Justify (Ctrl-Shift-J), Force Justify (Ctrl-

Shift-F) bölümleri alýar. 

 

Tejribe işleri 

Master sahypasy bilen işlemek 

1) Master sahypasyny döretmek 

2) Çep master sahypasyny işletmek 

3) Sag master sahypasyny işletmek 

4) Çepde duran sahypalaryň belgisini 

5) Sagda duran sahypalaryň belgisini 

6) Çepde duran sahypalarda kolontituly emeli döretmek 

7) Sagda duran sahypalarda kolontituly emeli döretmek 

8) Cep master sahypasynyň ölçegini üýtgetmek bilen hemme çepki sahypalarynyň 

ölçegini üýtgetmek 

9) Sag master sahypasynyň ölçegini üýtgetmek bilen hemme sagdaky 

sahypalarynyň ölçegini üýtgetmek 

10) Täze nusga döretmeli 
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KAGYZ ÝÜZÜNE ÇYKMAÝAN ÇYZYKLARYŇ ÜSTÜNDE IŞLEMEK. 

SÜTÜNLERIŇ GOÝLUŞ DÜZGÜNLERI. 
 

1. Kagyz ýüzüne çykmaýan çyzyklaryň üstünde işlemek. 

2. Sütünleriň goýluş düzgünleri. Kagyz ýüzüne çykmaýan liniýalar Adobe 

PageMaker programmasynyň ýokarky gyrasynda we çep tarapda ýerleşýän ölçeýji 

çyzgyçlarda bolýar. Ol çyzyklary ekranyň ýüzüne getirmek üçin syçanjygyň çep 

düwmejigi çyzgyjyň üstünde basylgy ýagdaýda aşak ýa-da saga çekmeli. Sonda 

ekranyň ýüzüne gök çyzyklar peýda bolýar. 

 

 
 

Kagyz ýüzüne çykmaýan çyzyklar - bular 

sahypada islendik obýektleri gerekli ýerinde 

ýerleşdirmek üçin ulanylýar. Kesgitli çyzgyjyň 

kömegi bilen toryň çyzylyşy suratda görýärsiňiz. 

 

 

Çyzgyzda ulanylýan çyzyklar tekstleri we 

beýleki obýektleri dogry we gerekli ýerinde 

goýmakda uly rol oýnaýar. Çyzgyjyň ölçeg birlikleri: Inches, Inchec Decimal, 

Millimeters, Picas, Ciceros, Custom. 

Çyzgyjy ekrana çykarmak ýa-da gizlemek: View > Show/Hide Rulers. 

Ölçeg ulgamyny saýlamak we wertikal çyzgyjy dikeltmek: 

1. Choose File > Preferences > General. 

2. Select the Measurement System option you want to use. 

The horizontal ruler reflects the measurement system you select. 

3. Select a Vertical Ruler option, we OK d.wmejigini basmaly. 
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Nolunjy punkty ulanmak. Nolunjy punkt - bu wertikal we gorizontal 

çyzyklaryň başlangyjydyr. Haçanda siz täze sahypa döredeňizde PageMaker 

sahypanyň başyny nol režiminde goýýar. Nolunjy nokady özüňizçe gerekli ýeriňize 

süýşürmäge mümkinçilk bardyr. 

Nolunjy punkty süşürmek: 

1. Syçanjygyň kömegi bilen nolunjy punkta barmaly. 

2. Gerekli ýere süşürmeli. 

3. Syçanjygyň çep düwmejigini goýberiň, sonda goýan ýeriňiz nolunjy punkt bolýar. 

 
Nolunjy nokadyň öňki we soňky ýagdaýy. 

 

Nolunjy nokady blokirlemek: View > Zero Lock. Nolunjy nokady blokdan 

açmak: nolunjy nokadyň üstüne iki gezek basmaly. 

Capa çykmaýan çyzyklaryň üç dolandyryjy görnüşi bar: sahypanyň gyralaryny 

dolandyryjylar, sütünleri dolandyryjylar we ugrukdyryjy çyzyklar. 

 

 
 

 

A. Dolandyryjy çyzyklar.  

B. Sahypanyň gyralaryny dolandyryjylar. 

C. Sütünleri dolandyryjylar. Sahypanyň gyralarynyň ölçeglerini haçanda başda 

sahypa döredeniňizde berilýär. Yagny Document Setup bölüminde. Eger gerek bolsa 

sahypanyň gyralarynyň ölçeglerini özüňizçe üýtgedip bilersiňiz. 
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Sütünleri dolandyryjy bölüm haçanda sahypa islendik obýekt ýerleşdirilende 

onuň gyralaryny kesgitleýji hökmünde ulaný lý ar. Her bir sahypada minimum bir 

sütün bolýar. Gerek bolsa birnäçe sütüne bölmek hem bolýar. Munuň üçin Layout 

menýusynyň Column Guides komandasyna girmeli we gerekli sütüniňizi bermeli. 

PageMaker-iň özi sütünleriň arasyny we sütünleriň öz ölçeglerini deň bölýär. 

Ugrukdyryjy çyzyklar capa çykmaýan setirler bolmak bilen sahypadaky 

elementleri deňlemek işini alyp barýar. Sütünleri dolandyryjylardan tapawutlylykda 

olar tekstler toplumyny dolandyrman dine obýektleri deňlemek işini ýerine ýetirýär. 

 

 
Sahypada sütünleri, çyzgylary we sahypanyň gyralaryny deňleýjileri ýüze çykarmak 

we gizlemek: View > Show/Hide Guides. Sütünleri dikeltmek: 

 
Sütünler edilişi.  
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Sütünleri süşürmek we doňdurmak. 
Sütüniň ölçegini üýtgetmek üçin syçanjygyň çep düwmejigi basylgy ýagdaýynda 

sütüniň çäklerini görkeziji çyzygy tutmaly we gerekli ýeriňize süşürmeli 

 

 
 

  Gyraky iki çäklendiriji çyzyklar bir çyzyk boýunça süşürilýär, ortadakylar 

ikileýin çyzyklardyr. Olar bilelikde süşürilýär. Olaryň arasyny Column Guides 

penjiresinde ýerleşýän Space between columns komandanyň üsti bilen ölçegini 

üýtgedip bolýar. 

Sütünleriň dürli görnüşleri bilen sahypa döretmek. 
Eger gerek bolsa siz sol bir sahypada dürli görnüşli sütünleri döredip bilersiňiz. 

Mysal hökmünde, iki sütün sahypanyň ýokarky bölüminde we üç sütün sahypanyň 

aşaky bölüminde. Siz bir sahypada 20 çenli sütünleri ýerleşdirip bilersiňiz. 

 

 
Dürli görnüşli sütünlere tekstleriň ýerleşdirilişi.  

 

Dolandyryjy çyzyklary gurnamak. 
Tekst ýerleşdiriljek sahypada wertikal we gorizontal ugrukdyryjy çyzyklaryň 

120 sanysyny ýerleşdirmek bolýar. 

Dolandyryjy çyzyklaryň goýluşy: 

Syçanjygyň dolandyryjysyny ýokarky çyzgyja eltmeli we çep düwmejigiň 

basylgy ýagdaýynda aşak çekmeli. 

Eger çyzgyç görkezilmedik bolsa, onda View > Show Rulers saýlamaly. 
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Dolandyryjy çyzyklary aýyrmak: 
Dolandyryjy çyzyklary aýyrmak üçin syçanjygyň çep düwmejigi basylgy 

ýagdaýynda çyzgyjyň üstüne eltmeli. 

Bir wagtda hemme dolandyryjy çyzyklary aýyrmak: 

View menýusyndan > Clear Ruler Guides komandasyny saýlamaly. 

 

Tejribe işleri 

Layout menýusy bilen işlemek 

1) 24 sahypa döretmek 

2) 5-nji sahypadan soň 12 sahypa döretmeli 

3) 3-nji sahypadan öň 5 sahypa döretmeli 

4) 17-nji sahypa geçmek 

5) 1-nji sahypa gaýtmak 

6) 7-nji sahypany 3-nji edip goýmak 

7) 5-8-nji sahypalary degişlikde 8-11-nji sahypalar edip goýmak 

8) Sahypany iki sütüne bölmek we tekst ýerleşdirmek 

9) Sahypada tekst ýerleşdirip üç sütüne bölmek 

10) Göçürilip alnan teskti Autoflow buýrugyny ulanyp zerur bolan sahypa 

mukdarynda ýerleşdirmek 
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SHEMALARY AWTOMAT ÝERLEŞDIRMEK. SHEMANY DOLANDYRMAGYŇ 

AWTOMAT GÖRNÜŞINI ULANMAK. 

 

1. Shemalary awtomak ýerleşdirmek. 2. Shemany dolandyrmagyň awtomat görnüşini 

ulanmak. Grafiki obýektleri tekstleriň arasyna ýerleşdirmek üçin File > Place 

salgysyna girmeli. Şol ýerden gerekli faýlyňy saýlap tekstiň arasyna ýerleşdirmeli. 

 

 
 

Siz PageMaker programmasyna birnäçe görnüşli grafiki faýllary Adobe 

Illustrator (AI), Adobe Photoshop (PSD), Adobe Acrobat (PDF), TIFF, and 

Encapsulated PostScript (EPS)ýerleşdirip bilersiňiz. 

Ýokary takyklygy bolan PostScript imagesetter (800 dpi-den hem köp) wektor 

grafikaly EPS formaty ulanýar. Raster grafikasy üçin TIFF formaty ulanylýar. 

PostScript imagesetter formaty tekst we grafiki faýllaryň ýokary hilli çapa 

çykmagyna uly goşant goşýar. 

Process-color separations wektor grafikaly EPS formaty eýeleýär.Bitmap 

reňkler üçin CMYK TIFF ýa-da DCS EPS, TIFF nokatly suratlar üçin ulanylýar. 

Şeýle formatly faýllar çykyş gurluşynyň ýokary hilli çykarmagyna ýardam edýär, 

CMYK režimiň bolsa garşysyna çykjak režim ýokdur. 

TIFF formaty ýokary hilli mümkinçilikli reňlere bölmekde örän amatly bolýar. Şeýle 

formatly faýllar reňkler gammasynyň örän köp mümkinçiliklerini özünde saklaýar. 

RGB formaty hem ýokary hilli reňkleriň gammasyny özünde saklaýandyr. 

Bu iki farmatly faýllar reňkleriň gammasynyň üstünde işlemekde örän ýokary 

mümkinçiligi bardyr. 

HTML dökumentler JPG we GIF grafikaly faýllary ulanýarlar. PageMaker 

hem beýleki grafiki faýllary, haçanda eksport edeniňizde JPG ýa-da GIF formatyna 

konwertirläp bilýär. 

Ýerleşdirilýän garfiki faýllaryň simwoliki belgileri: 

Haçanda Siz grafiki faýllary ýerleşdireniňizde syçanjygyň görkezijisi öz 

formasyny faýlyň formatyna görä üýtgedýär. Aşakda nyşanlaryň birnäçe görnüşi 

ýerleşdirinendir: 
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• Bitmap (paint) image (  ) 

• Scrapbook (Mac OS only) (  ) 

• PDF, EPS graphic (Mac OS) (  ) 

• PDF, EPS graphic (Windows) (  ) 

• Photoshop file (PSD) (  ) 

• TIFF, GIF, JPEG, PhotoCD image (  ) 

• Vector (draw) graphic ( )  

PostScript printerlerde çapa çykarmak: 
EPS garfikaly we PDF formatly faýýalry ýokary hilli çapa çykarmak üçin, 

PageMaker birnäçe opsiýalary özünde saklaýar. 

Uns beriň: PostScript däl printerler EPS grafikaly faýly çapa çykaryp 

bilmeýar. 

EPS reňkleri saklamak. 
Haçanda EPS grafika import edilende, siz EPS reňkleri hem importirläp 

bilýärsiňiz. Eger gerek bolsa şol reňkleri PageMaker-de üýtgedip hem bilersiňiz. Siz 

EPS faýly başlangyç ýagdaýyndaky ýa-da üýtgedilen ýagdaýynda çapa çykaryp 

bilersiňiz. Preserve EPS Color bölümini saýlap alsaňyz, onda siz PageMaker-de 

üýtgeden hem bolsaňyz ol diňe orginal reňki çapa çykarýar. 

Original EPS reňki çapa çykarmak: 

1. Choose File > Print, and then click Color. 

 2. Select Preserve EPS Colors. 

 

ClickPrint. 

Iş meýdanynda reňkleriň dolanşygyny döretmek. 

Siz reňkler bilen işläniňizde esasy bölüm öňüňizdäki monitoryň reňkleri 

görkezijilik mümkinçiligi we soňky çykan netijä baglydyr. Gerekli reňkleriňizi 

almak üçin şol sanda reňkleri dolandyrmak üçin aşakdakylary ýerine ýetirmeli: 

Daş-töweregiňizi gurşap alyjy reňkleri dolandyrmagy başarmaly. Günüň 

şöhlezi siziň ekranyňyzda görünýän reňki üýtgetmegi mümkin. Reňkleriň üstünde 

işlenende girizilýän üýtgeşmeleri kompýuteriň huşuna wagtal-wagtal girizip 

durmaly. 

Öz eden işiňizi neýtral otagda - açyk reňklenen stenaly we porolokly seredip 

görüň. Otagyň reňki siziň işiňize örän uly täsir edýändir. Otag üçin iň oňat reňk çal 

reňkdir. 

Iş stolyňyzda fon beriji zatlary aýyrmaly. Gurşap alan otagyňyzyň reňki näçe 

ýagty bolsa siziň reňkiňiz şonça görkezijilik mümkinçiligi köpelýär. 

Siziň monitoryňyzdaky Contrast düwmejigi reňkiň intensiwliligini üýtgedýär, 

Brightness (ýagtylyk beriji) düwmejigi bolsa, gara reňkiň derejesini sazlaýar. 

 

Tejribe işleri 

 

Type menýusy bilen işlemek 
1) Tekstiň şriftini üýtgetmek 

2) Şriftiň ululygyny dürli edip ulaltmak 

3) Şriftiň stilini üýtgetmek 
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4) Harplaryň arasyndaky aralygyny üýtgetmek 

5) Sözleriň arasyndaky aralygy üýtgetmek 

6) Tekstiň trekingini üýtgetmek. 

7) Simwolyň häsiýetlerini üýtgetmek. 

8) Tekstiň abzasynyň häsiýetlerini üýtgetmek 

9) Tekstiň ýerleşişini sazlamak 

10) Define Styles buýrugyny ulanmak bilen tekstiň stilini üýtgetmek 
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KITAP SAHYPALARYNY WE GAZÝET SAHYPALARYNY DÖRETMEK WE 

ONUŇ DÜZÜM BÖLEKLERI. 

 

1. Gazýet sahypalaryny döretmek we onuň düzüm bölekleri. 

2. Kitap sahypalaryny döretmek we onuň düzüm bölekleri. 

PageMaker programmasynyň ýerine ýetirýän işleriniň biri hem gazet we kitap 

sahypalaryny ýerine ýetirmekdir. Häzirki döwürde biziň Garaşsyz Türkmenis-

tanymyzda poligrafiýa ugruna uly üns berilýär. Munuň şeýledigine häzirki döwürde 

metbugatda çykýan gazetdir žurnallar mysal bolup biler. Garaşsyzlygymyzy 

alanymyzdan soň biziň ýurdumyzda çykýan poligrafiýa önümleriniň hiline uly üns 

berilýär. Muny biz öz durmuşymyzda görýäris. 

Ilki bilen islendik gazet sahypasy ýerine ýetirlende sahypanyň gerekli ölçegleri (A2, 

A3 formaty ýa-da Custom) goýulýar. Gazet sahypalarynda goýulýan materiallaryň 

tutýan göwrümi ölçenilýär. Bir sahypa näçe material ýerleşdirmelidigi barada 

öňünden maketler düzülýär. Şol maketler jogapkär kätipler tarapyndan düzülýär. 

Jogapkär kätibiň düzen maketini gazetiň redaktory goldasa ýa-da üýtgeşme girizip 

ýerine ýetirmäge rugsat berse, şondan soň kompýuterde ýerine ýetirmek işi başlanýar. 

 
 Gazete ýerleşdiriljek materiallar ilki bilen operator tarapynda kompýuterde 

ýygylýar. Ýygylan materiallyň ilkinji nusgasyny korrektorlar okaýar we gerekli 

belliklerini girizýärler. Mundan soň girizilen bellikleri täzeden operator tarapyndan 

kompýuterde ýygylýar. Taýýar bolan faýly ýörite sahypada goýyjy kompýutere 

(maketiň üstünde işleýän dizaýner) geçirilýär. Maketa görä sahypa ýerine 

ýetirilenden soň bir nusgasyny korrektor okaýar we gerekli üýtgeşmeleri girizýär. 

Gazetiň dizaýnerini j ogapkär sekretar gerek bolsa üýtgedip bilýändir. 

 
 Mundan başga-da gazet sahypasynda ýerleşdirilýän suratlar bardyr. Suratlar 
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bilen göniden-göni dizaýneriň özi işleşýär. Ýagny suratyň hili bilen iş salyşýar. Gazet 

sahypasyna hemme gerekli zatlar ýerleşdirilenden soň, ýalňyşlyklat we üýtgeşmeler 

girizilenden soň bir nusga arassa kagyza çykarylýar we redaktor tarapyndan gözden 

geçirilýär. Hemme tarapdan goldanylandan soň gazet plýoka çykarylýar. Plýonkadan 

soň bolsa demire (plastina) geçirilýr. Demirden soň ýörite çap ediji gurluşlaryň 

kömegi bilen kagyza geçirilýär. 

Umuman gazet sahypasy ýerine ýetirlende kompýuteriň roly örän güýçlidir. 

Dünýäniň hemme ýurtlarynda diýen ýaly gazetler PageMaker programmasynyň 

kömegi bilen ýerine ýetirilýär. PageMaker programmasyndan başga-da QuarkXpress 

pogrammasynda hem gazet sahypalaryny ýerine ýetirmek bolýar. 

Kitap sahypalary hem köplenç halatlarda PageMaker programmasynyň üsti 

bilen ýerine ýetirilýär. Beýik Saparmyrat Türkmenbaşynyň Mukaddes Ruhnama 

kitaby hem şu programmanyň üsti bilen ýerine ýetirilendir. 

Kitap sahypalary ýerine ýetirilende edil gazet sahypalarynyňky ýaly onuň formaty 

(A3, A4, A5 we Custom we ş.m.) görkezilýär. Kitap sahypalarynda dizaýn işleri 

ýerine ýetirilende PageMaker programmasynyň mümkinçilikleri örän uludyr. 

PageMaker programmasy tekstleriň üstünde işlemekde özüniň artykmaçlyklary 

bardyr. Meselem, sözleri boguna böleniňde. 

 
 Gazet sahypalarynda bolşy ýaly kitapda hem PageMaker programmasy bilen 

bir hatarda Adobe PhotoShop, CorelDraw programmalary ulanylýar. Bu 

programmalar esasan grafiki obýektleriň üstünde işleşýär. Suratlar PhotaShop 

programmasynyň üstünde redaktirlenýär, gerekli animasiýadyr dizaýnerler köplen 

halatlarda CorelDraw programmasynyň üsti bilen ýerine ýetirilýär. 

Tejribe işleri 

Kitap sahypalaryny we gazýet sahypalaryny döretmek 

1) ESGER gazetiniň ýüz sahypasyny döretmek 

2) GALKYNYŞ gazetiniň ýüz sahypasyny döretmek 

3) ZENAN KALBY žurnalynyň ýüz sahypasyny döretmek 

4) TÜRKMENISTAN gazetiniň ýüz sahypasyny döretmek 

5) AŞGABAT gazetiniň ýüz sahypasyny döretmek 

6) MUGALLYMLAR GAZETI gazetiniň ýüz sahypasyny döretmek 

7) TÜRKMENISTANDA YLYM WE TEHNIKA žurnalynyň ýüz sahypasyny 

döretmek 

8) ADALAT gazetiniň ýüz sahypasyny döretmek 

9) TÜRKMEN DÜNÝÄSI gazetiniň ýüz sahypasyny döretmek 

10) TÜRKMEN DILI gazetiniň ýüz sahypasyny döretmek 
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UTILITIES MENÝUSY. PLUG-INS... KOMANDASY. BOOK, INDEX ENTRY, 

SHOW INDEX, CREATE INDEX, CREATE TOC... KOMANDALARY. 
 

Beýleki ofis programmalarynda bolşy ýaly PageMaker programmasynda hem 

kömekçi utilitler ulanylýar. Utilities menýusy öz düzümine aşakdakylary alýar: 

1. Plug-ins.. 

2. Find(Ctrl-F) 

3. Find Next (Ctrl-G) 

4. Change (Ctrl-H) 

5. Spelling (Ctrl-L) 

6. Book... 

7. Index Entry... (Ctrl-Y) 

8. ShowIndex... 

9. Create Index.. 

10. Create DOC... 

11. Define Colors... 

Plug-ins.. bölümi öz içine birnäçe komandalary alýar. 

Add Confd line..., Balance Columns..., Build Booklet..., Bullets and 

numbering..., Change Case..., Create Color Library..., Drop Cap.., EPS Font 

Scanner..., Global Link Options..., Grid Manager..., Keyline..., Merge Records..., 

Publication Converter..., QuikTime Media..., Running Headers & Footers ..., Save 

for Service Provider..., Show/Hide Toolbar..., Word Counter. 

 

Yokarda görkezilen komandalaryň hersiniň öz ýerine ýetirýän iünksiýalary 

bardyr. Olaryň käbirlerine seredip geçeliň. 

 Balance Columns - bu bölüm sütünler bilen işleşýän bölümdir. Haçanda gerekli 

ýerlerde sütünler döredilende, ony tekste görä ýerleşdirmeli bolýar. Meselem, 

sütünleriň ýokary gyrasyna ýa-da aşaky çäklerini deňleşdirmeli. Suratdan görnüşi 

ýaly Alignment diýen bölümden gerekli komandaňy saýlamaga mümkinçilik bolýar. 

Build Boollet bölümi PageMaker-de taýýarlanan sahypalary kitap formasyna 

geçirmek işlerini ýerine ýetirýär. 01 birnäçe bölümlerden ybaratdyr: 2-up saddle, 2-

up perfect bound, 2-up consecutive, 3-up consecutive, 4-up consecutive. 
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Build Bookllet komandasy ýerine ýetirlenden soň täze bir kitap görnüşine getirilen 

faýl döredýär. Bu faýl kagyz ýüzüne çykarlanda aşakdaky tehnologiýa ulanylýar. 

Ýagny kitapda sahypalar jübüt (Even) we täk (Odd) görnüşinde bolýar. Haçanda 

sahypalar çapa goýberlende PageMakerde üç režim bolýar, ýagny Both Pages, Even 

Pages we Odd pages. Eger-de hemme sahypalary yzygyder çykarmaly bolsa, onda 

Both Pages komandasyny bermeli bolýar. Kitap tertibinde çykarjak bolsaň, onda ilki 

bilen haýsam bolsa (Even Pages ýa-da Odd Pages) birini ilki goýbermeli. Meselem, 

Odd Pages, soň beýlekini. 
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Bellik: PageMaker programmasynyň aşaky bölüminde Hstleriň sany 

ýerleşdirilendir, listreriň özünde bolsa kitap sahypalary ýerleşdirilýär. Haçanda, 

Build Booklet komandasy ýerine ýetirlende Hstleriň sanyna görä ýerine ýetirilýär. 

 

Create DOC komandasy kitap sahypalaryny bir ýere jemleýär, ýagny kitabyň 

mazmunyny döredýär. 

  

 

 Define Colors bölümi reňkleri saýlamak bölümidir. Bu bölümde gerek bolsa 

täze reňk döretmäge mümkinçilik hem bardyr. 

 

Tejribe işleri  

Sahypanyň bölekleri bilen işlemek 

1) Sahypa belgi goýmak 

2) Sahypany düzgünleşdirmek 

3) Sahypanyň tekstine grafiki çyzgylary ýerleşdirmek 
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4) Grafiki obýektleriň tekst bilen aralaşmasyny üýtgetmek 

5) Grafiki obýektleri belli burça öwürmek 

6) Tekst bloguny sahypanyň töwereginde süýşürmek 

7) Tekst blogy bölmek 

8) Iki sany tekst blogy birleşdirmek 

9) 32 sahypadan ybarat bolan broşýuranyň sahypalaryny tertipleşdirmek 

10) 27 sahypadan ybarat bolan broşýuranyň sahypalaryny tertipleşdirmek 
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COREL DRAW PROGRAMMASY BARADA 

 

Mesele - Esaslar, şekilleriň düzümi, çyzyklar, tekst, obýektler 

Corel Draw programasy grafika bilen işlemek babatda dünýäniň öňdebaryjy 

programmalarynyň biri bolup durýar. Ol esasan wektor grafikanyň üstünde alnyp 

barylýan amallary ýerine ýetirmegi mümkin edýär. Öz işinde ol diňe grafiki 

obýektleri bilen işlemek bilen çäklenmän, eýsem ol tekst bilen işlemekde hem amatly 

mümkinçilikleri hödürleýär. 

CorelDRAW programmasy illýustratiw grafika bilen işlemek üçin 

programmalaryň obýektl-integrirlenen toplumy bolup durýar.  

«Integrirlenen toplum» sözleri hökmünde CorelDRAW programmanyň diňe bir 

anyk meseläni çözmek üçin aýry programma dälde, meseleleriň birnäçesini çözmek 

üçin niýetlenen programmalaryň utgaşmasy bolup durýar. Toplumyň integrirlenmegi, 

oňa girýän programmalaryň özara maglumatlar bilen aňsat alyş-çaşlyp bilýändigini 

aňladýar. Şeýleik bilen, toplumyň köp funksiýalylygy gazanylýar, dürli 

programmalaryň mümkinçilikleri bolsa öz bölekleriniň jeminden uly bolan bir bitewi 

zada birleşýär. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Esaslar 

 

Iş meýdany we ulanyjynyň interfeýsi 

Programmanyň ulanylýan faýllaryny goýbermek üçin şu giňişlikleri gözlemeli 

- .CDR, .CMX, .WMF.  

Program goýberilenden soň suratda görkezilen CorelDRAW programmasynyň 

ulanyjy interfeýsiniň esasy elementlerini saklaýan penjiresi açylýar.  

Wektor 
grafikasy 

Rastr 
grafikasy 
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Windowsyň standartlaryna laýyklykda penjiräniň adynyň aşagynda menýu 

setiri ýerleşdirilen. CorelDRAW programmasynda menýu örän çylyşyrymly, kömekçi 

menýularyň we buýruklaryň köp mukdary bilen. Edil beýleki programmalarda ýaly 

menýu CorelDraw programmasynyň köp funksiýalaryna elýeterligi üpjün edýär, 

emma köp amallar onsuz hem ýerine ýetirilip bilner.  

Iş meýdanyň çep böleginde Corel firmasynyň önümleri üçin spesifiki bolan 

gurallar toplumy (toolbox) ýerleşdirilen. Ol iş düzügünini saýlamak üçin niýetlenen. 

Düzgüniň saýlanylmagy gurallar toplumynyň düwmejikleriniň birine syçanjyk bilen 

basma arkaly amala aşyrylýar.  

Gurallaryň düwmejikleriniň käbiri aşaky sag burçundan üçburçluk bilen ýerine 

ýetirilen, bu şol düwmejigiň ýeke däl-de birnäçe gurallar bilen baglaşandygyny 

görkezýär. Olaryň hemmesini görmek üçin syçanjygyň düwmejigini tiz basmagyň 

deregine ony basyp durmaly (1-2 sekundan soň goýbermeli) – ekranda anyk guralyň 

paneli açylar. 

Menýu setiriniň aşagynda ýerleşen standart gurallar panelinde (toolbar) has 

köp ulanylýan buýruklara gabat gelýän dolandyryş elementler ýerleşdirilen: faýllary 

açmak, ýapmak we ýatda saklamak, alyş-çalşygyň buferi bilen işlemek, suratlary 

görmegiň düzgünlerine we masştabyna.  

Standart paneliniň aşagynda atributlar paneli (property bar) ýerleşdirilýär. Ol 

saýlanylan iş düzgünine laýyklykda hemişe üýtgeýär, ol ulanyjynyň esasy iş guraly 

bolup durýar. 

Sag araçägiň ugry boýunça ekran reňk palitrasy ýerleşen (color palette). Ol 

reňk doldurmanyň we obýektleriň sudurynyň reňkini bellemek üçin ulanylýar.  

Menýu setiri 

Gurallar toplumy 

Çap sahypasy 

Gurallaryň standart 
paneli 

Atributlar 
paneli 

Iş stoly 

Ýanaşdyrylan 
penjireler 

Reňkleriň ekran 
palitrasy 

Ýagdaý setiri 
Sahypalar geçmek 
boýunça dolandyryş 
elementler 
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CorelDRAW penjiresiniň aşaky gyraňynda ýagdaý setiri ýerleşen (status bar). 

Onda bellenilen obýekt barada maglumatlar we programmanyň iş düzgüni barada köp 

peýdaly maglumatlar görkezilýär. 

Iş giňişligini esasy bölegi resminamalaryň penjirelerini (drawing windows) 

ýerleşdirmek üçin niýetlenen. Resminama döredilenden soň, ekranda surat 

ýerleşdirilmeli çap sahypanyň görnüşi bolar. Sahypanyň araçäkleri kölegeli ramka 

görnüşinde görkezilen, emma olar şekiliň elementi bolup durmaýar. Şekili düzjek 

obýektler şol araçäkleriň içinde ýerleşdirilmelidir. Şekiliň penjiresiniň beýleki 

giňişligi iş stoly diýlip atlandyrylyp obýektleriň wagtlaýyn saklawjysy hökmünde 

ulanylýar.  

Resminamanyň çepki we ýokarky gyraňlarynda obýektleriň koordinatalaryny 

ölçemek we ugrukdyryjylary ýerleşdirmek üçin gulluk edýän koordinata çyzgyçlary 

(rulers) bar.  

CorelDRAW interfeýsinde ýanaşdyrylýan penjireler (dockers) uly rol oýnaýar. 

Täze resminamany döretmek 

Deslapdan programma goýberilenden soň hemişe resminmama açylýar. Eger 

işiň dowamynda ýene bir resminama açmak zerurlygy ýüze çyksa, onda File (Файл) 

menýusynda New (Новый документ) bendi saýlamaly ýa-da gurallaryň standart 

paneliniň çep gyrasynda ýerleşen New (Новый документ) düwmejige basmaly.  

Resminamalary açmak we ýapmak 

CorelDRAW-da öň döredilen resminamalar Windows üçin standart usuly bilen 

açylýar: CorelDRAW bilen asssiirlenen faýlyň üstüne syçanjyk bilen basylandan soň 

programma goýberilende; File > Open (Файл > Открыть) buýrugy ýa-da standart 

panelinde ýerleşen Open (Открыть) düwmejigi arkaly.  

Açylan gepleşik penjiresinde Windowsyň islendik programmasyndaky ýaly 

hemme standart elementler bar. Ondan başga, faýllaryň sanawyndan çepde, deslapky 

götmegiň töweregi bar, Preview (Предварительный просмотр) baýdajygy goýlan 

ýagdaýynda şol töwerekde faýlyň içinde saklanylýan şekiliň kiçeldilen görnüşi 

görkezilýär. CorelDRAW resminamalary ýatda saklanylanda esasy sözler ýa-da 

bellikler bellenilen bolsa, onda olar Keywords (Ключевые слова) we Notes 

(Замечания) meýdanlarynda görkezilýär.  

Şekiliň kiçeldilen nusgalary faýl ýatda saklanylanda oňa goşulman hem bilýär, 

bu ýagdaýda Preview (Предварительный просмотр) baýdajyk goýulan hem bolsa 

deslapky görmegiň töwereginde hiç zat görünmez.  

Ulanylýan resminamany ýapmak üçin File > Close (Файл > Закрыть) buýrugy 

ulanmaly ýa-da şol penjiräniň sag ýokarky burçunda ýerleşen düwmejigine basmaly.  

 Resminamalary ýatda saklamak 

CorelDRAW resminamasynyň ýatda saklanylmagy File > Save (Файл > 

Сохранить) buýrugyň saýlanylmagy ýa-da gurallaryň standart panelindäki Save 

(Сохранить) düwmejigine basmak arkaly amala aşyrylýar. Eger bu resminama öň 

ýatda saklanylman bolsa, onda ýörite Save Drawing (Сохранить документ) penjiresi 

açylýar.  
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Eger resminamany programmanyň öňki ir wersiýalarynda ýatda saklamaklyk 

gerek bolsa, onda bu penjiredäki Version (Версия) açylýan sanawa üns bermeli we 

bu sanawda gerekli wersiýany saýlamaly.  

Eger faýl öň ýatda saklanylan bolsa, diske gaýtalanyş ýazgy Save Drawing 

(Сохранить документ) penjires açylmazdan bolup geçer.  

Eger faýlyň göçürmesini döretmek üçin File > Save As (Файл > Сохранить 

как) buýrugyndan peýdalanmaly. 

Sahypanyň parametrlerini üýtgetmek 

Täze resminama döredilenden soň käwagt deslapdan kabul edilen çap 

sahypanyň ölçeglerini üýtgetmek gerek bolýar. Bu amal aşakdaky panel arkaly 

sahypada hiç obýekt saýlanylman wagty ýerine ýetirilip bilner. 

 
Çap sahypalaryň ölçegi Paper Type/Size (Тип/формат бумаги) sanaw arkaly 

saýlanylýar, ol atributlar paneliniň iň çepinde ýerleşýär. Çap sahypanyň ölçegi 

hökman kagyzyň formatyna laýyk gelmän hem bilýär. Ol listiň ölçeglerinden kiçi 

bolsa ýeterlik.. Eger çap sahypanyň ölçegi listiňkiden kiçi bolsa, şekiliň gyrasynda 

arassa meýdan bolýar. 

 

Şekilleriň düzümi 
Öň bellenilşi ýaly, CorelDRAW-da şekiller bilen işlemekde esas bolup 

obýektler bolýar. Hemme grafiki obýektleri iki derejä bölmek bolýar — çyzyklara we 

primitiwlere. Soňkulara şulary degişli etmek mümkin: 

 Göniburçluklar  

 Ellipsler 

 Köpburçluklar we ýyldyzlar 

 Halkaçlar  

 Torlar 

 Standart figuralar 

Göniburçluklar  

 
Görkezilen obýektleriň iň pepdäkisi — «klassik» göniburçluk. Hut şeýle 

görnüşde göniburçluklar döredilende görünýär. Ikinji obýekt 45° burça öwrülen. 

Üçünji obýektde 4 burçdan üçüsi tegeleklenen. iň sagdaky bolsa egrilen. Görnüşi ýaly 

gönibrçlugy beýleki obýektlerden tapawutlandyrmak kän bir aňsat hem däl, emma 

ygtybarly usul - obýekti saýlap, ýagdaý setire seretmeklik. Eger ol ýerde Rectangle 

on Layer 1 (Прямоугольник на слое 1) habar emele gelse – şol obýekt 

göniburçlukdyr.  

CorelDRAW-da hemme primitiwler degişli gurallar arkaly gurulýar. 

kagyzyň 
formaty 

listiň ölçegi listiň ugrukdyrylmagy 
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Göniburçluklar döretmek üçin Rectangle (Прямоугольник) düwmejigi ulanmaly. 

Syçanjygyň görkezijisi gönüburçluk bilen kesişmäniň görnüşini alar.  

Rectangle (Прямоугольник) guraly başga usul hem arkaly işletmek mümkin, 

munuň üçin sahypanyň boş ýerinde syçanjygyň sag düwmejigine basmaly we 

kontekst menýuda Create Object > Rectangle (Создать объект > Прямоугольник) 

menýuny saýlamaly ýa-da F6 klawişasyna basmaly.  

Gönuburçlugy çyzmak üçin Rectangle (Прямоугольник) guralynyň 

görkezijisini döredilýän obýektiň diagonaly boýunça süýşürmeli. Syçanjygyň 

görkezijisi süýşürilýän mahaly ýagdaý setirde göniburçlugyň beýikliginiň we ininiň 

şol wagtky bahalary görkezilýär, ekranda bolsa, onuň hemişe üýtgeýän abrisi 

görkezilýär. Syçanjygyň düwmejikleri goýberilen mahaly ekranda göniburçluk emele 

geler, onuň daşynda ramka we markerler we içinde marker bolar, ýagdaý setirinde 

bolsa göniburçluklaryň toparyna degişli bolan obýekt döredilendigi barada habar 

bolar. 

 
 

Klawişa-modifikatorlaryň ulanylmagy 

1. Göniburçluk çyzylanda Ctrl klawişasy basylanda inedördül çyzylar.  

Ctrl klawişasy beýleki funksiýlary hem ýerine ýetirip bilýär. Meselem eger 

obýektiň öwrülmegi Ctrl klawişasynyň basylan ýagdaýynda amala aşyrylsa, onda 

obýekt birsydyrgyn öwrülmeginiň deregine 15° burç bilen bökme bilen öwrüler.  

2. Göniburçluk çyzylanda Shift klawişasy basylanda syçanjygyň görkezijisiniň 

süýşürilmeginiň başlanmagynyň nokadynda burçdaky marker dälde, merkeziň 

markeri bolýar. Bu usul, göniburçlugyň merkeziniň ýerleşmeginiň ýeri belli bolan 

mahaly amatly.  

Iki modifikatory bilelikde ulanmak mümkin.  

 
 

Belleniş çägiň markerleri 

Obýektiň 
bellenilmegini
ň markerleri 

Obýektiň düwünleri 
markerleri 

Rectangle guraly üçin syçanjygyň 
görkezijisi 

Masştablamagyň koeffisienti 

Ini 

Beýikligi 

Aýratyn 
masştablamag
y blokirlemek 

Serpikdiriş 
koeffisienti 

Egrilere 
geçirmek 

Öwrüliş 
burçy 

Burçlaryň aýratyn 
tegelenmekligini 
blokirlemek 

Burçlaryň  
tegelenmekligini
ň koeffisientleri 

Ortalaryň 
koordinatalary 
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Indi bolsa göniburçluklaryň atributlarynyň paneline göz ýetireliň. Atributlar 

panelinde obýektiň modeliniň parametrini kesgitleýän dolandyryş elementleri we şol 

toparyň obýektleriniň üstünden standart amallary ýerine ýetirmegi mümkin edýän 

düwmejikler ýerleşdirilen.  

 Object(s) Position (Координаты середины). Koordinat ulgamynda (adatça 

sahypanyň çepki aşaky burçy bilen bagly bolan) göniburçlugyň ortasynyň 

koordinatlarynyň takyk bahalaryny saklaýan iki meýdan. Bu meýdanlara täze 

bahalary girizmek bilen göniburçlugy süýşürmek mümkin.  

 Object(s) Size (Высота и ширина). Bu meýdanlardaky bahalar 

göniburçluklaryň ölçeglerini dolandyrýar.  

Takyk aýdylanda bu meýdanlarda obýektleriň ölçegleri dälde, onuň gabaralary, 

ýagny ony belleýiş çägiň ölçegleri görkezilýär. Tapawut şol çägiň taraplarynyň 

koordinata oklaryna elmydama parallel bolmagyndan ybarat. Şol sebäpli, 45° burça 

öwrülen inedördül üçin iniň we beýikligiň bahalary onuň diagonalyna deň bolar.  

 Scale Factor (Коэффициенты масштабирования). Bu iki meýdanda 

çyzyklaýyn süýnmegiň we gysylmagynyň koeffisientleri saklanylýar. Olary 

üýtgedip, obýektiň degişli özgerdilmegini amala aşyrmak mümkin.  

 Nonproportional Scaling/Sizing Ratio (Блокировка раздельного 

масштабирования). Eger bu düwmejik basylan bolsa obýektiň bir tarapynyň 

ugry boýunça süýnmegi ýa-da gysylmagy ikinji tarap boýunça proporsionla 

süýnmege we gysylmaga getirer.  

 Angle of Rotation (Угол поворота). Bu meýdanda obýektiň öwrüliş amalynyň 

dolandyryş parametriniň bahasy saklanylýar.  

 Rectangle Corner Roundness (Коэффициенты закругления углов). Bu 

meýdanda göniburçlugyň her burçunyň tegelenmekliginiň radiusynyň otnositel 

bahalary saklanylýar. Bahalar göterimde ölçenilýär, 100 % hökmünde 

göniburçlugyň iň kiçi tarapynyň uzynlygynyň ýartysy kabul edilen.  

 Round Corners Together (Блокировка раздельного закругления углов). Eger 

bu düwmejik basylan bolsa, tegeleniş koeffisientleriniň dördüsinden islendik 

biriniň üýtgedilmegi beýleki koeffisientleriň şol bir ululyga awtomatiki 

üýtgedilmegine getirer. 

Göniburçlugyň burçlaryny tegelemek  

Gurallar toplumynda Shape (Форма) guraly saýlamaly, onuň görkezijisini 

göniburçlugyň burçunda ýerleşen islendik düwüne süýşürmeli we ony göniburçlugyň 

islendik tarapynyň ugry boýunça geçirmeli. Syçanjygyň görkezijisiniň göniburçlugyň 

burçundan daşlaşmagy boýunça hemme dört burç tegelenip başlanýar, özem görkeziji 

näçe uzak süýşürilse, şonça hem tegelenmegiň radiusy uly bolýar.  

 
 

Göniburçlugyň diňe bir burçuny tegelemeklik üçin görkezijini gerek bolan 

burça getirmeli we syçanjyk bilen basmaly we soň görkezijini çekmeli. Diňe şol burç 
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tegeleklener. 

Eger üns berilse, görkeziji çekilende düwünden emele gelen iki täze düwün biri 

biri bilen deň hereketlenýär we olaryň süýşürilmegi olaryň biriniň göniburçlugyň 

tarapynyň ortasyna ýetýänçä dowam edýär. Göniburçlugyň burçunyň maksimal 

tegeleniş radiusy (100%) onuň iň kiçi tarapynyň ýarty uzynlygyna deň. 

Eger tegeleniş koeffisintleriň ýanyndaky gulpuň şekiline eýe bolan düwmejik 

basylsa, onda tegeleniş koeffisientleriň biriniň üýtgedilmegi beýlekilere täsir etmez. 

 Ellipsler 

CorelDRAW bilen işlenende ellipsleri öz diametri boýunça süýndürilen tegelek 

hökmünde hasaplamak bolýar.  

Edil göniburçluk ýaly «ellips» obýektler topary öz içinde ellip bolman duran 

obýektleri hem alýar, ýagny ellipslerden emele gelýän ellipsleriň sektorlary we 

halkalary.  

Geometriýada ellipsleriň ölçegleri onuň ýarym oklarynyň ölçegleri bilen 

kesgitlenýär, CorelDRAW-da — gabara göniburçlugyň ölçegleri bilen (belleýiş çägi 

bilen gabat gelýän). Ellips belleýiş çägi taraplaryň 4 sany orta markerleri ýerleşýän 

ýerinde degýär. Ýaňy çyzylan ellipsde diňe bir düwün bar. 

  
Ellipsleriň, halkalaryň we sektorlaryň çyzylmagy we modifikasiýa 

Sahypany grafika bilen doldurmazlyk üçin CorelDRAW resminamasyna täze 

sahypany goşmaly. Munuň üçin Layout > Insert Page (Макет > Добавить страницу) 

buýrugyndan peýdalanmaly we açylan gepleşik penjiresinde ОК düwmejigine 

basmaly ýa-da penjiräniň aşagynda sahypanyň adyna syçanjygyň sag düwmejigine 

basyp kontekst menýuda meňzeş atly menýuny çagyrmaly.  

Ellips çyzmak üçin, gurallar toplumynda Ellipse (Эллипс) guraly saýlamaly 

we guralyň görkezijisini çyzyljak ellipsiň gabara çäginiň diagonaly boýunça 

süýşürmeli. Syçanjygyň düwmejigi goýberilenden soň, ekranda ellips çyzylar.  

Klawişa-modifikatorlar Ellipse (Эллипс) guraly bilen edil Rectangle 

(Прямоугольник) guraly bilen işleýşi ýaly işleýär. Ctrl klawişasyny basyp saklap 

ellipsi dälde, dogry tegelegi çyzmak bolýar, Shift klawişasy ellipsi burçdan 

çekmände, gabara göniburçlugyň ortasyndan çekip çyzmagy mümkin edýär. Klawişa-

modifikatorlary syçanjygyň düwmejikler goýberilenden soň goýbermeli.  

Gurulan ellipsiň düwünini tapmaly we onuň üstüne syçanjygyň düwmejigini 

getirmeli. Ellipse (Эллипс) guralyň görkezijisi Shape (Форма) guralyň görkezijisi 

Ellipse guralynyň 
görkeziji 

Ellipsiň düwüni 
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bilen çalşyrylmaly. Syçanjygyň düwmejigine basmaly we düwüni gabara 

göniburçlugyň ortasyna tarap süýşürmeli, soňra bolsa ellipsiň araçäginden daşyna 

çykman sagat oky boýunça. Syçanjygyň düwmejigi goýberilenden soň ellips sektora 

öwrüler. Şonda ýagdaý setirinde we atributlar panelinde sektoryň merkezi burçy we 

ony çäklendirýän radiuslaryň ugurlary görkeziler. 

 
Ýene bir ellipsi çyzyp onuň düwünini içinden dälde daşyna çekip süýşürmeli. 

Netijede sektor dälde, ellipsiň halkasy çyzylar.  

Ellipsiň düwüni süýşürilende Ctrl klawişasy basylyp durulsa halkanyň ýa-da 

sektoryň merkezi burçy 15° bökme bilen üýtgäp durar.  

Ellips toparaynyň obýektleri üçin atributlar paneline seredeliň)  

 

 
 

 Ellipse (Эллипс). Bu düwmejik ellips bolup durýan obýekt bellenilen bolsa 

basylýar. Sektor ýa-da halka saýlanylan mahaly bu düwmejige basylsa olar 

ýapyk ellipse öwrülerler.  

 Pie (Сектор). Bu düwmejik sektor bolup durýan obýekt bellenilen bolsa 

basylýar. Onuň basylmagy ellipsleri we halkalary sektora öwürýär.  

 Arc (Дуга). Bu düwmejik halka bolup durýan obýekt bellenilen bolsa basylýar. 

Onuň basylmagy ellipsleri we sektorlary halka öwürýär.  

 Starting and Ending Angles (Начало и конец дуги). Bu iki hasaplaýjyda 

sektoryň ýa-da halkanyň merkezini degişlilikde halkanyň başlangyç we ahyrky 

nokady bilen birleşdirýän radiuslaryň ugrukdyryş burçlarynyň bahalary 

saklanylýar. Ugrukdyryş burçlar sektory ýa-da halkany döredýän ellips bilen 

bagly bolan koordinat ulgamynda bellenilýär, başlangyç şöhle bolsa (0°) 

merkezi we ellips çyzylanda beýlekilerden has çepde ýerleşen nokady 

birleşdirýär.  

 Clockwise/Counterclockwise (Направление дуги). Bu düwmejik iki şöhleden 

olaryň haýsy ugur boýunça sagat ugry ýa-da oňa garşy gitjekdigini kesgitleýär.  

Köpburçluklar we ýyldyzlar  

 «Köpburçluk» toparyna CorelDRAW-da hemme geometriki köpburçluklar degişli – 

diňe dogrylar degişli: çykyp duranlar we ýyldyzlaýynlar (olary köplenç которые 

Halkanyň ugry 

Halkanyň başy we 
soňy 

Halka 

Sektor 

Ellips 
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чаще называют просто звездами). 

 Edil ellipsler we göniburçluklar ýaly köpburçluklar modifisirlenip we öz öňki 

şekilini tanamazça üýtgedip bilýärler. 

  
Köpburçluklary gurmak üçin ýörite gural göz öňünde tutulan. Onuň düwmejigi 

Polygon (Многоугольник) guralyň panelinde beýleki iki guralyň düwmejikleri bilen 

bilelikde ýerleşdirilen.  

 
 

Beýleki primitiwleri gurmakdan tapawutlylykda köpburçluklar bilen işlenende 

atributlar paneli bilen çyzmakdan soň dälde öň işlemek gerek bolýar. Meselem:  

 Number of Points of Polygon (Количество узлов базового многоугольника). 

Bu hasaplaýjynyň bahasy ellipsiň bazasynda gurulýan köpburçlugyň ellipsde 

näçe düwüni guruljakdygyny kesgitleýär, şeýlelik bilen ol köpburçlugyň 

taraplarynyň sanyny belleýär.  

Bu hasaplaýjynyň maksimal bahasy 500, minimaly — 3 deň.  

 
 Star/Polygon (Звезда/Многоугольник). Bu düwmejikler ýyldyz köpburçlugyň 

çyzma düzgüni işledýärler we öçürýärler.  

Tor 

Halkaç 

Köpburçluk 

Köpburçlugyň 

burçunyň ýiteldilmegi 

Baza köpburçlugyň 

düwünleriniň mukdary 

Ýyldyz/Köpburçluk 

Rectangle guralynyň 

görkezijisi 

Baza köpburçlugyň 

görkezijisi görkezijisi 

Köpburçlugyň tarapynyň 

ortasyndaky düwün 
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Ýylzdyzyň çyzylmagyny tarapynyň sany 5-den az bolmadyk köpburçluk üçin 

ulanmak mümkin.  

 Sharpness of Polygon (Заострение углов многоугольника). Bu dolandyryş 

elementi (polzinokly utgaşan meýdan) diňe taraplarynyň sany azyndan 7 bolan 

ýyldyz köpburçluklar bilen işlenende elýeterli. Bu parametriň bahasy näçe uly 

bolsa, şonça hem ýyldyzyň şöhleleri ýiti bolaýr.  

Köpburçluk gurulandan soň, baza köpburçlugynyň depelerinde ýerleşen 

düwünlerinden başga, onda köpburçlugyň her bir tarapynyň ortasynda ýerleşen 

goşmaça düwünler görkezilýär. Köpburçlugyň formasynyň Polygon 

(Многоугольник) guraly arkaly modifikasiýasy şol düwünleri süýşürmekden ybarat. 

Köpburçluklaryň gurulmagy we modifisirlenmesi 

Çyzylan köpburçlugyň düwünlerine üns bereliň. Polygon (Многоугольник) 

guralyň görkezijisini köpburçlugyň taraplarynyň ortasynda ýerleşen islendik düwüniň 

üstüne getireliň — şonda görkezijiniň formasy üýtgemeli, bu bolsa Shape (Форма) 

guralyň wagtlaýyn işlenendigi barada habar berýär. Ctrl klawişasyny basyp saklap, 

şol düwüni radius boýunça merkeze çenli ýarym aralyga süýşürmeli. „Alynan“ 

düwün bilen bilelikde köpburçlugyň tarapynyň ortasynda ýerleşen hemme beýleki 

goşmaça düwünler hem süýşer. Netijede ninzalaryň zyňýan ýaragy bolan sýurikene 

meňzeş figura emele geler.  

 
Ctrl klawişasynyň basylmagy köpburçlugyň düwünleri süýşürilende olaryň 

baza ellipsiň radiuslary boýunça hereket bilen olaryň süýşmeginiň erkinligini 

çäklendirýär.  

Indi guralyň görkezijisini köpburçlugyň depesinde ýerleşen esasy düwüniň 

üstüne getiriň we ony radius dälde merkeziň daşyndan sagat ugry boýunça süýşüriň. 

Netijede sýurikeniň şöhleleri mundan güýçli hem ýiti bolar, we figura oklaýyn 

simmetriýany ýitirip, diňe merkezi simmetriýany saklap galar.  

Indi bolsa, ýene bir köpburçluk guralyň, emma ol indi tegelegiň içine dälde, bir 

kese çekilen ellipsiň içine salnan ýaly bolsun (aşaky surat, çepden). Polygon 

(Многоугольник) guralyň görkezijisini belleniş çäginiň orta markeriniň üstüne 

getirmeli (mundan soň ol dört başly strelka öwrülmeli) we köpburçlugy saga 

süýşüreliň. Syçanjygyň çep düwmejigini goýbermezdn öň, onuň sag düwmejigine 

basmaly (dört başly strelkanyň ýanynda «plýus» nyşany emele gelmeli). Netijede 

sahypada öň gurulan köpburçlugyň süýşürilen nusgasy emele geler. Bu amaly ýene 

iki gezek gaýtalamaly we 4 sany onburçluklardan ybarat bolan hatar emele geler.  

Göçürmegiň bu usuly örän peýdalydyr we ony ýatda saklamak gerek  

 
Birinji nusgany Polygon (Многоугольник) guralyň görkezijisi bilen basyp 

bellemeli we köpburçlugyň hem-de ýyldyzyň düzgünlerini işlediş düwmejigine 

basmaly. Çykyp duran köpburçluk ýyldyza öwrüler, köpburçluklaryň ýiteldiş 

meýdanynda bolsa 1 baha emele geler. 
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Beýleki nusgalarda ýiteldiş meýdanyndaky bahany artdyrmak bilen emele 

gelen ýyldyzyň burçlaryny ýitileşdirmegi görüp bolar. 

Halkaçlar  

Halkaçlar şekiliň düzüm bölekleri hökmünde örän seýrek ulanylýar, ýöne 

olaryň ukrukdyryjylar we traýektoriýalar hökmünde ulanylmagy örän gyzykly grafiki 

effektleri gazanmagy mümkin edýär.  

CorelDRAW-da halkaçlaryň iki görnüşi bar: simmetriki we logarifmik. 

Birinjiler üçin iki sany goňşy burumlaryň arasyndaky aralyk (onuň merkezinden 

geçirilen radiusyň ugry boýunça ölçenilen) tutuş halkaç üçin deň. Logarifmik 

halkaçda bu aralyk deňölçegli belli bir konstanta – halkajyň giňeliş koeffisientine 

proporsional bolup artýar.  

Bu koeffisient göterimde ölçenilýär. Bu koeffisientiň 0.333 deň bolan bahasy, 

soňraky goňşy burumlaryň arasyndaky aralyk, ondan öňkileriňkiden üçden bir esse 

ulydygyny aňladýar.  

Aşakdaky suratda birinji spiral simmetriki, ikinji spiralda koeffient = 0,5-e, üçünjide 

koeffisient – 1-e deň 

Hakykatdan aýdylanda halkaçlar 

CorelDRAW-yň primitiwleri hökmünde 

bolmaýarlar. Şol sebäpli programmada “halkaç” 

diýip obýektler topary ýok. Olar egriler toparynyň düzümine girýärler. Halkaçyň 

dolandyryş elementleriniň hemme bahalary halkaç gurulmazdan öň goýulmaly. 

Halkaç bellenilen bolanda onuň dolandyryş elementleriniň bahalarynyň atributlar 

panelinde üýtgedilmegi oňa hiç hili täsir etmeýär.  

Halkaçlar Spiral (Спираль) guraly arkaly çyzylýar, onuň düwmejigi Polygon 

(Многоугольник) guralyň panelinde ýerleşýär.  

 
Torlar  

Torlar hem edil halkaçlar ýaly aýry obýektler toparyny düzmeýär. Graph Paper 

Logarifmik 
halkaç 

Burumlary
ň  

sany 

Giňeliş 
koeffisienti 

Simmetriki halkaç 

Spiral guralyň 

görkezijisi 
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(Диаграммная сетка) gural arkaly gurulýan şekiliň fragmentleri özi bilen deň 

göniburçluklaryň tertipleşdirilen toparlary bolup durýar. Bu fragmentleri Rectangle 

(Прямоугольник) guraly arkaly gurmaklyk örän ýadadýar. Bu guralyň düwmejigi 

Polygon (Многоугольник) guralyň anelinde ýerleşdirilen.  

 
Tor şeýle yzygiderlilikde gurulýar: gurallar toplumynda Graph Paper 

(Диаграммная сетка) gural saýlanylýar, soňra atributlar panelinde setirleriň we 

sütünleriň sany görkezilýär, soňra guralyň görkezijisi göniburçluk töweregiň 

diagonaly boýunça süýşürilýär. Tor elmydama deň inli sütünler we deň beýiklikli 

setrler bilen gurulýar. 

Ýumuş nusgaly plakat döretmek 

 
Täze sahypany dörediň, ony atlandyryň we içinde setirler öwrenilen gurallara 

laýyk gelýän, öýjüklerinde bolsa obýektleriň nusgalary ýerleşen jetwel görnüşinde 

plakaty çyzmaly.  

Standart figuralar  

Bu toparyň primitiwleri tejribede köp duş gelýän grafiki fragmentleri çyzmak 

üçin ulanylýar. Topar 5 bölege bölünen: baza figuralar(basic shapes), strelka (arrow 

Graph Paper guralyň görkezijisi 

Toruň 
setiriniň 
  

sany 

Toruň 
sütünini

ň sany 
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shapes), blok-shemalaryň elementleri (flowchart shapes), ýyldyzlar (star shapes), 

çykaryjylary (callout shapes). Aşaky suratda toparyň bölünýän bölekleriň 

düwmejikleri we olara degişli standart figuralaryň palitrasy görkezilen. Palitralar 

bölege degişli bolan guralyň atributlar panelindäki düwmejik arkaly açylýar.  

 
Standart figuralaryň çyzylmagy ikä bölünýär: çyzma we formany sazlama. 

Figurany çyzmak üçin şulary ýerine ýetirmeli.  

1. Perfect Shapes (Стандартные фигуры) guralyň düwmejigine basmaly.  

2. Syçanjygyň görkezijisini çyzyljak standart figuranyň diagonaly boýunça 

süýşürmeli.  

Sahypada saýlanylan standart figura emele geler, ol belleniş markerler bilen 

gurşalar. Mundan başga standart figuralaryň köpüsinde bellenilende kiçi romb 

görnüşindäki reňkli marker— marker- modifikator emele gelýär (aşaky surat, sagda). 

Syçanjyk arkaly marker-modifikatory süýşürip, standart figuranyň daşky keşbini 

üýtgetmek mümkin.  

 
Çyzylan standart figurany soňra marker-modifikator arkaly gaýtadan sazlap, 

onuň gabaralaryny we ugrukdyrylmagyny atributlar paneliniň dolandyryş elementleri 

arkaly üýtgedip bolýar. Standart figuranyň formasyny marker-modifikator arkaly 

üýtgetmek mümkinçiligi figuranyň üstünden alnyp barylýan işiň tutuş dowamynda 

saklanylýar we ol diňe figura egri çyzyga öwrülende ýitýär.  
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ÇYZYKLAR 

Egriniň modeli 

CorelDRAW-da kabul edilen çyzygyň modeliniň esasynda iki düşünje 

durandyr: düwün we segment. Düwün bolup şekiliň tekizliginde duran, segmentiň 

uçlarynyň biriniň ýagdaýyny belleýän nokat bolup durýar. Segment diýlip iki goňşy 

düwüni birleşdirýän çyzygyň bölegine aýdylýar. Ýapyk çyzykda düwünleriň sany 

bilen segmentleriňki gabat gelýär, açyk çyzykda düwünleriň sany 1-a artyk bolýar.  

Şu ýerde „çyzyk“ diýlen adalga hökmünde egrileriň (curve) toparyna degişli 

bolan obýekte düşünmeli bolar.  

Düwün ondan öňki segmentiň häsiýetini doly kesgitleýär, şol sebäpli ýapyk däl 

çyzyk üçin iki ahyrky düwünleriniň haýsysy başlangyç bolýandygyny, ýapyk çyzyk 

üçin bolsa çyzygyň ugruny (sagat ugry ýa-da oňa garşydygyny) bilmek zerur. Öňdäki 

segmentiň häsiýetleri boýunça düwünleriň üç görnüşini belleýärler: ýapyk däl 

çyzygyň başlangyç düwüni, şeýle hem göniçyzykly (line) we egriçyzykly (curve) 

düwünler. Aşaky suratda aralykdaky 1 düwün we ahyrky düwün — göniçyzykly, 

aralykdaky 2 düwün — egriçyzykly.  

Egri çyzyjk üçin ýagdaý setiriň orta böleginde obýektiň toparynyň ady 

görkezilýär — Curve on Layer 1 (Кривая на слое 1), onuň çep tarapynda bolsa— şol 

egri çyzygyň düwünleriniň sany.  

 
 Suratdan görnüşi çyzygyň düwünleri kiçiräk inedördüliň görnüşinde 

görkezilýär. Başlangyç düwün biraz ulyrak inedördül bolup görkezilýär.  

Redaktirlemede bellenilen düwünler hem ulaldylan görnüşinde görkezilýär.  

Iň bolmanda bir egriçyzykly segment bilen goňşy bolan düwünler üçin 

görnüşleriň ýene bir toparlanylyşy bar: olar döwüliş nokatlaryna (cusp) we düzlenen 

düwünlere (smooth) bölünýärler. Ýagny, düzlenen düwüniň ýagdaýy hökmünde 

simmetriki düwün bolýar (symmetrical), emma şeýle düwün bolup diňe iki 

egriçyzykly segmentiň arasyndaky düwün bolup durýar. 

Aşaky suratda görkezilen düwüniň hemme komponentleri diňe şol düwün 

Shape (Форма) gural arkaly bellenilen bolsa we şol egride başga düwün 

bellenilmedik bolsa ekrana çykarylýar.  

Aralykdaky 2 düwün 
görkezijisi 

Ahyrky düwün 

Çyzygyň göniçyzykly 
segmenti 

Aralykdaky 1 
düwün görkezijisi 

Çyzygyň egriçyzykly 
segmenti 

Başlangyç 
düwün 

Çyzygyň göniçyzykly 
segmenti 
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Egriçyzykly segmentiň bellenilen düwünine galtaşylýan tarapdan ukrukdyryjy 

nokat görkezilýär. Ekranda ol düwün bilen ştrihleme bilen birleşdirilen garaldylan 

inedördül hökmünde görkezilýär. Bu ştrihleme çyzyk onuň düwüne girýän 

nokadynda egriçykly segmente bolan galtaşyjy bilen gabat gelýär. Ukrukdyryjy nokat 

düwünden näçe daşlaşylsa, şonça hem egriçyzykly segment düwünden daşlaşylýança 

galtaşyjydan haýal gyşarylýar. Iki egriçyzykly segmenti bölýän düwün bellenilse, 

ekranda 4 sany ugrukdyryjy nokat görkezilýär — her segmenitň iki uçlaryndan.  

Düwüniň görnüşi (ol ýagdaý setirinde görkezilýär) onuň ukrukdyryjy 

nokatlarynyň özara ýerleşişini kesgitleýär. 

Döwülme nokatlary 

Düwün döwülme nokady diýlip oňa ýanaşýan segmentlere düwüniň özünden 

geçirilen galtaşyjylar bir çyzykda ýerleşmän doly açylan burçdan tapawutly burçy 

döredýän ýagdaýda atlandyrylýar. Döwülme nokatlaryň mysallary aşakdaky suratda 

getirilen.  

 
а) göniçyzykly segmentleriň sepinde; b) göniçyzykly we egriçyzykly segmentleriň 

sepinde; ç) iki egriçyzykly segmentleriň sepinde 

 

 

Düzlenen burçlar 

Düwün düzlenen diýlip oňa ýanaşýan segmentlere geçirilen galtaşyjylar bir 

çyzykda ýerleşýän bolsa atlandyrylýar. Düzlenen düwünleriň mysallary aşaky suratda 

getirilen.  

Bellenilen düwün 

Bellenilen düwüniň 
ugrukdyrjy nokatlary 

a   b ç   
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a) göniçyzykly we egriçyzykly segmentleriň sepinde b) iki egriçyzykly 

segmentleriň sepinde  

Iki göniçyzykly segmentleriň sepinde ýerleşen düwün düzlenen bolup 

bilmeýär. 

Simmetrik düwünler 

Simmetrik diýlip ugrukdyryjy nokatlar özünden deň daşlaşdyrylan düzlenen 

nokada aýdylýar. Döwüliş nokatlardan we düzlenen düwünlerden tapawutlykda 

simmetrik düwünler örän seýrek ulanylýar. Simmetrik düwüniň mysaly aşakdaky 

suratda getirilen.  

 
Ýapyk, arasy açyk we birleşdiriji çyzyklar 

Ahyrky düwün diýlip diňe bir segment bilen goňşy düwüne aýdylýar. Ýokarda 

bellenilişi ýaly, öňünden gelýän segmenti bolmadyk düwün başlangyç diýlip 

atlandyrylýar.  

Başlangyç düwüne eýe bolan çyzyk ýapyk däl (open curve) diýlip 

atlandyrylýar. Ahyrky düwünleri ýok bolan çyzyga ýapyk (closed curve) diýilýär.  

Ýapyk çyzykda başlangyç we ahyrky düwüniň roluny şol bir düwün ýerine 

ýetirýär, şol sebäpli onda hem şňki we yzyndan gelýän segmentleri bar. Şeýlelik bilen 

ýapyk çyzykda başlangyç düwün ýok, ýogsam ekranda şol düwün Shape (Форма) 

gural bilen saýlanylsa edil başlangyç düwün ýaly ulaldylan inedördül bilen 

şekillendirilen hem bolsa.  

Birleşdirilen çyzyklar – bu birnäçe şahalardan (subpath) ybarat bolan 

obýektler, şol şahalaryň her biri ýapyk ýa-da ýapyk däl çyzyk bolup durýar. 

Birleşdirilen çyzyklar obýektler Combine (Соединить) buýrugy bilen birleşdirilen 

amallarynda we beýleki obýektler (meselem tekstler) egri çyzyklara özgerdilende 

emele gelýär. Birleşdirilen obýektiň esasy tapawutly häsiýeti bolup bir obýekte 

ulaldylan inedördül bilen belleinlen birnäçe düwünleriň bolmagy bolýar. Birleşdirilen 

çyzyklary aýrylaşdyryp bolaýr.  

 

 a      b  
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Suratda ýapyk (çepde), atasy açylan (ortada) we birleşdirilen (sagda) çyzyklar 

görkezilen 

CorelDRAW-da islendik grafiki obýekt egrilere öwrülip bilner. Hem-de 

tersine, köp çylşyrymly obýektler bir ýa-da birnäçe çyzyklaryň esasynda gurulýar. 

Egri çyzyklary gurmak üçin gurallaryň biri bolup Spiral çykyş edýär. Dürli 

görnüşli çyzyklary gurmagy mümkin edýän gurallar CorelDRAW-da Curve (Кривая) 

guralyň panelinde ýygnalan.  

 

  

 

 

 

 

 

 

 

Çyzyklar we Freehand guraly 

Freehand (Произвольная кривая) guraly syçanjygyň hereket ediş ýoluny egri 

çyzyga öwürýär. Şonda çyzygyň düwünleri we segmentleri guralyň sazlanmasyna 

laýyklykda awtomatiki döreýär. 

Çyzyklary el bilen çyzmak 

Curve (Кривая) gurallar panelinde Freehand (Произвольная кривая) guraly 

saýlalyň. Syçanjygyň görkezijisi saýlanylan gurala gabat gelýän görnüşe eýe bolar. 

Syçanjygyň düwmejigine basmaly we görkezijini süýşürip tegeleklenen ýapyk egrini 

çyzmaly. Syçanjygyň görkezijisi egriniň çyzylmagy başlanan nokadyna golaýlaşanda 

görkeziji öz görnüşini suratdaky ýaly üýtgeder (sagda). Eger syçanjygyň düwmejigi 

goýberilse ýapyk egri çyzylar.  

 

Superçyzyk 

Pero 

Poliçyzy
k 

Bezýe 
egrisi Egri 

Üç nokat boýunça egri 

Ölçeg çyzygy 
Birleşdiriji çyzyk 

a b 
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Egri çyzylanda, çyzyk „başga ýere barsa“, syçanjygyň düwmejigini goýbermän 

Shift düwmejigine basyp saklaň. Indi görkezijini eýýam çyzylan çyzygyň ugry 

boýunça yza süýşürsek „nädogry“ bölegi pozup bolýar. Soňra klawişany goýberip 

çyzmagy dowam etmek bolýar.  

Egri çyzylandan soň Shape (Форма) guraly saýlaň we onuň bilen islendik 

düwüne basyň, soňra bolsa ýagdaý setirindäki habary okaň. Soňra, yzygiderli Tab 

düwmejigni basyp, düwünden düwüne geçip olaryň görnüşini ýagdaý setirinden biliň. 

Netijede şular gelip çykar:  

 Freehand (Произвольная кривая) gural bilen işlenende düwünler we 

segmentler awtomatiki döredilýärler;  

 Düwünleriň köpüsi döwüliş nokady bolup durýarlar;  

 Segmentleriň köpüsi— egriçyzykly.  

Syçanjygyň tizligi egri çyzylanda näçe ýokary bolsa, şonça hem gurulýan 

düwünler biri-birinden daşda ýerleşer.  

Indi ýaňky egri çyzylanda tegelenişden başlap göniçyzkly segment başlanmaly 

we gutarmaly mahaly Tab klawişasyny basyň. Göniçyzykly segmentler gowy 

çyzyldy.  

Indi bolsa bu guralyň gowy oňarýan zadyny çyzalyň – diňe göniçyzykly 

segmentleri. Guralyň görkezijisi birinji düwüniň ýerleşmeli ýerine getirilýär we 

syçanjygyň düwmejigine basmaly. Indiki syçanjygyň düwmejiklerine basylmagy 

düwünleriň ýerleşmeli ýerinde iki gezek basylmak bilen amala aşyrylýar. Soňky 

gezek başlangyç nokatda basylan ýagdaýda çyzyk ýapyk bolup galýar.  

Corel-Draw-yň soňky wersiýalarynda Freehand (Произвольная кривая) 

gurala goşmaça hökmünde Polyline (Полилиния) guraly girizilen. Onuň bilen 

birnäçe segmentlerden ybarat bolan egrileri çyzmak amatly. Başlangyç segment 

döredilenden soň syçanjygyň düwmejigine basylýar, emma ol egriniň çyzylmagyny 

tamamlamaýar. Syçanjygyň düwmejigi basylan mahaly görkezijiniň süýşürilmegi 

egri çyzygyň egriçyzykly segmentini döredýär, syçanjygyň düwmejigi goýberilen 

mahaly görkezijiniň süýşürilmegi göniçyzykly segmenti döredýär. Ýapyk däl egriniň 

çyzylmagyny tamamlamak üçin Probel klawişasyna basmaly. 

Çyzyklar we Bezier guraly 

Bezier (Кривая Безьс) guraly bilen işlände ulanyjy çyzyljak egriniň 

düwünleriniň ýerleşi'ini belleýär we çyzmagyň dowamynda onuň her biriniň 

ugrukdyryjy nokatlaryna täsir etmek mümkinçiligine eýe bolýar. Egriniň Bezier 

(Кривая Безье) guraly arkaly çyzylmagy egriniň her düwüni bilen işlemegiň 

siklleriniň yzygiderliliginden ybarat. Sikl görkezijiniň boljak düwüniň ýerine 

goýulmagyndan başlanýar. Soňra syçanjygyň düwmejigi basylýar we ony basyp 

saklap ulanyjy ugrukdyryjy nokatlaryň ýerleşişini takyklaýar, syçanjyk bilen ony 

süýşürip (ilkibaşda düwünden, soňra bolsa – onuň daşynda). Deslapdan simmetrik 

düwünler döredilýär, emma syçanjygyň düwmejigi goýberilen mahaly ulanyjy 

düwüniň klawişa-modifikatordan peýdalansa düzlenen düwün ýa-da döwüliş nokat 

dörediler. Syçanjygyň düwmejigi goýberilen mahaly düwüniň görnüşi we 

ukrukdyryjy nokatlaryň ýerleşişi bellenilýär, soňra indiki düwüniň kesgitleniş sikli 

başlanýar. Siklden çykmak üçin Probel klawişasyna basmaly.  
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Döwüliş nokady döredilende С klawişasyny basyp saklamaly (cusp). Düzlenen 

nokady döretmek üçin S (smooth) klawişa-modifikator ulanylýar.  

Çyzyklary Bezier guraly arkaly çyzmak 

Gurallar toplumynda Bezier (Кривая Безье) guraly saýlaň. 

Çyzygyň gurulmagyny çyzykly segmentden öň duran düwünden başlalyň. 

Görkezijini gerekli nokada goýmaly we syçanjygyň düwmejigine basmaly. 

Düwmejigi goýbermän görkezijini birneme saga geçirmeli, düwünden „çykarylan“ 

ugrukdyryjy nokatlar görüner ýaly. Indiki segmente bolan galtaşyjy berk kese bolar 

ýaly Ctrl klawişasyna basyp saklamaly. Syçanjygyň düwmejigini goýberiň soňra 

bolsa Ctrl klawişasyna — egriniň birinji düwüni gurulan. Başda ol ýeke düwün 

bolany üçin onuň üstünden iş tamalanandan soň ol awtomatiki döwüliş nokady bolup 

durýar. Bu düwünde çyzyk ýapylan ýagdaýynda onuň görnüşi üýtgär.  

 
Ikinji düwüniň gurulmagyna geçeliň. Ol birinji düwün bilen bir kese çyzykda 

ýerleşmelidigi sebäpli, guralyň görkezijisini süýşürmezden öň gaýtadan Ctrl 

klawişasyny basyp saklamaly. Ikinji düwün edil birinji düwün ýaly gurulýar, ýöne 

syçanjygyň düwmejigi goýberilenden soň ol simmetrik bolar. 3.10).  

 
Üçünji düwün gönümel ikinjiň aşagynda ýerleşmelidir, şol sebäpli ikinji düwün 

bilen işlenenden soň Ctrl klawişasyny goýbermeseň hem bolýar. Bu gezek düwünden 

ugrukdyryjy nokady Ctrl klawişasyny goýbemän saga dälde çepe “çykarmaly”. 

Tegelenme simmetriki bolar ýaly ugrukdyryjy nokatdan düwüne çenli aralyk edil 

ikinji düwüniňki ýaly bolmalydyr.  

 
 

Dördünji düwün edil üçünji ýaly gurulýar. Indi egrini ýapmak gerek. Munuň 

üçin syçanjygyň görkezijisi başlangyç nokada süýşürilýär (ýörite strelkaly nyşan 

emele gelýänçä) we syçanjygyň çep düwmejig basylýar. Ugrukdyryjy nokady Ctrl 

klawiýasy basylan ýagdaýynda saga süýşürmek galdy (tegelenme simmetrik bolar 

ýaly) we ýapyk egri çyzylar.  

 
Täze Реn (Перо) guraly egrileri edil Bezier (Кривая Безье) guralyň teklip 

edýän usullary bilen çyzmaklygy mümkin edýär. Tapawut syçanjygyň görkezijisi 

egriniň nibatdaky düwüniň ýerleşiş nokadyna süýşürilende ektanda egriniň entek 

gurulmadyk indiki segmentiň daşky görnüşi görkezilýär.  

Üýtgeýän inli çyzyklar we Artistic Media guraly 

Artistic Media (Суперлнння) guraly arkaly «superçyzyklar» (Artistic Media 

Group) toparynyň düzüm obýektleri çyzylýar. Bu obýektleriň her biri iki bölekden 

ybarat — dolandyryjy obýektiň roluny oýnaýan we tutuşlaýyn düzüm obýektiň 

b a 
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formasynyň esasy parametrlerini kesgitleýän çyzykdan hem-de şol formanyň 

detallaryny kesgitleýän tabyn obýektden. Tabyn obýektiň rolunda ýapyk egri çyzyk 

eýsem CorelDRAW-daky islendik obýekt oýnap biler, özem dolandyrjy obýekt hem-

de tabyn obýekt superçyzyk gurulmazdan öň çyzylyp bilner, şeýle hem çyzmagyň 

dowamynda gurulyp bilner. Bu mümkinçilikleri amala aşyrmak üçin Artistic Media 

(Суперлиния) guraly birnäçe düzgünde işläp bilýär. Artistic Media (Суперлиния) 

guralyň düzgünlerini saýlamaklyk aşakda görkezilen atributlar paneli arkaly amala 

aşyrylýar 

.  

 
  

 Preset (Заготовка), Brush (Кисть), Sprayer (Распылитель), Calligraphic 

(Каллиграфия) we Pressure (С нажимом) düwmejikleri guralyň düzgünlerini 

işletmegi mümkin edýär.  

 Polzunogy bolan Freehand Smoothing (Сглаживание) meýdany düwünleriň 

döredilmeginiň ýygylygyny sazlamagy mümkin edýär, ýagny birleşdirilen 

obýektiň dolandyryjy çyzygynyň tekizligini.  

 Artistic Media Tool Width (Ширина линии) hasaplaýjysy superçyzyk 

gurulanda tabyn obýektiň maksimal inini kesgitleýän bahany saklaýar.  

 Preset (Схема заготовки) açylýan sanaw taýýarlanma düzgünde işelenende 

tabyn obýektiň ülňisini saýlamagy mümkin edýär.  

Kaliigrafiýa düzgüni 

Guralyň görkezijisi belli bir traýektoriýa boýunça süýşürilende bu traýektoriýa 

düzüm obýektiň dolandyryjy çyzygy hökmünde bellenilýär, şonda düzlenmegiň 

dolandyrjy parametriň bahasy hasaba alynýar. Emma süýşürme tamamlanandan soň 

(syçanjygyň düwmejigi goýberilenden soň) awtomatiki ýene bir obýekt çyzylýar — 

ýapyk egri çyzyk. Onuň formasy dolandyryjy çyzygyň formasy we kaliigrafiki 

peronyň häsiýetnamalary – ini we eňňitlik bilen kesgitlenýär.  

Berlen inli kalligrafik pero ortaky nokady bilen dolandyryjy çyzygyň 

başlangyü düwünine goýulýar, soňra onuň ugry boýunça süýşürilýär. Tabyn obýekt 

peronyň başlangyç we ahyrky ýagdaýlaryndan we onuň gyralarynyň hereket eden 

traýektoriýadan ybarat bolan ýapyk egri çyzyk bolup durýar. Aşaky suratda 

kalligrafik gural bilen çyzylan obýekt üç gezek görkezilen, Çepde ol Shape (Форма) 

guraly bilen okuna basylyp saýlanylan, ortada — Pick (Выбор) guraly bilen obýektiň 

gyrasyna syçanjyk bilan basylyp. Sagda kaligrafik peronyň eňňitlik bahasy 0-dan 60° 

çalşyrylan ýagdaýynda.  

  

Taýýarlanma
m 

Çotga 

Basyş 
bilen Düzlenme 

Pürkgüç Kalligrafiýa Çyzygyň ini Taýýarlanmanyň 
ülňisi 
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Taýýarlanma düzgüni 

Kalligrafiýa düzgüninden tapawutlykda taýýarlanma düzgüni dolandyryjy 

çyzygy iki usul bilen gurmagy mümkin edýär: superçyzygyň düzüm obýekti gurulýan 

mahaly ýa-da öňünden, soňra dolandyryjy obýekte özgertme bilen.  

Birinji warianta ulanyjy edil kalligrafiýa düzgüninde ýaly hereket edýär, ýöne 

kalligrafiki peronyň eňňitliginiň deregine tabyn obýektiň öň taýyn ülňisi ulanylýar — 

bu ülňileri saklaýan sanaw atributlar panelinde emele gelýär. 

Ikinji wariantda ulanyjy çyzgyny ilkibaşda Freehand (Произвольная кривая) 

ýa-da Bezier (Кривая Безье) guraly arkaly gurýar, soňra Artistic Media 

(Суперлиння) guraly saýlanylýar, taýýarlanma düzgüni işledilýär.  

Eger dolandyryjy obýekt hökmünde birleşdirilen çyzyk ulanylsa, onda 

taýýarlanma onuň her şahamçasyna aýry ulanylýar. Taýýarlanam saýlanmazdan öň 

superçyzyk bolup duran obýekt bellenilse, onuň tabyn obýekti ýok edilýär, we täze 

tabyn obýekt bellenilýärто его подчиненный объект удаляется, а по сохраненной 

управляющей линии строится новый подчиненный объект в соответствии с 

новой заготовкой.  

 
  

Çotga düzgüni 

Çotga düzgüninde tabyn obýekt dolandyryjy çyzgy boýunça gurulmaýar, ol 

diňe onuň formasy we superçyzygyň ini boýunça deformirlenýär. Deformasiýa üçin 

basşlangyç material bolup sülereýler hyzmat edýär — ýörite .стх formatda 

CorelDRAW programmasynyň ýüklenen bukjasynda ýerleşen \CustomMediaStrokes 

bukjada ýatda saklanylan şekiller. Deformasiýanyň manysy şekil-sülereý ini 

birleşdirilen obýektiň uzynlygyna, beýikligi bolsa superçyzgyň berlen inine deň bolar 

Guralyň görkezijisi Eňňitlik 
burçy 
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ýaly süýnýär ýa-da gysylýar, soňra bolsa dolandyryjy çyzygyň formasyna laýyklykda 

gyşarylýar.  

 CorelDRAW-yň düzümine standart sülereýleriň toplumy girýär we olaryň 

içine täzelerine goşmak hem bolýar (diňe wektorlylary dälde, eýsem nokatlylary 

hem). Şekil \CustomMediaStrokes salnan soň onuň ýönekeýleşdirilen şekili kist üçin 

atributlar panelinde sülreýleri görkezýän açylýan sanawda ýerleşdiriler.  

 

 
 

Çyzyklary kist düzgünde çyzmaklygyň usullary edil taýýarlanma düzgüniňki 

ýalydyr. 

Şekili sülereý hökmünde ýatda saklamak üçin, ony Pick (Выбор) guraly arkaly 

saýlamak gerek, soňra Artistic Media (Суперлиния) guraly saýlamaly, kist düzgünini 

işletmeli we paneldäki degişli düwmejige basmaly we açylan penjirede at bermeli. 

Sülereýleri ýok etmek üçin hem degişli düwmejik bar. 

Sülereýiň fiziki ýok edilmegi syçanjyk bilen düwmejige basylan ýagdaýda 

dälde, CorelDRAW bilen iş tamamlananda amala aşyrylýar. Şol sebäpli programma 

ýapylmaka ýok edilen sülereýi bilen işlemek mümkin.  

Superçyzyklary çyzmak 

1. Sahypada ýylanyň suratyny çekiň (aşaky surat, ýokarda). Ilkibaşda ýylanyň 

tenine we kellesine gabat gelýän ýapyk çyzygy guruň. Gözleri we burun deşikleri 

hökmünde ellipsleri çyzyň. Arkazynda zigzak hökmünde bolsa döwülen çyzyk gulluk 

etsin.  

 
2. Indi ýylanyň hemme böleklerini Pick (Выбор) guraly arkaly göniburçluga 

salyp belläliň.  

3. Artistic Media (Суперлиния) guraly saýlap kist düzgünini işledeliň. Soiňra 

disketa görnüşine eýe bolan düwmejige basyp sülereýi ýatda saklamak üçin faýlyň 

adyny girizmeli. Ok düwmejigi basylandan soň täze sülereý ulanylmaga taýyn. 

4. Esc basyp ýylanyň bellenilmegini aýyrmaly. Artistic Media (Суперлиния) 

gural arkaly islendik çyzyklary çyzalyň. Netijäni ýokarky suratda görmek bolar!  

Sülereýleriň 
sanawy 

Sülereýleri ýok etmek 

Sülereý hökmünde ýatda 
saklamak  
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5. Ýylany ýumak ýaly düýrlemek üçin Spiral (Спираль) guraly arkaly 2-3 

burumdan ybarat bolan logarifmik spiraly çyzalyň. Artistic Media (Суперлиния) 

guraly saýlap ýylanyň sülereýini ulanalyň. Eger ýumak gaty dykyz bolsa 

superçyzygyň inini peseldip görmeli ýa-da obýekti ýok edip spiralyň giňeliş 

koeffisientini artdyryp obýekti çyzmaly .  

6. Ýylany halka düýrlemek üçin dolandyryjy çyzyk hökmünde ellipsi ulanmak 

gerek.  

7. Original göniburçluk ramkany ýasamak üçin göniburçlugy gurmaly we onuň 

üç burçuny – ýokarky çepdekiden başgasyny tegeleklemeli. Bu superçyzygyň güýçli 

döwülmesinden azat eder. 

Pürkgüç düzgüni 

Artistic Media (Суперлиния) guralyň pürkgüç düzgüni bir tabyn obýekti 

dälde, olaryň tutuş toparyny döredýär, ol öňden kesgitlenen şekiliň nusgalaryny we 

onuň böleklerini (pürkgüjiň şablonyny) dolandyryjy çyzygyň ugry boýunça 

ýerleşdirýär. Aşakda suratda iki mysal getirilen olaryň şablony tapawutly emma 

dolandyryjy çyzyklary bir görnüşli. 

Ýöne bu düzümli obýektleri çyzyklara örän kynçylyk bilen degişli etmek 

bolýar. Pürkgüç düzgüniň funksional mümkinçilikleri örän giň. Ýagny pürkgüjiň 

şablonyna girýän şekiliň aýry böleklerini, olaryň dolandyryjy çyzykda ýerleşişini 

kesgitleýän parametrlerini, şol bölekleriň yzygiderliligini dolandyrmak mümkin. 

CorelDRAW-yň düzümindäki topluma pürkgüjiň şablonlarynyň köp mukdary girýär, 

şol şablonlaryň sanyny köpeltmegiň mümkinçiligi hem bar. Köplenç pürkgüç 

düzgüninde düzülen superçyzyklary original ramkalary we fonlary döretmek üçin 

ulanýarlar.  

 
Artistic Media ýanaşdyrylýan penjiresi  

Superçyzyklary gurmak we üýtgetmek üçin diňe Artistic Media (Суперлнния) 

guralyň atributlary panelini ulanman, eýsem deň atly ýanaşdyrylýan penjiresini 
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ulanmak bolýar. Ony ekranda görkezmek üçin Window > Dockers > Artistic Media 

(Окно > Пристыкоаываемыеокна > Суперлиния) buýrugy saýlamaly.  

 
Ýanaşdyrylýan penjirede superçyzyklaryň taýýarlanmasynyň, pürkgüjiň 

sülereýleriniň we şablonlarynyň şekilini saklaýan iki sanaw getirilen. Aşaky sanawda 

\CustomMediaStrokes bukjanyň düzümine gabat gelýän ülňileriň doly toplumy 

getirilen, ýokarkyda — ýakynda ulanylanlar. Sanawyň düzümini görkezilýän 

obýektleriň menýusy arkaly dolandyrmak mümkin, ol saga gönükdirilen üçburçlugyň 

şekilini göterýän düwmejik arkaly amala aşyrylýar. Menýuda üç sany düzgüni 

pürkgüjiň taýýarlanmasynyň, sülereýleriniň we şablonlarynyň görkezilmegini 

işledýär we öçürýär.  

Blokirowka düwmejigi ülňiniň saýlanylan çyzyga ulanmagyň düzgünini 

dolandyrýar. Eger düwmejik basylan ýagdaýda bolsa, onda sanawda bir ülňi 

saýlanylandan soň, derrew şol ülňi superçyzygy gurmak üçin ulanylýar. Eger 

düwmejik basylmadyk ýagdaýda bolsa, onda, ülňini ulanmak üçin Apply 

(Применить) düwmejigine goşmaça basmak gerek bolýar.  

Şu ýanaşdyrylýan penjiresiniň elementlerini ulanmaklyk superçyzyklary 

gurmagyň üç düzgünleri: taýýarlanma, çotga we pürkgüç düzgünleri bilen işlemegi 

gaty aňsatlaşdyrýar.  

Egri çyzygy superçyzygyň dolandyrjy egri çyzygyna özgertmek üçin, 

ýanaşdyrylýan penjiräniň iki sanawynyň birinde taýýarlanmanyň, sülereýiň ýa-da 

şablonyň gerek şekilini saýlamak we ony syçanjyk arkaly şol egri çyzygyň üstüne 

süýşürmek ýeterlikdir.  

Şekili pürkgüjiň sülereýi ýa-da şablony hökmünde ýatda saklamak üçin ony 

belläp syçanjyk bilen aşaky sanawa süýşürmek ýeterlikdir. Syçanjygyň düwmejigi 

goýberilenden soň görkezilen şekil pürkgüjiň sülereýi ýa-da şablony hökmünde ýatda 

saklanylýandygy görkezilýän gepleşik penjiresi açylýar, soňra bolsa faýlyň ady 

berilýär.  

Görkezilýän 
obýektler 

Ulanylan 
şablonlar, 
sülereýler we 
ülňiler 

Taýýarlanmany 
ýok etmek 

Sülereýi ýatda 
saklamak 

Blokirowka 

Ulanmak 
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Edil şol netijäni ýanaşdyrylýan penjiräniň Save (Сохранить) düwmejigi arkaly 

gazanmak mümkin. 

Basyşly surat çekiş düzgüni 

Bu düzgün ýörite enjamy talap edýär — tenzometrik grafiki planşeti, ol diňe 

peronyň üstünden hereketini bellemän, eýsem ulanyjynyň pero basýan güýjüni hem 

hasaba alýar.  

Bu düzgünde peronyň planşet boýunça süýşürilmegi superçyzygyň dolandyryjy 

egri çyzygyny döredýär, basyş bolsa onuň inini kesgitleýär (iň ýokary basyşly 

ýerlerde ol atributlar panelinde bellenilen guralyň inine deň bolar).  

Ekzotikanyň söýüjileri bu düzgüni planşetsiz hem ulanyp bilerler. Peronyň 

hereketini syçanjyk arkaly amala aşyryp basyşy bolsa kursory dolandyryjy klawişalar 

bilen (ýokary we aşak).  

Cyzgylaryň we ülňileriň elementleri  

CorelDRAW-daky käbir obýektler esasan ýörite şekiller: çyzgylar, ülňiler, 

diagrammalar, blok-ülňiler gurulanda ulanylýar. Kada bolşy ýaly, bu görnüşli şekiller 

dürli şertler bilen çyzylýar. Programma çyzgylary çyzmaklyga bolan standartlaryň 

hemmesini kanagatlandyryp bilmeýär, ýöne eger şekile önümiň gabara ölçeglerini 

goýmak, ýa-da onuň aýry böleklerini çykaryş çyzyklar bilen görkezmek gerek bolsa, 

bu işi CorelDRAW başarýar we munuň üçin onda ýeterlikçe güýçli gurallar bar.  

 
Olaryň köpüsi Curve (Кривая) guralyň açylýan paneline ýygnalan. 

Ölçeg çyzyklar 

Curve (Кривая) guralyň panelinde Dimension (Размерные линии) guralyň 

saýlanylmagy ölçeg ülňileriniň bir toparyny (çykaryş çyzykdan, ölçeg çyzykdan we 

ölçeg ýazgydan ybarat bolanlary) we çykaryş çyzyklary ulanmagy mümkin edýär:  

 Çyzykly ölçeg (Linear Dimension);  

 Burç ölçegi (Angled Dimension);  

 çykaryjy (Callout).  

Düzümli obýektiň içine dürli toparlaryň obýektleri girýär. Olary aýratyn 

üýtgetmek mümkin däl, üýtgetme tutuşlaýyn bolup geçýär we aýratyn obýektler 

boýunça ylalaşykly bolýar, meselem ölçeg ýazgysy üýtgedilende şoňa görä ölçeg 

ülňisiniň çykaryş çyzyklary ýa ulalar ýa-da kiçeler we ölçeg çyzygy süýşüp durar.  

Ölçeg ülňisini, edil düzümli obýekti ýaly aýry böleklere bölmek mümkin. 

Munuň üçin Arrange > Break Apart (Монтаж > Разъединить) buýrugyny saýlamaly. 

Bu buýruk ýerine ýetirilenden soň düzümli obýekt birnäçe obýektlere we obýektler 

toparyna öwrülýär. Emma bu yzyna gaýtarylmaýan hereket.  

Ölçeg ülňiler we çykaryjylar bilen işlenende uly orny atributlar paneli oýnaýar. 
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 Ölçeg ülňisiniň görnüşini saýlaýyş düwmejikleriniň topary.  

o Auto Dimension Tool (Авторазмер). Ölçeg ülňisiniň görnüşi ülňi 

düzülende syçanjygyň hereketi boýunça awtomatiki kesgitlenýär. 

Islendik çyzykly ölçegiň ölçeg ülňisini gurmagyň prosesi syçanjygyň 

düwmejiginiň üç gezek yzygiderli basylmagyndan ybarat: birinji çykaryş 

çyzygyň „ölçenilýän“ obýekte birleşýän ýerinde, ikinji çykaryş çyzygyň 

birleşýän ýerinde we ölçeg ýazgynyň we ölçeg çyzygyň ýerleşişi 

bellenilende.  

Obýektiň birleşiş nokat bolup, ölçeg ülňiniň elementleri, birleşiş çyzyklar we 

çykaryjylaryň başlary bagly bolup durýan nokat çykyş edýär. Guralyň görkezijisi 

meselem Dimension Line (Размерная линия) guralyňky — birleşiş nokadynyň 

üstünden baranda ol ekranda reňkli marker bilen görkezilýär. Birleşiş nokatlary 

hökmünde obýektleriň hemme düwünleri, şeýle hem belleýiş çäkleriň markerleriniň 

ýerleşiş ýeri degişli, eger olaryň ýerleşiş ýerinde obýektiň çyzygy bar bolsa. 

Meselem, göniburçlukda, hem-de ellipsde belleýiş çäginiň aşaky tarapynyň ortasynda 

birleşiş nokady bar. Emma şol çägiň burçlarynda göniburçlukda birleşiş nokatlary 

bar, ellipsde bolsa ýok. Primitiwleriň ortasynda birleşiş nokatlary bar.  

o Vertical Dimension Tool (Вертикальный размер). Dik ölçeg ülňisi.  

o Horizontal Dimension Tool (Горизонтальный размер). Kese ölçeg 

ülňisi.  

o Slanted Dimension Tool (Наклонным размер). Ölçeg çyzygyň eňňitli 

ugruny göz öňünde tuttýan ölçeg ülňisi.  

o Callout (Выносная линия). Ýazgyny obýektdäki birleşiş nokady bilen 

baglaşdyrylýan ýörite düzümli obýektiň saýlanylmagy.  

o Angular Dimension Tool (Угловой размер). Burçuň ölçegini goýmagyň 

ölçeg ülňisi.  

 Dimension Style (Тип измерения). Bu açylýan sanaw ölçegiň bahasyny 

görkezmegiň formadyny dolandyrýar. Sanawa şular goşulan:  

o Decimal (Десятичный) — ölçegiň bahasy onluk drob görnüşinde 

görkezilýär, onda drobuň razrýadlaryň sany ölçeýşiň takyklygynyň 

sanawynda saýlaýyş bilen kesgitlenýär;  

Eňňit ölçegi Çykaryş çyzyk 

Burç ölçegi 

Ölçegiň 
görnüşi 

Ölçeýşiň takyklygy 

Ölçeg birligi 

Tekstiň ýerleşişi Dinamiki 
baglaşdyryş 

Ölçegiň 
goşulmasy 

Ölçegiň 
prefiksi 

Ölçeg birlikleri 

görkezmek 

Awtoölçeg 

Kese ölçeg 

Dik ölçeg 
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o Fractional (Дробный) — ölçegiň bahasy garyşyk natural drob 

görnüşinde görkezilýär, onuň drob böleginiň maýdalawjysy ölçeýişiň 

takyklygynyň sanawynda saýlaýyş bilen kesgitlenýär;  

o US Engineering (Инженерный) we US Architecture (Архитектурный) 

— ABŞ standartlary.  

 Dimension Precision (Точность измерений). Bu sanawyň bahalary ölçegiň 

ähmiýetini ölçeg ýazgysynda takyklygyny dolandyrýar.  

 Dimension Units (Единицы измерения). Bu açylýan sanaw ölçeg birlikleri 

saýlamagy we olaryň görkezimegini saýlamagy mümkin edýär.  

 Тext Position (Положение текста). Ölçeg ýazgysynyň ýerleşişini kesgitleýän 

düwmejikleri saklaýan panel.  

 
 

 Dynamic Dimensioning (Динамическая привязка). Ölçeg ýazgyny 

döretmegiň düzgünini dolandyrýan düwmejik. Ol basylan ýagdaýda bolsa, 

obýektiň ölçegi her gezek üýtgedilse ölçeg ýazgysy täzeden döredilýär. 

Ýogsam ölçeg ýazgysy ölçeg ülňisi döredilende bir gezek döredilýär.  

 Suffix for Dimension (Суффикс размера). Ölçeg sanyň soňundan teksti 

goşmagy mümkin edýän meýdan.  

 Prefix for Dimension (Префикс размера). Ölçeg sanyň öňünden teksti 

goşmagy mümkin edýän meýdan;  

 Show Units for Dimension (Показывать единицы измерения): Ölçeg 

ýazgynyň düzümine ölçeg birlikleri goşmagy dolandyrýan düwmejik. 

Ölçegleri goýmak 

1. Sahypada dogry altyburçlugy guruň. Atributlar panelini ulanmak bilen onuň 

dik ölçegini 50 mm deň ediň.  

2. Gurallar toplumynda Dimension (Размерные линии) guraly saýlamaly we 

atributlar panelinde kese ölçegiň düwmejigine basyň. Kese ölçeg ülňiniň gurmagyny 

atributlar panelinde dolandyryjy parametrleri bermekden başlalyň. Ölçegiň görnüşini 

Decimal (Десятичный) ediň, ölçeg birlikleri hökmünde millimetrleri saýlaň we ölçeg 

ýazgysyna oalryň ýazylmagyny gadagan ediň. Görkezmegiň takyklygyny oturdan soň 

iki razrýada deň ediň. Guralyň görkezijisini altyburçlugyň çepki aşaky burçuna 

getiriň we birleşiş nokady reňkli marker bilen bellenilenden soň syçanjygyň 

düwmejigine basyň (aşaky surat a.)  

Ölçeg çyzygyň üstünden 

Ölçeg çyzygyň üzülmesine 

Ölçeg çyzygyň aşagyndan 

Hemişe kese boýunça 

Ýazgyny merkezleşdirme 
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3. Guralyň görkezijisini altyburçlugyň sagdaky aşaky burçuna getiriň we 

ýokarky ýaly çykaryş çyzygyň ikinji nokadyny berkidiň (ýokarky surat b.).  

4. Guralyň görkezijisini aşak süýşüriň, onuň bilen bile ölçeg çyzygy hem 

süýşer we çykaryş çyzyklar uzalar. Indi bolsa ölçeg ýazgynyň ýerleşişini kesgitleýän 

göniburçluk ortada durar ýaly görkezijini çepe süýşüriň we ýene syçanjygyň 

düwmejigine basyň. 

5. Pick (Выбор) guraly saýlaň we altyburçluga basyň. Ölçeg ülňisi 

birleşdirilenden soň obýek dolandyrylýan bolup galdy, ýagny onuň üýtgedilmegi oňa 

birleşdirilen obýektleriň awtomatiki üýtgemegine getirýär. Eger ölçeg ýazgysna 

basylsa ol aýratyn belleniler we onyölçeg ülňisiniň çäginde islendik ýerde goýmak 

bolýar, beýleki obýektler hem şoňa görä üýtgeýär. Altyburçluk oňa birleşdirilen 

hemme ölçeg ülňiler üçin dolandyryjy obýejt bolsa, ölçeg ýazgysy diňe özüne degişli 

ölçeg ülňi üçin dolandyryjy obýekt bolup durýar. 

6. Edil şolar ýaly eňňitli we dik ölçeg ülňileri çyzylýar. 

7. Burç ölçegi üçin ölçeg ülňisini çyzalyň. Birinji nokady bellemzden öň ölçeg 

ýazgyny goşulmasyny (suffiksi) girizežiň – gradusyň belgisini. Munuň üçin atributlar 

paneliniň degişli ýerine kursory goýalyň, kömekçi klawiaturany Num Lock klawişasy 

arkaly sanlaryň giriziliş ýagdaýyna geçireliň we Alt klawişasyny basyp ondan gradus 

belginiň 0176 koduny ýazalyň. Soňra ölçegiň bahasyny görkezmegiň takyklygyny 

drobly razrýadsyz edip goýalyň. Ölçeg ülňisi ondan öňkilere meňzeş çyzylýar, ema 

bir goşmaça bilen: çykaryş çyzyklaryň birleşme nokatlaryny kesgitlemezden öň 

(aşaky surat b we ç) syçanjyk bilen basmak arkaly burç ölçegiň merkezini bellemek 

gerek — çykaryş çyzyklaryň kesişýän nokadyny (aşaky surat а). Eger ölçeg ülňisi 

doly obýekt bilen baglaşdyrylan bolsa bu birleşme nokady bolmaly  

 
 

 Eger ölçeg ülňisi ýalňyş çyzylan bolsa we ony ýok etmeklik gerek bolsa ony 

Pick (Выбор) guraly saýlaň, munuň üçin dolandyryjy teksti saýlamaklyk hem 

ýeterlik we Del klawişasyna basyň. Ölçenilýän obýekt ýok edilse, onuň bilen 

bilelikde ölçeg ülňisi hem ýok ediler. 

a b ç d 

a b 

ç d 
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Eger ölçeg ülňisi gurulanda çykaryş çyzyklar obýektiň birleşme nokatlaryna 

birleşilmän bolsa onda obýekt üýtgedilende üýtgemez we obýekt ýok edilende ýok 

edilmeýär.  

8. Gurulan ülňilere üýtgetme giriziň. Hemme ütgetmeler Pick (Выбор) guraly 

bilen amala aşyrylýar. 

Çykaryş çyzyklar 

Çykaryş çyzyklar aýratyn topary düzýän düzümli obýekt bolup durýar. Olar iki 

segmentden ybarat, özem ikinji segmentiň ahyry çykaryjynyň ýazgysyna 

birleşdirilen. Ýazgy çykaryjylaryň toparynyň dolandyryjy obýekti bolup durýar. 

Ýazgynyň üýtgedilmegi çykaryjynyň ikinji segmentiniň uzynlygyna we ýerleşmegine 

täsir edýär, şonda birinji segment üýtgedilmän galýar. Ýazgynyň uzynlygynyň 

üýtgedilmegi çykaryjynyň segmentlerine täsir etmeýär. Obýekt süýşürilende hem oňa 

birleşdirilen çykaryjy hem bile süýşýär.  

Çykaryjyny çyzmagyň düzgüni Dimension (Размерная линия) guraly 

saýlanylandan we şol guralyň atributlar panelinde çykaryjynyň düwmejigine 

basylandan soň 4 amaldan ybarat.  

1. Birinji syçanjyk bilen basma birinji segmentiň başyny belleýär. Eger ol obýekte 

birleşme nokadynda ýerine ýetirilse çykaryjy obýekte birleşýär, ýogsam ol onuň bilen 

bagly bolmaýar.  

2. Ikinji syçanjyk bilen basma birinji segmentiň ahyryny we ikinji segmentiň başyny 

aňladýar. Eger ikinji segment gerek däl bolsa, onuň üçin nola deň bolan uzynlyk 

bellenilýär, şonuň üçin ikinji gezek syçanjyk bilen iki gezek basýarlar.  

3. Üçünji syçanjyk bilen basma ikinji segmentiň ahyryny we çykaryjynyň 

ýazgysynyň başlanýan ýerini aňladýar.  

Segmentleriň ugry kesgitlenende Ctrl klawişa-modifikatordan peýdalanmak 

amatly.  

4. Üçünji (ýa-da ikinji) syçanjyk bilen basmadan soň ýazgynyň girizme 

düzgüni işläp başlaýar.  

Ýazgynyň tekstini girizmegi tamamlamak üçin gurallar toplumynda Pick 

(Выбор) saýlamak ýeterlik.  

 
Düwün 
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Birleşdiriji çyzyklar 

Birleşdiriji çyzyklar çyzykly obýektleriň aýratyn toparyny düzýär, olar dürli 

ülňi şekilleri, aýratynlykda hem blok-shemalary çyzmak üçin örän amatly gural bolup 

durýar. Standart figuralar bilen utgaşykda Interactive Connector Tool 

(Соединительная линия) guraly olar bilen işlenende goşmaça amatlyklary 

hödürleýär.  

Birleşdiriji çyzygyň iki ujy hem obýekte birleşme nokatlarynda birleşmelidir. 

Çyzylandan soň birleşdiriji çyzygy birleşme nokatlaryny birleşdirýär. Birleşmegiň iki 

warianty bardyr: birleşdirilen obýektleriň özara ýerleşişine garamazdan berk kese ýa-

da berk dik göniçyzykly segmentlerden ybarat bolan döwülen çyzyk (döwülen 

birleşdiriji çyzyk) we göni çyzygyň kesimi (göni birleşdiriji çyzyk) bilen. Wariantyň 

saýlanylmagy guralyň atributlar panelinde ýerleşen Angled connector (Ломаная 

соединительная линия) we Straight connector (Прямая соединительная линия) 

düwmejikleri arkaly amala aşyrylýar. 

Birleşdiriji çyzygyň gurulmagy Interactive Connector Line (Соединительная 

линия) gural saýlanylandan soň iki amal arkaly amal aşyrylýar.  

 

 
1. Iki obýektiň birine birleşdiriji çyzygyň berleşýän nokadyny syçanjyk bilen 

basmak arkaly bellemeli.  

2. Ikinji obýekte birleşdiriji çyzygyň birleşýän nokadyny syçanjyk bilen basma 

arkaly bellemeli.  

Birleşdiriji çyzyk gurulandan soň onuň aýry segmentlerini Interactive 

Connector Line (Соединительная линия) guraly arkaly süýşürmek mümkin. 

Birleşme çyzygyň birleşýän iki obýekti onuň üçin dolandyryjy bolup durýar.  

Birleşdiriji çyzyklary gurmak 

Ilkibaşda göniburçluk bilen ellipsi çyzyň soňra bolsa olary birleşdiriji 

çyzyklaryň ikisi bilen baglaşdyryň, özem olary birleşme nokatlaryň iki aýry jübüdi 

bilen birleşdiriň. Ikinji birleşdiriji çyzygy döretmezden öň birleşdiriji çyzygyň 

görnüşini üýtgetmeli. Soňra Pick (Выбор) guraly arkaly dolandyryjy obýektleriň 

birini saýlamaly we ony ikinjiň daşyndan süýşürip duruň.  

Halkajyň ahyrky 
nokady 

Halkajyň 
başy 

Birleşdiriji çyzyk 
Birleşdiriji çyzygyň düwüni 

Interactive Connector 
Line guralyň görkezijisi 
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Aýry ýagdaýlarda birleşdiriji çyzyk obýekte diňe bir ujy bilen birleşdirilip 

bilner. Şonda ikinji ujy sahypa birleşdirilen diýlip hasaplanylýar. Obýekte 

birleşdirilen birleşdiriji çyzygyň ujuny soňra aýryp bolýar, aýrylany bolsa birleşdirip 

bolýar. Döwülen birleşdiriji çyzygyň segmentiniň ortasynda birleşme nokady 

ýerleşýär şol sebäpli döwülen birleşdiriji çyzyga beýleki birleşdiriji çyzygy 

birleşdirmek mümkin. 
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TEKSTLER BILEN IŞLEMEK 

  

Corel Draw-da tekst esasy iki bölege bölünýär - figura we ýönekeý tekstlere. 

Figura teksti 

Umuman figura teksti özi bilen köp derejeli birleşdirilen obýekt bolup durýar. 

Bir derejeli obýektler bilen birnäçe biri-biri bilen baglaşdyrylmadyk şahalardan 

ybarat bolan we bitewi obýekt hökmünde özüni alyp barýan egrilere seredilende 

tanyşylypdy. Eger şeýle obýekti belläp, soňra Arrange > Break Apart (Монтаж > 

Разъединить) buýruk saýlanylsa, ol adaty obýektlere öwrülýär. Figura tekstiň blogy 

bölünende özüni başgaça alyp barýar. Birinji bölünmeden soň ol, başlangyç figura 

tekstiň setirlerine gabat gelýän figura tekstleriň utgaşmasyna öwrülýär. Setiriň 

bölünmesi sözleriň utgaşmasyny berer, sözüň bölünmesi bolsa simwol bolup durýan 

figura teksti berýär. 

 
Ters amal hem mümkin. Munuň üçin Arrange > Combine (Монтаж > 

Соединить) buýrugy ýerine ýetirmeli. 

Figura tekstiň atributlary 

 Her bir simwol üçin şu atributlar degişli: 

 Garnitura (font). Elipbiýiň simwollarynyň şekillerine garnitura diýilýär..  

 Kegl (size). Bendlerde tekstiň simwollarynyň beýikligine kegl diýilýär. 

Käwagt garnituranyň we kegliň utgaşmasyna kegl diýilýär (meselem, 

deslapdan figura tekstleri Avant Garde Bk ВТ 24 bentli şrift bilen çykarylýar). 

Garnituranyň we kegliň täsirini aşakda görmek mümkin 

 
 Şekili (style). Ştrihleriň galyňlygyny üýtgetme we olaryň eňitliginiň hasabyna 

bolup geçýän tekstleriň simwollarynyň suratynyň modifikasiýasyna şekil 

diýilýär. Standart şekiller hökmünde adaty (Normal), kursiwli (Normal-Italic), 

ýarym goýy (Bold) we ýarym goýy kursiwli (Bold-Italic) hasaplanylýar. 

  

Setir Setir Setir 

Söz Söz Söz 

Simwo
l 

Simwo
l 

Simwo
l 

Figura tekstiň blogy 
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 Aşagyny çyzma (underline), üstüni çyzma (strikethra) we üstünden çyzma 

(overscore). Çyzmak üçin standart çyzyklar bolup CorelDRAW-da inçe ýeke 

çyzyk (Single Thin), galyň ýeke çyzyk (Single Thick) we goşa inçe çyzyk 

(Double Thin) hasaplanylýar. Her bir toplum üçin diňe probelsiz teksti 

çyzmagy mümkin edýän modifikasiýa gönükdirilen (degişlilikde Single Thin 

Word. Single Thick Word и Double Thin Word). CorelDRAW-da çyzyklaryň 

standart toplumynyň parametrlerini üýtgetmek mümkin (galyňlygyny, tekstiň 

baza çyzygyndan bolan aralygy, goşa çyzyklaryň arasyndaky aralygy).  

 
 

 Simwollaryň registrini (uppercase). Bu atribut registriň özgerdilmegini hasaba 

almak bilen simwollaryň görkezilmegini dolandyrýar. Ol üç baha eýe bolup 

bilýär: özgerdilmesiz (None), kapitel (Small CAPS) kapitallaşdyryş (All 

CAPS). Kapitel özgerdilmegi işledilende hemme setir simwollary adaty 

beýiklige eýe, emma surat boýunça olar degişli uly harplara gabat gelýär. 

Kapitallaşdyrma özgerdilmegi setir simwolalryň deregine olaryň baş 

harplaryny görkezýär.  

 Indeks düzgüni (position). Bu atribut simwolalry ýokarky (setiriň üstündäki) 

we aşaky (setir aşagyndaky) indeksleri döredýär.  

 Simwollaryň süýşmegi (character shift). Bu topara üç atribut girýär: смещение 

keselik(Horizontal), diklik(Vertical) we burçlaýyn (Rotation) süýşme. Aşaky 

suratyň ýokarky setirinde käbir simwollar üçin diklik boýunça süýşme,orta 

setirde — kese boýunça, aşakyda — bir harp üçin goşmaça kese we dik 

süýşme we 160° öwrüm ulanylan.  

 
Figura tekstiň blogy üçin şeýle atributlar kesgitlenen.  

 Deňeşdirme (alignment):  

o None (Отсутствует) — sözler bloguň çep araçägi boýunça deňleşýär, 

emma, keselik boýunça süýşmegiň otrisatel bahalaryny girizmek bilen 

aýry simwollary ondan hem çepräk çykarmak mümkin;  

o Left (По левому краю) — sözler bloguň çep araçägi boýunça deňleşýär, 

eger şonda aýry simwollar çepe süýşse, onda olar bloguň çep 

araçäginden çepe çykarymagyň deregine hemme beýleki setiriň saga 

süýşmegi bolup geçýär;  

o Center (По центру) — sözler merkezden deňleşip başlanýar;  
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o Right (По правому краю) — sözler bloguň sag araçägi boýunça 

deňleşýär, eger şonda aýry simwollar saga süýşse, onda olar bloguň çep 

araçäginden çepe çykarymagyň deregine hemme beýleki setiriň çepe 

süýşmegi bolup geçýär;  

o Full Justify (По ширине) — sözler sag we çep araçäkler boýunça 

deňleşýär, emma söňky setiri çep araçägi boýunça deňleşýär;  

o Force Justify (Полное по ширине) — ýokarky ýaly, emma soňky setir 

hem ini boýunça iki araçäk bilen deňleşýär.  

 Interlinýaž (line space). Bu atribut figura tekstiň blogunyň goňşy setirleriniň 

arasyndaky aralygy dolandyrýar. San bilen interlinýaž tekstiň goňşy setirleriň 

baza çyzyklarynyň arasyndaky aralyga deň. Deslapdan bu ululyk CorelDRAW-

da saýlanylan şriftiň simwollarynyň beýikliginiň göteriminde görkezilýär.  

 Interwallar (space). CorelDRAW-da goňşy simwollaryň arasyndaky 

(Character) we goňşy sözleriň arasyndaky (Word) aralyklary mejbury 

üýtgetmek mümkinçiligi bar. Simwolara aralygyň üýtgedilmegine treking 

diýilýär. Sözara aralyk deslapdan 100% deň.  

Figura tekstiň bloguny döretmek 

Hem figura teksti, hem-de ýönekeý teksti CorelDRAW-da Text (Текст) guraly, 

emma aýry usular bilen döredilýär. Text (Текст) guraly saýlanylandan soň aşakdaky 

atributlar çykýar.  

 
 

Figura tekstiň bloguny başlamak üçin tekstiň ýerleşmeli ýerine syçanjyk bilen 

basmaklyk ýeterlik. Sahypada dik çyzyk hökmünde tekst kursory emele geler.  

Girizme prosesini tizleşdirmek ýa-da bloga teksti import etmek üçin, girizme 

we redaktirleme düzgüniň düwmejigine basylandan soň açylýan penjireden 

peýdalanmak mümkin.  

Stil Garnitura Kegl 

Ýarym goýy 

Ýarym goýy 

Çyzma 

Deňleşdirme Girizme we redaktirleme düzgüni 

Formatirlemegiň gepleşik penjiresi 

Çap edilmeýän simwollaryň görkezilmegi 
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Bu ýerde köp düwmejikler esasy atributlar panelindäki düwmejikleri 

dublirleýär. Aýratyn orny F şekilli düwmejik tutýar — ol Format Text 

(Форматирование текста) gepleşik penjiresini açýar.  

 

 
 

Garnitur
a 

Kegl Şekil Deňleşdirme 

Çap edilmeýän simwollaryň görkezilmegi 

Formatirleme 

Import etmek Goşmaça 

Garnitura 

Kegl 

Stil 

Aşagyny 
çyzma 
Üstüni çyzma 

Üstünden 
çyzma 
Registr 

Indeks 
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 Import (Импортирование). Bu düwmejik teksti başga faýldan almagy mümkin 

edýän gepleşik penjiresini açýar.  

 Options (Дополнительно). Bu düwmejige basylsa aşakdaky kontekst 

menýuny açýar, bu menýu tekst bilen işlemek üçin kömekçi gurallara el-

ýeterligi üpjün edýär.  

 
Figura teksti girizmek, redaktirlemek we formatirlemek 

1. Text (Текст) guraly saýlaň we syçanjyk bilen sahypanyň ýokarky bölegine 

basyň. We belli bir teksti giriziň.  

2. Atributlar panelinde çap edilmeýän simwollar düzgüniniň düwmejigine 

basyň we probelleriň deregine kiçijik tegelekleriň, setirleriň ahyrlarynda abzasyň 

soňunyň simwollarynyň emele gelendigine üns beriň  

3. Tekste ýörite simwol girizmek üçin Text > Insert Character (Текст > 

Вставка символа) buýrugy bilen Insert Character (Вставка символа) ýanaşýan 

penjiresini açalyň. Bu ýerde garniturany saýlap, olaryň içinden gerekli simwoly 

syçanjyk bilen gerekli ýere süýşüriň. Onuň reňkini üýtgetmek üçin ekran 

palitrasyndaky belli bir reňke basyň.  

Edil şeýle usul bilen figura tekste islendik wektor şekilini goýmak mümkin. Bu 

ýagdaýda ol Text (Текст) guralyň görkezijisi arkaly ýanaşýan penjireden dälde, 

gönümel sahypadan geçirilýär. Goýulmazyndan öň şekiliň ölçegleri şol şriftiň 

standart simwolynyň ölçeglerine deň edilip getiriler we geljekki kegliň üýtgemegi şol 

goýlan şekile hem täsir eder. Beýle şekiller tekstiň içine goýlan diýlip atlandyrylýar. 

Bu şekili standart usullar arkjaly redaktirlemek mümkin däl.  
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4. Teksti redaktirlemegiň penjiresine atributlar panelindäki düwmejige basyp 

geçiň Options > Replace Text (Дополнительно > Заменить текст) buýrugy ýerine 

ýetirip, kontekst çalşyryşyň gepleşik penjiresini açyň we belli bir sözi alyp başga söze 

Replace All (Заменить все) düwmejigine basyp çalşyryň.  

5. Aýry islendik bölekleri Text (Текст) guraly bilen belläp, olaryň kegelini we 

garnituralaryny üýtgediň. Deňleşdiriş düzgünleriniň täsirlerini barlap görüň. 

Interlinýažyň bahasyny keglden 120% etmek üçin formatirleme penjiresi açyp görüň.  

6. Ahyrynda figura tekstiň bloguny bölüň. Arrange > Break Apart (Монтаж > 

Разъединить) buýrugyny saýlaň. Üns berseňiz markerler tutuş blogy gurşaman onuň 

diňe birinji setirini belleýärler. Amaly ýene iki gezek gaýtalaň – setiri sözlere, soňra 

bolsa — sözi aýratyn simwollara bölmek üçin. 

Ýönekeý tekst  

Edil figura teksti ýaly köp derejeli birleşen obýekt bolup durýar, emma 

bölünende ýönekeý tekstiň geçýän derejeleri kän. Ýönekeý tekstiň uly mukdary 

bölünende şular emele gelip biler: tekstiň sütünleri, sanaw bendleri, abzaslar, setirler, 

sözler, simwollar. Mundan başga hem, figura teksti bilen tapawutlylykda ýönekeý 

tekst gönümel çap sahypasynda ýerleşip bilmeýär. CorelDRAW-da islendik ýönekeý 

tekst ýörite obýekt – ýönekeý tesktiň ramkasynyň içinde (paragraph text frame) 

ýerleşýär. Baglaşyklar arkaly ramkalar düzümli obýekt – ýönekeý tekstiň 

ramkalarynyň yzygiderliligini, onuň aýry elementleri aýry sahypalarda hem ýerleşip 

biler CorelDRAW. Ýönekeý tekstiň ramkanyň baza formasy— göniburçluk, emma 

olar soň oslendik görnüşleri alyp biler. 

Ýönekeý teksti döretmek we redaktirlemek 

Ýönekeý tekst Text (Текст) guraly arkaly döredilýär. Emma onuň 

döredilmezden öň syçanjygyň görkezijisini boljak ramkanyň burçunyň ýerleşmeli 

ýerine getirmeli we ony diagonal boýunça süýşürmeli. Syçanjygyň düwmejigi 

goýberilenden soň, ramka emele geler, onuň içinde dik çyzyk görnüşinde tekst 

kursory ýerleşer. Ramkanyň içinde ýerleşen tekst onuň daşyna çykyp bilmeýär, we 

sag araçägine ýetilende ol awtomatiki täze setire geçýär, abzas döretmek üçin bolsa 

Enter klawişasyna basmak ýeterlik. Eger tekst 

aşaky araçägiň aşagyndan hem aşak düşse onuň 

şol bölegi görünmän galar. 

Eger ýönekeý tekstiň uly mukdaryny 

girizmek gerek bolsa, ony başga tekst 

prosessorynda taýýarlap, soňra bolsa Edit Text 

(Редактирование текста) penjiresiniň Import 

düwmejigi ulanyp ony geçirmeli. Programmada 

alynan tekstiň abzaslarynyň we simwollarynyň 

başlangyç formatirlenmegini, diňe simwollaryň 

formatirlenmegini saklamagy ýa-da import 

edilýän teksti diňe simwollaryň yzygiderliligi 

hökmünde goýmak mümkinçiligi bar.  

Ýönekeý teksti redaktirlemek üçin, oňa 

Text (Текст) guralyň görkezijisi bilen basmaly, 
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ýa-da ramka Pick (Выбор) guraly bilen basyp atributlar panelinden Edit Text 

(Редактирование текста) gepleşik penjiresini çagyrmaly. 

Baglanan ramkalaryň yzygiderliligini döretmek 

Baglanan ramkalaryň yzygiderliligini bir tekst bölegini bir sahypanyň birnäçe 

ýerinde ýa-da birnäçe sahypada ýerleşdirmek üçin ulanylýar. Gürrüň göçürmeler 

barada dälde, bir ramkadan beýlekä geçilende tekstiň dowamy barada gidýär (çepki 

surat). 

Eger ramkanyň içindäki tekst doly görkezilmeýän bolsa, onda ramkanyň aşaky 

çäginiň ortasynda ýerleşen indikator aşak gönükdirilen strelkaly göniburçlugyň 

görnüşini alýar. Syçanjyk bilen şol indikatora basylan ýagdaýynda guralyň görkezijisi 

tekstli listiň görnüşini alýar (aşaky surat).  

 
Yzygiderlige täze ramkany goşmak üçin görkezijini onuň diagonaly boýunça 

süýşürmek ýeterlikdir (aşaky surat).  

 
Bir yzygiderlilige girýän ramkalar reňkli strelkalar bilen görkezilýär. Ýokarky 

we aşaky indikatorlaryň formasy boýunça ramkanyň yzygiderlilikde tutýan ýeri we 

onda sygmadyk tekst barada barada gürrüň edip bolýar. Birinji ramkada ýokarky 

indikator boş. Eger ramka yzygiderlilikde iň soňky däl bolsa, onuň aşaky indikatory 

tekstli kiçi sahypa görnüşinde görkezilýär; eger ramka birinji däl bolsa, onuň ýokarky 

indikatory tekstli kiçi sahypa görnüşinde görkezilýär. Eger ramka iň soňky bolsa 

onuň aşaky indikatory boş bolýar ýa-da sygmadyk tekst bolsa aşak gönükdirilen 

strelkany saklaýar. 

Eger yzygiderlilikdäki ramka islendik görnüşe eýe bolar ýaly, ilkibaşda şol 

ýapyk obýekti gurmaly, soňra guralyň görkezijisini aşaky indikatora basyp tekst bilen 

“zarýadlamaly”. Indi görkeziji şol ýapyk obýektiň içine süýşürilende ol saga 

gönükdirilen giň strelka görnüşine eýe bolar. Syçanjyga basylandan soň obýektiň 

formasy bilen gabat gelýän ramka emele gelýär we sygmadyk tekst onuň içine 

ýazylýar. 
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Ýokarky amalyň netijesinde ýapyk figuradan (dolandyryjy obýekt) we 

göniburçluk ramkadan ybarat bolan düzümli obýekt emele gelýär. Ramka düzülenden 

soň dolandyryjy obýekt gerek däl, sebäbi onuň üýtgedilmegi ýönekeý tekstiň 

ramkasyna täsir etmeýär. Şol sebäpli düzümli obýekti Arrange > Break Apart 

(Монтаж > Разъединить) buýrugy bilen bölüp ýapyk egrini ýok etmek bolýar.  

Eger guralyň görkezijisi “zarýadlanandan” soň syçanjyk bilen ýapyk egrine 

basylman açyk egrisine basylsa, onda egrini bellemegiň ramkasy bilen gabat gelýän 

göniburçluk ramkasy emele geler we oňa düşen tekstiň başy şol egriniň ugry boýunça 

ýerleşdirilýär galan tekst bolsa ýerleşmedik bolup galýar. 

Yzygiderlilige girýän ramkany ýok etmek üçin ony Pick (Выбор) guraly bilen 

saýlap Del klawişasyny basmak ýeterlik. Eger soňky ramka ýok edilse, ondan 

saklanylýan tekst ondan öňki tekste sygmadyk hökmünde geçirilýär. Birinji ramka 

ýok edilende tekst ikinji geçirilýär, ikinjiden üçünjä we ş.m. Tekstiň artykmaçlygy 

hemişe soňky ramkada ýerleşdirilýär (sygmadyk tekst hökmünde). Aralykdaky ramka 

ýok edilende awtomatiki täze baglanyşyk döredilýär.  

Baglanan ramkalaryň yzygiderliligini islendik ýerde gurmak mümkin. Eger 

täze ramka döredilende onuň yzyndan gelýän ramkalar hem bar bolsa, onda yzky 

ramkalardan tekst awtomatiki öňki ramka geçýär.  

Yzygiderliligiň düzümine girýän ramkalar dürli sahypalarda ýerleşip biler. 

Beýleki sahypada ramka döredilende guralyň görkezijisi “zarýadlanandan” soň şol 

sahypa geçmeli we tekst ramkasyny döretmeli.. Eger öň döredilen ramkany beýleki 

sahypa geçirmek gerek bolsa, ilkibaşda ony Pick (Выбор) guraly bilen sahypanyň 

daşyna çykarmaly, beýleki sahypa geçip iş stolundan şol ramkany sahypanyň içine 

süýşürmeli. 

Ýene-de bir zady bellemek, eger islendik tekst Copy buýrugy bilen 

göçürilende, onda islendik (ýapyk hem bolsa) obýektiň daşky çyzygynyň üstüne Text 

guralynyň görkezijisi getirilende, ol A harpyň ýanynda egri çyzygyň görnüşini alar, 

şol ýagdaýda syçanjygyň düwmejigine basylsa kursor obýektiň içinde däl-de daşky 

sudurynyň üstünde durar. Bu ýagdaýda Paste buýrugy ýerine ýetirilse tekst obýektiň 

sudurynyň üstünde ýerleşer, eger tekstiň uzynlygy sudurda uly bolsa, onda sygmadyk 

tekst gaýtadan suduryň daşyndan aýlanar – tä soňky simwol aýlanýança (dürli 

aýlawdaky emma bir ýerde duran simwollar biri-biriniň üstünde ýerleşer). 

Tekst bilen aralaşma 
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Bu düzgün tekst bilen aralaşmagy None (Без обтекания) baha eýe bolmadyk 

üçin hemme obýektler üçin işleýär. Bu atribut atributlar panelindäki Wrap Paragraph 

Text (Обтекание простым текстом) düwmejigi bilen bagly bolan menýudan 

çagyrylyp bilner (aşaky surat). Mundan başga hem yş, ýagny tekst bilen obýektiň 

arasyndaky minimal aralyk bellenilip bilner.  

 
Aşaky suratda obýektiň sudury boýunça aralaşma görkezilen: a – aralaşmasyz, 

b - çepki aralaşma, ç - sagdaky aralaşma, d – töwerekleýin aralaşma 

 
 

Aşaky suratda belleýiş çäk boýunça aralaşma görkezilen: a –- çepki aralaşma, b 

- sagdaky aralaşma, ç – töwerekleýin aralaşma, d – kesimleýin aralaşma. 

Belleýiş çägi göniburçluk bolany sebäpli aralaşma hem degişli görnüşde amala 

aşyrylýar. 

Aralaşmasyz 

Sudur boýunça 
aralaşma 

Belleýiş çägi 
boýunça 
aralaşma 

Çepki aralaşma 

Sagdaky 
aralaşma 
Töwerekleýin 
aralaşma 

Çepki aralaşma 

Sagdaky 
aralaşma 
Töwerekleýin 
aralaşma 
Kesimleýin aralaşma 

Yş 

a b 

ç d 
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Ýönekeý tekstiň atributlary 

Figura tekstiň hemme atributlary ýönekeý tekstde hem bar, emma soňkuda 

düzüm bölekleriň sany köpräkdigi sebäpli Format Text (Форматирование текста) 

gepleşik penjiresiniň goşmaçalarynda goşmaça elementler emele gelýär.  

Programmanyň öňki wersiýalary bilen 

tapawutlylykda soňky wersiýalarda Format Format Text 

(Форматирование текста) gepleşik penjiresiniň köp 

funksiýalary Text menýusyna geçirilipdir.  

Text menýusynyň Paragraph Formatting bendine 

basylsa aşaky ýanaşýan penjire açylýar.  

Alingment bölüminde deňleşdimäni keslik we (ýa-da) 

diklik boýunça amala aşyrmak mümkinçiligi bar. 

Spacing (Интервалы) hasaplaýjylaryň topary Before 

paragraph (Перед абзацем) we After paragraph (После 

абзаца) hasaplaýjylary saklaýar, olar abzalaryň arasynda 

boş aralyklary goýmagy mümkin edýär, Line 

hasaplaýjysy bolsa islendik bellenilen setirleriň 

arasyndaky boşluklary dolandyrýar. Deslapdan abzasyň 

öňündäki interwal setirara interwala deň (100%), 

abzasdan soňky nola deň bolýar. 

Indents (Отступы) hasaplaýjylaryň topary abzas 

aralyklary bellemegi mümkin edýär.  

 

o Left (Левый) hasaplaýjysy abzasyň setirleriniň (birinjidn başga) birinji 

simwollaryň deňleşýän dik çyzyga bolan ýönekeý tekstiň ramkasynyň 

çep araçäginden aralygy belleýär.  

o Right (Правый) hasaplaýjysy abzasyň setirleriniň (birinjidn başga) 

birinji simwollaryň deňleşýän dik çyzyga bolan ýönekeý tekstiň 

ramkasynyň sag araçäginden aralygy belleýär.  

First line (Первая строка) hasaplaýjysy abzasyň birinji setiri üçin çepki aralygy 

belleýär. 

a b 

ç d 
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Text menýusyndaky Hyphenation 

Settings (Установки переноса) bendi 

kömekçi gepleşik penjiresini açýar, bu 

penjire sözleriň geçirilmegini 

dolandyrýan elementleri saklaýar. 

o Automatic hyphenation 

(Автоматическая 

расстановка переносов) 

baýdajygy sözleri 

geçirmegi awtomatiki 

edýär.  

o Break capitalized 

(Разбивать прописные) 

baýdajygy baş harplardan bolan sözler üçin geçirmekligi gadagan edýän 

düzgüni ýatyrýar.  

o Hot zone (Зона переноса) hasaplaýjysy geçiriş zolagyň inini belleýär, ol 

ýönekeý tekstiň sag araçägine ýanaşýar. Eger söz setire sygmaýan bolsa, 

onda awtomatiki geçiriş düzgünde şol sözüň başy nirede ýerleşýändigi 

barlanylýar, eger ol geçiriş zolagyna düşýän bolsa onda ol indiki setire 

geçirilýär. Eger sözüň başy geçiriş zolakdan çepde ýerleşýän bolsa, onda 

onuň bölegini geçirmeklik synanyşylýar.  

Geçiriş zolagy näçe inçe bolsa, şonça herm geçiriş nyşany (-) bilen tamamlanýan 

setirleriň sany köp bolar we setirler dykyz bolar 

o Min. word length (Минимальная длина слова) hasaplaýjysy geçirilip 

bilinjek sözdäki simwollaryň iň az sanyny belleýär (deslapdan — 6 

simwol).  

o Min. characters before (Минимальное число символов до) we Min. 

characters after (Минимальное число символов после) hasaplaýjylary 

degişlilikde geçiriş nyşandan öň we soň setirde galmagy mümkin bolan 

simwollaryň iň az sanyny belleýär. 

Tabulýasiýa 

Ýönekeý tekst bilen işlenende tabulýasiýanyň ornuny tekstiň koordinata 

çyzgyjyň ýa-da Text menýusynyň Tabs (Табуляции) bendi arkaly bellemek mümkin. 

Bende basylanda Tab Setting gepleşik penjiresi açylýar. Penjirede üç sütünden 

ybarat bolan jetwel bar. Jetweliň birinji sütün degişli tabulýatoryň ornuny görkezýär. 

Alignment (Выравнивание) sütüniň öýjügine basylsa tabulýasiýa orny üçin 

deňleşdirmegiň görnüşini saýlamagyň sanawy görkezilýär: Left (Çep), Right (Sag), 

Center (Merkez boýunça) или Decimal alignment (onluk nokady boýunça).  

Leadered (С заполнителем) baýdajyklaryň sütüni, tabulýasiýanyň orny 

dolduryjy bilen baglymy ýa-da ýokdygyny görkezýär. Dolduryjy setiri 

tabulýasiýanyň öňki we şol wagtky orunlary boýunça deňlenen tekstleriň arasynda 

adaty probelleriň deregine doldurýan simwollaryň gaýtalanýan yzygiderliligi bolup 

durýar. 
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Simwol-dolduryjyny bellemek üçin 

Penjirede ýerleşen Leader Option 

düwmejigine basmaly. Açylan 

penjirede Character (Символ) 

meýdanyna simwoly girizmeli. 

Deslapdan dolduryjy hökmünde 

probel ulanylýar. Spacing 

(Интервал) hasaplaýjysy 

dolduryjydaky simwolara aralygy 

dolandyrýar. 

Bir abzasyň çäginde 

dolduryjynyň sazlanmasynyň diňe 

bir warianty ulanylyp bilner.  

 

 

Tabylýasiýanyň täze ornuny girizmek üçin Add (Добавить) düwmejigine 

basmaly, eger orny ýok etmek gerek bolsa şol orny belläp Remove (Удалить) 

düwmejigine basmaly, hemme orunlary ýok etmek üçin Remove All (Удалить 

все)düwmejigine basmaly. 

 
Tekstiň sütünleri 

Ramkanyň çäginde ýerleşdirilen teksti birmnäçe sütünlerde ýerleşdirmek 

mümkin (8-den köp däl). Tekstiň sütünleri deň ýa-da dürli inli bolup biler. Sütünleri 

dolandyryş elementler Text menýusynyň Columns bendi bilen çagyrylýan Columns 

Settings gepleşik penjiresinde ýerleşdirilen. 

 Number of columns (Число колонок) hasaplaýjysy ýönekeý tekstiň bölünýän 

sütünleriň sanyny berýär.  

 Width (Ширина) sütünde tekstiň sütünleriniň her biriniň inini girizmek bolýar.  

 Gutter (Средник) sütünde ara zolagyň inini görkezmek bolýar.  

 Equal column width (Колонки равной ширины) baýdajygy iniň we orta 

zolagyň atributlary diňe birinji sütün üçin berilýän beýleki sütünler bolsa şoňa 

meňzeş atributlary alýan düzgüni işledýär. 

 Framme Settings bölüminde Maintain current frame width (Сохранять 

ширину рамки) pereklýuçatel goýlan bolsa, onda abzasyň ramkasynyň ini 

hemişe sütünleriň inine we orta zolaklaryna garaşsyz bolup durýandygyny 
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görkezýär. Automatically adjust frame width (Автоматически изменять 

ширину рамки) pereklýuçatel goýlanda ramkanyň ini hemişe üýtgäp we 

sütünleriň jemi inine we orta zolaklaryna deň bolup durar.  

 

  
Markirlenen sanawlar we bukwisalar 

Bu effektler Tekst menýusynyň Bullet (Маркер списка) hem-de Drop cap 

(Буквица) bendleri arkaly çagyrylýan gepleşik penjiresi bilen amala aşyrylýar.  

Markirlenen sanaw Bullet (Маркер списка) gepleşik penjiresi bilen amala 

aşyrylýar: 

 Font (Шрифт) açylýan sanaw simwollary Symbol (Символ) sanawynda 

görkezilýän şriftiň garniturasyny saýlamagy mümkin edýär. 
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 Size (Размер маркера) hasaplaýjysy sanawyň markeriniň keglini kesgitleýär. 

Deslapdan onuň bahasy abzasyň birinji simwolynyň kegli boýunça goýulýar.  

 Baseline shift (Смещение маркера) hasaplaýjysy sanawyň markeriniň abzasyň 

birinji setiriniň baza çyzygyna görä diklik boýunça süýşmegini kesgitleýär.  

 Spacing meýdanynyň Text frame to bullet hasaplaýjysy tekstiň ramkasynyň we 

sanawyň markeriň arasyndaky aralygy belleýär, Bullet to text hasaplaýjysy 

sanawyň markerinden oňa degişli tekste bolan aralygy kesgitleýär. 

 Penjiredäki Use handing indent style for bulleted lists pereklýuçateli 

işledilende markerli abzasyň birinjiden soňky gelýän setirler birinji setir bilen 

çep araçäkden deň aralyklda ýerleşdirilýär, eger ol pereklýuçatel işledilmedik 

bolsa onda birinji setir markerden aralykda ýerleşip, ondan soňky gelýän 

setirler marker bilen çep araçäkden deň aralykda ýerleşer.  

 

Poligrafiýada bukwisa diýip, abzasyň beýleki tekstine görä aýratyn 

ýerleşdirilen we has uly kegl bilen alnan abzasyň birinji simwolyna aýdylýar.  

Drop cap (Буквица) penjiresinde aşakdaky elementler bar: 

 Appearance meýdanynyň Number of lines dropped hasaplaýjysy tekstiň 

setiriniň sanyny kesgitleýär, olaryň umumy beýikligi hem bukwisanyň 

beýikligi hökmünde alynýar.  

 Space after drop cap hasaplaýjysy bukwisanyň sag gyrasynyň we tekstiň 

arasyndaky aralygy kesgitleýär.  

Penjiredäki Use handing indent style for drop cap pereklýuçateli işledilende 

bukwisaly tekstiň birinjiden soňky gelýän setirler birinji setir bilen çep araçäkden deň 

aralyklda ýerleşdirilýär, eger ol pereklýuçatel işledilmedik bolsa onda birinji setir 

bukwisadan aralykda ýerleşip, ondan soňky gelýän setirler bukwisa bilen çep 

araçäkden deň aralykda ýerleşer. 

 
Ýönekeý tekst bilen işlemek 

Ýönekeý tekst bilen işlemekigiň usullaryny öwrenmek üçin belli bir şertli 

menýunyň makedini döredeliň. Onuň suraty aşakda getirilen  

1. Text (Текст) guraly saýlap, sahypanyň ýokarky böleginde ýönekeý tekstiň 

bloguny dörediň we Edit Text (Редактирование текста) gepleşik penjiresine geçiň.  
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2. Teksti giriziň hem-de ony gerekli abzaslara Enter bilen bölüň. Menýunyň 

bölümleriniň atlary aýry abzaslarda ýerleşmelidir. Tekst girizilenden soň Edit Text 

(Редактирование текста) gepleşik penjiresini ýapyň.  

 
3. Aýry abzalar üçin garnituralary we keglleri belläň.  

4. Tekst kursory menýunyň bölümleriniň atlarynyň abzaslaryna goýup 

bukwisalaryň parametrlerini goýuň (bu maketde atlar uly däl we bukwisalaryň 

beýikligini iki setiriň beýikliginden ýokary etmeklik zerur däl).  

5. Menýunyň her bir bölüminiň naharlaryna gabat gelýän abzalary belläp olar 

üçi sanaw markerlerini belläň.  

6. Ýönekeý tekstiň baglanan ramkalarynyň yzygiderliligini dörediň. 

Yzygiderlilikde alty ýa-da üç ramka gerek bolar, soňky ýagdaýda iki soňky 

ramkadaky teksti birnäçe sütünde ýerleşdirmeli bolar. 

Figura we ýönekeý tekstiň özara özgertmeleri 

Figura teksti ýönekeýe özgertmek mümkin. Kesgitli şertler berjaý edilende ters 

özgerme hem mümkin.  

Figura teksti ýönekeýe özgertmek üçin ony Pick (Выбор) guraly bilen 

bellemeli, soňra bolsa Text > Convert To Paragraph Text (Текст > Преобразовать в 

простой текст) buýrugy saýlamaly.  

Ýönekeý teksti figura tekstine özgertmek üçin ony Pick (Выбор) guraly bilen 

bellemeli, soňra Text > Convert To Artistic Text (Текст > Преобразовать в 

фигурный текст) buýrugy saýlamaly.  

Ýönekeý tekst özgerdilende onuň käbir elementleri ýitýär: tesktiň sütünleri, 

bukwisanyň tabulýasiýa orny. Ýönekeý tekstiň ramkasynda ýerleşmedik tekst bar 

bolsa, ýa-da ol ramkalaryň yzygiderliligine girýän bolsa, ýa-da oňa ýörite özgerdilme 
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ulanylan bolsa (meselem, tektiň egri çyzyk boýunça ýewrleşdirilmegi), figura tekstine 

özgerdilme mümkin däl. 
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OBÝEKTLER 

Obýektleri gurallaryň görkezijileri bilen bellemek  

Obýektleri bellemek üçin Pick (Выбор) guralyny ulanmak gerek.  

Deslapdan reňksiz obýektiň çäginde syçanjygyň basylmagy ony edil reňkli 

obýekti belleýän ýaly belleýär. Emma reňk ýok bolanda obýekt açyk we onuň 

yzyndaky obýektler görüner ýşne olary bellemek mümkin däl bolar. Eger hemme 

obýektleriň bellenilşini ýatyryp atributlar panelinde Treat As Filled (Считать 

заполненными) düwmejik basylsa reňksiz obýektiň bellenilmegi şol obýektiň 

abrisiniň islendik nokadyna basylsa amala aşyrylýar, eger ol düwmejik goýberilen 

bolsa reňksiz obýektiň bellenilmegi diňe onuň suduryna basylan ýagdaýynda amala 

aşyrylar.  

Bellenilen obýekt ekranda bellenış ramka 

bılen gurşalýar, ol ramka 8 markerden ybarat, 

onuň merkezinde kese krest görnüşindäki ýene 

bir marker goýulýar. 

Obýektiň bellenilmegi ýatyrmak üçin Pick 

(Выбор) guraly bilen sahypanyň islendik ýerine 

basmaly ýa-da Esc klawişasyna basmaly.  

Aýry ýagdaýlarda syçanjyk bilen 

basylandan soň obýekt dälde, obýektleriň topary 

bellenilýär. Topar diýlip toparlaşdyrma amaly 

arkaly baglanan obýektleriň utgaşmasyna 

aýdylýar. Özgertme amallary ulanylanda topar 

bitewi obýekt hökmünde bolýar, bellenişde bolsa olaryň birine syçanjygyň 

basylmagy şol obýekti bellemän tutuş topary 

belleýär.  

Eger topara girýän obýekti bellemek gerk 

bolsa, onda ilkibaşda şol topary bellemeli, soňra 

bolsa CTRL klawişasyny basyp saklap 

gyzyklanýan obýekte syçanjyk bilen basmaly. 

Şonda belleniş markerleriň görnüşi inedördülden 

tegeleklere üýtgär (surata ser.).  

Eger bellenilen obýektiň ýany bilen ýene-

de birnäçe obýektleri bellemek gerek bolsa, onda 

olary Pick (Выбор) guražy bilen bellenende, 

Shift klawişasyny basyp durmaly. 

Bellenişden ol ýa-da başga obýekti çykarmak üçin Shift klawişasy basylan mahaly 

oňa syçanjyk bilen basmaklyk ýeterlikdir.  

Käbir ýagdaýlarda gerekli obýekti saýlamak örän kyn bolýar, özem onuň 

sudury we reňki ýok bolsa onda has hem kyn. Bu ýagdaýlarda Wireframe (Каркас) 

görkezmegiň düzgüninden peýdalanamk ýa-da obýektleriň dispetçeriniň kömegi bilen 

işlemeklik maksada laýykdyr. 
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Obýektleri bellemegiň kömekçi usullary  

Eger bir ýerde ýerleşen birnäçe obýektleri tiz belläp almak gerek bolsa, onda Pick 

(Выбор) guralyň görkezijisini şol obýektleri göniburçluk çägiň içine salar ýaly 

ýerleşdirip, şol göniburçlugyň diagonaly boýunça süýşürmeli, syçanjyk 

goýberilenden soň şol çäge doly tutuş giren obýektler bellenilgi bolar, eger çägiň 

içine doly girmedik, emma çäk bilen kesilip geçilen obýektleri bellemek hem gerek 

bolsa, göniburçluk belleýiş çägi döredilende Alt klawişasyny basyp saklap durmaly.  

 Köplenç obýektler biri-biriniň öňünde ýerleşýärler we yzyndakylary ýapýarlar. 

Tab klawişasyna basylyp dursa, belleýiş iň öňdäki obýektden çap sahypasyna tarap 

obýektleri bellemegi amala aşyrylar, Shift+Tab klawişalary basylan ýagdaýynda 

tersine  

Edit > Select All > Objects (Правка > Выделить все > Объекты) buýrugyň 

saýlanylmagy bilelikde sahypada ýerleşen hemme obýektleri saýlamagy mümkin 

edýär.  

Ýerleşdiriş 

Obýekt ýerleşdirilende atributlar panelindäki onuň diňe iki parametri – onuň 

merkeziniň koordinatalary üýtgeýär.  

Ýerleşdirmegiň iň ýönekeý usuly obýekti Pick (Выбор) gural arkaly 

geçirmekden ybarat. Köplenç obýekt süýşürilende ol kän bir birsydyrgyn 

süýşürilmeýämn ýaly görünip bilner. Bu dürli baglanyş düzgünleri bilen bagly bolup 

biler, olar aşakda getirilen. 

  
  Eger bellenilen obýekti sahypanyň belli bir ýerinde ýerleşdirmeli gerek bolsa, 

bu ýerde bellenilen obýektiň merkeziniň dolandyryjy x we y koordinatalaryny 

üýtgetmeli we Enter basmaly. 

Transformation ýanaşdyrylýan penjiresiniň ulanylmagy 

Ýölarda agzalan ýerleşdiriş usullar belli bir markeriň ýerleşiş meselesini, ýa-da 

bellenilen obýekti mysal üçin göräleýin 10mm-e süýşürmek meselesini çözüp 

bilmeýärler. Bu ýerleşmegi awtomatlaşdyrmak üçin Transformation 

(Преобразование) penjiresiniň goşmaçasynyň biri gulluk edýär. Onyü açmak üçin 

Arrange > Transformation (Монтаж > Преобразование) buýrugy açmaly. 

Penjiräniň ýokarky böleginde özgertmegiň 5-ni saýlamagyň düwmejikleri bar. 

Olaryň çetki çepkisi ýerleşiş özgerdilmegine gabat gelýär. 

Özgertmegiň görnüşini saýlamaklyga baglylykda penjiräniň dolandyryş 

elementleriniň düzümi üýtgäp biler. 

Ýerleşdiriş düzgüninde penjirede şular ýaly dolandyryş elementler bar.  

 

süýşmegiň 
ädimi 

göçürmesiniň 
süýşmegi ädimi 

tora baglamaly 

doldurylan hasap 
etmeli 

obýektlere baglamaly 

ugrukdyryjylara baglamaly 



 89 

  Н we V hasaplaýjylary 

bellenilen obýektiň baglama 

nokadynyň ýerleşýän ýerini 

kesgitleýärler. 

 Relative Position 

(Относительно) baýdajygy 

koordinatalary hasaplamagyň 

usulyny dolandyrýar. Ol aýrylan 

bolsa baglama nokadynyň täze 

ýerleşmeli ýeriniň koordinatalary 

çap sahypasy bilen bagly bolan 

ulgamda hasaplanylýar. Baýdajyk 

goýlan bolsa koordinatalar 

bellenilen obýekt bilen bagly 

bolan koordinatalar ulgamynda 

hasaplanylýar, ol ulgamyň başy 

baglama nokadynyň öňki ýerleşiş 

ýeri bilen bagly bolup durýar.  

 Penjiräniň aşaky 

bölegindäki pereklýuçatelleriň 

topary baglama nokadyny 

saýlamagy dolandyrýar.  

 Apply (Применить) düwmejigi hemme goýlan parametrleri bellenilen obýekte 

ulanmak üçin niýetlenen.  

 Apply To Duplicate (Применить к копни) düwmejiginiň basylmagy 

bellenilen obýektiň özgerdilmegini dälde, onuň göçürmesiniň özgerdilmegini 

amala aşyrýar.  

Bellenilen obýekti onuň merkezi belli bir nokat bilen gabat düşer ýaly 

süýşürmek üçin (şol nokadyň koordinatalary sahypanyň koordinatalar ulgamynda 

berlen, onuň noly sahypanyň aşaky çep burçy bilen gabat gelýär) aşakdaky amallary 

ýerine ýetirmek gerek.  

1. Göräleýin ýerleşdimegiň baýdajygyny aýyrmaly.  

2. Pereklýuçateli toparyň merkezinde ýerleşdirmeli.  

3. Н we V hasaplaýjylaryna nokadyň koordinatalaryny girizmeli.  

4. Apply (Применить) düwmejigine basmaly.  

Bellenilen obýekti onuň häzirki ýerinde belli bir aralyga süýşürmek üçin aşakdaky 

ädimleri ýerine ýetirmek gerek.  

Göräleýin ýerleşdimegiň baýdajygyny goýmaly.  

2. Н we V hasaplaýjylaryna gerek bolan süýşmegiň ululyklaryny girizmeli.  

3. Apply (Применить) düwmejigine basmaly. 

Göräleýin ýerleşdirmekde baglanma nokadynyň saýlanmagy rol oýnamaýar. 

Şol sebäpli pereklýuçatelleriň topary bu ýerde başga işleri bitirýär. Islendik 

perklýuçatel goýulanda (ortakydan başgasy) Н we V meýdanlarynda süýşmegiň 

bahalary emele gelýär, olaryň absolýut bahasy nola deň ýa-da bellenilen obýektleriň 

gabaralaryna gabat gelýär, belgiler bolsa (plýus ýa-da minus) görkezilen 

Masştablama we serpikdirme 

Öwrüm 

Ölçegi bermek 
serpikdirme Gyşartma 

serpikdirme 

Ýerleşdiriş 

Keselik 
boýunça 

Diklik boýunça 

Göräleýin 

Baglama nokadynyň orny 

Göçürmesine ulanmak 

Ulanmak 

Keselik 
boýunça 

Diklik boýunça 
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pereklýuçateliň tarapynda süýşme amala aşyrylar ýaly edilip alnan. Meselem bir 

göniburçlugy saýlap, sag gyraky perekluçatele basyp Apply To Duplicate 

(Применить к копии) düwmejige basylsa, göniburçlugyň sagynda onuň göçürmesi 

emele geler, özem oalryň dik taraplary gabat getirilendir, kese taraplary bolsa – 

deňleşdirilen. 

Süýşme, super süýşme, mikro süýşme 

Bellenilen obýektleri çap sahypasy boýunça kursory dolandyryş klawişalary 

arkaly süýşürmek mümkin. Şol klawişalaryň her gezek basylmagy süýşme ädiminiň 

hasaplaýjysy bilen berlen ululyga süýşmegi emele getirýär, ol hasaplaýjysy obýekt 

saýlanmadyk ýagdaýyndaky atributlar panelinde ýerleşdirilen.  

Deslapdan süýşme ädimi 0,1 düýma ýa-da takmynan 2,5 mm deň. Bu köp 

şekiller üçin örän kän bolup durýar, şol sebäpli ony meselem 0,1 ýa-da eýsem 0,01 

mm çenli kiçeltmeklik ündelýär. Munuň üçin hemme obýektleriň bellenilşini ýatyryp 

hasaplaýja gerekli bahany girizmeli.  

Bellenilen obýektleriň kursory dolandyrýan klawişalar bilen Shift klawişa-

modifikator basylan ýagdaýynda süýşürilmegi super süýşme diýlip atlandyrylýar 

(super nudge). Bu düzgünde atributlar panelindäki süýşme ädimiň bahasy super 

süýşmegiň hemişelik koeffisentine köpeldilýär (deslapdan ol 2 deň). Şol amallaryň 

Ctrl klawişasy basylan ýagdaýynda amala aşmagyna mikro süýşme diýilýär (micro 

nudge). Bu düzgünde süýşmegiň ädiminiň bahasy mikro süýşmegiň koeffisientine 

bölünýär (deslapdan 2 deň). 

Kada bolşy ýaly, deslapdan kabul edilen degişli süýşmekleriň koeffisientleri 

amatly däl bolup çykýar. Olary üýtgetmek üçin Tools > Options (Сервис > 

Дополнительно) buýrugyny çagyrmaly, soňra bolsa sazlamalaryň penjiresiniň çep 

böleginde Document (Документ) derejesinde Rulers (Линейки) bölümini saýlaň. 

Nudge (Сдвиг) süýşmwegiň parametriň elementlerine elýeterlilik açylar. Olar arkaly 

süýşmegiň ädimini, şeýle hem koeffisientleri we ölçeg birlikleri üýtgetmek mümkin. 

Super we mikro süýşmegiň koeffisientlerini 10 deň etmeklik ündelýär.  

Göçürme we dublirleme 

Corel Draw-da öň göçürilen obýektleriň goýulmagy asyl nusgasynyň ýerleşýän 

nokadyna goýulýar. Eger obýektler kesilip alynmadyl bolsa, olaryň goýulmagy öz 

asyl nusgalaryndan öňde ýerleşen obýektleriň göçürmesini emele getirer.  

Eger bellnilen obýektiň göçürmesi ondan öňde ýerleşer ýaly etmek üçin, 

obýektler bellnilen wagty + (plýus) klawişasyna basmak ýeterlikdir.  

Eger göçürmäni süýşürmeklik gerek bolsa onda Edit > Duplicate (Правка > 

Дублировать) buýrugy arkaly ony dublirlemeli. Deslapdan dublikat (bellenilen 

obýektiň takyk göçürmesi) asyl nusgasynyň öňünde ondan ýokary we saga 6,35 mm 

süýşürilip ýerleşer. Bu bahany bellenilen obýektler ýok mahalyndaky atributlar 

panelinde ýa-da dublirlemegiň buýrugyna basylandan soň çykýan penjirede bellemek 

mümkin.  

Eger ýaňy gurlan dublikaty asyl nusgasyndan belli bir aralyga süýşürilse, onda 

onuň bellenilşini aýyrman dublirleme buýrugy ýene bir gezek ýerine ýetirilse, onda 

ikinji dublikat birinjiden edil birinjiniň asyl nusgadan süýşürilen aralyga süýşüriler 

CorelDRAW-da bu usula super dublirleme diýlip atlandyrylýar.  
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Eger obýektiň bir topar nusgasyny döredip, olary belli bir ugur boýunça 

ýerleşdirmek gerek bolsa, şol obýekti belläp şol ugur boýunça probel klawişasyny 

basyp süýşürmeklik ýeterlikdir. 

Süýndürme we gysyş 

Obýektleriň üstünden bu amallary ýerine ýetirmegiň iň ýönekeý usuly bu 

belleýiş çägiň markerlerini süýşürmek:  

 markerler merkezden gidýän ugra süýürilende obýektiň ölçegleri ulalaýar, eger 

merkeze tarap ugur boýunça süýşürilende kiçelýär;  

 burçdaky markerler keselik ýa-da diklik boýunça süýşürilende obýektiň 

üýtgemegi proporsiýalary saklamaklyk bilen bolup geçýär, otaky markerler 

süýşürilende bolsa ramkanyň ölçegi diňe keselik ýa-da diklik boýunça 

üýtgeýär;  

 eger marker süýşürilende Ctrl klawişasy basylan bolsa, onda ölçegiň diňe 

esselik üýtgemegi mümkin (2, 3, 4... esse ulalmagy ýa-da kiçelmegi);  

 eger marker süýşürilende Shift klawişasy basylan bolsa, obýektiň ölçegi 

merkezden simmetriki üýtgär;  

 Eger markeri süýşürip gutarmazdan öň syçanjygyň çep düwmejigi basylsa 

onda özgertme asyl nusganyň üstünde dälde, bellenilen obýketiň 

göçürmesiniňüstünden ýerine ýetirilýär;  

 eger ortaky marker ramkanyň merkezine tarap süýşürilende onuň garşyky tarap 

kesilip geçilen bolsa (Shift düwmejigi basylanda - ortasy), onda özgertmegiň 

netijesinde aýna görnüşdäki serpikdirme emele geler. 

Takyk ölçegleri berme  

Käwagt obýekte takyk ölçeg bermeli bolýar. Munuň üçin atributlar panelinde 

ýerleşen obýketiň ölçegleriniň hasaplaýjylaryndan 

peýdalanmak mümkin, has çylşyrymly ýagdaýlarda bolsa 

Transformation (Преобразование) penjiresiniň dolandyryş 

elementlerini ulanmak gerek. 

Size (Размер) düwmejigine basylandan soň emele 

gelýän dolandyryp elementleri obýektiň täze beýikliginden 

we ininden başga belleýiş ramkanyň haýsy markeri ölçeg 

üýtgedilende hereketsiz galjakdygyny görkezýär. Munuň 

üçin pereklýuçatelleriň degişlisine basmaly.  

Non proporsional baýdajygy basylmadyk ýagdaýynda 

beýiklik ýa-da in üýtgedilende awtomatiki beýleki ölçegiň 

proporsiýaly üýtgemegine getirer.  

Ölçegler goýlanda özgertmegiň obýektiň öz 

ölçeglerine täsir etmän, gabara göniburçlugyň ölçeglerine 

täsir edýär. Bu has hem bilelkikde bellenilen obýektleriň 

üstünde ýerine ýetirilende wajyp.  

Masştablama we serpikdirme 

Masştablamada bellenilen obýektiň täze ölçegi onuň başlangyç ölçeginiň 

göteriminde berilýär. Edil takyk ölçegiň berilşi ýaly olary atributlar paneliniň 

meýdanlary ýa-da penjiräniň Scale and Mirror (Масштаб и отражение) düwmejigine 
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basylandan soň emele gelýän paneliň dolandyryş elementleri arkaly amala aşyrmak 

mümkin.  

 
Ýokarky suratda Transformation penjiresiniň elementleri, şeýle hem bellenilen 

obýekt (a) we onuň masştablamagynyň usullary görkezilen: proporsional 

masştablama 1 30 % (b), beýiklik boýunça masştablama -100 % (ç). Proporsional 

masştablama -100 % (d). 

CorelDRAW-da masştablama koeffisientiň otrisatel bahasy berlende ölçegiň 

üçýtgemegi bilen bilelikde bellenilen obýektiň aýna görnüşde serpikdirmegi bolup 

geçýär. Ýokarky suratda ç we d ýagdaýlarynda şol masştablamagyň iki mysaly 

getirilen.  

Adatça, Transformation (Преобразование) penjiresiniň dolandyryş elementleri 

özgertmegiň hereketsiz nokadyny görkezmek we özgertmegi bellenilen obýektiň 

göçürmesine ulanmagyň mümkinçiligini berýär.  

Penjirede ýerleşen (koeffisientleriň hasaplaýjylardan sagdaky) düwmejikler 

özgertmä “minus” belgini girizmän serpikdirmegi işletmegi mümkin edýär. 

Obýektleriň öwrümi 

Bellenilen obýekti Pick (Выбор) guraly arkaly islendik burça öwürmek üçin 

obýekte guralyň görkezijisi ýene bir gezek basmaly. Şondan soň belleýiş ramkasynyň 

burç markerleriniň deregine öwüriş markerleri emele gelýär, obýektiň merkeziniň 

markeriň deregine öwürişiň merkezini markeri emele geler (aşaky surat). Tegelegiň 

görnüşindäki merkeziň markerini süýşürip, bellenilen obýektiň aýlanyljak merkezini 

çalşyryp bolýar  

Eger öwürme markeri süýşürilende Ctrl klawişasy basylan bolsa, obýekt 15° 

bölünýän burçlar bilen bökme-bökme öwrüler.  

Edil şol özgermeleri atributlar paneliniň Rotate (Поворот) meýdany we 

Transformation (Преобразование) penjiresiniň Rotate (Поворот) düwmejigine 

Guralyň görkezijisi 

a   b 

ç   d 
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basylyp açylýan paneldäki dolandyryş elementleri arkaly ýerine ýetirmek mümkin. 

Soňkynyň düzümi:  

 Angle (Угол) hasaplaýjysy 

bellenilen obýektleriň 

öwrülmeli burçuny berýär, 

položitel bahanyň berilmegi 

sagat ugruna garşy öwrüme 

gabat gelýär.  

 Н we V hasaplaýjylary 

bellenilen obýektler daşyndan 

aýlanýan nokadyň 

koordinatalaryny saklaýar. 

Deslapdan şol nokat belleýiş 

ramkanyň ortasy bilen gabat 

gelýär. Absolýut koordinatalary 

berilýän düzgünde öwrümiň 

merkeziniň koordinatalary çap 

sahypasy bilen bagly bolan 

ulgamda, göräleýin 

koordinatalar berilýän 

düzgünde – bellenilen obýektleriň baglanan koordinatalar ulgamynda (onuň başy 

belleýiş ramkasynyň ortasy bilen gabat getirilen).  

 Relative Center (Относительно) baýdajygy öwrümiň merkezini bermegiň 

düzgünini biri-birinden geçirýär.  

 Öwrümiň merkezini ýerleşmegini saýlamagyň pereklýuçatelleriň topary 

öwrümiň merkezi hökmünde belleýiş ramkasynyň bir markerini saýlamagy 

mümkin edýär.  

 Apply (Применить) düwmejigi we Apply To Duplicate (Применить к копии) 

edil beýleki öň seredilen panellerdäki ýaly. 

Obýektleriň gyşardylmagy 

Bellenilen obýektiň 

gyşardylmagyny Pick 

(Выбор) guraly bilen 

ýerine ýetirmek üçin, 

bellenilen obýekte ýene bir 

gezek basmaly, soňra bolsa 

görkezijini gyşartmagyň 4 

markerinden islendigine 

getirmeli (surat). Görkeziji 

ugry biri-birine bolan 

strelkalaryň görnüşini alar.  

 

 

 

 

Öwrümiň 
merkezi 

Öwrümiň markeri 

a 

b 

Gyşartmagyň guralyň 
görkezijisi 

Gyşartmagyň markeri 

a 

b 
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Gyşartmagyň dolandyryjy parametri bolup gyşaryş burçy bolup durýar. 

Gyşarmagy hem diklik hem-de keselik boýunça mala aşyrmaklyk mümkin bolany 

üçin şeýle iki dolandyryjy parametr bar. CorelDRAW-da gyşartmagyň burçunyň iň 

maksimal absolýut bahasyhökmünde 75° bellenilen.  

Transformation (Преобразование) penjiresiniň Skew (Скос) düwmejigine 

basylandan soň açylýan paneldäki dolandyryş elementleri arkaly özgertmegi has 

takyk ýerine ýetirip bolýar. Mundan başga hem, bir wagtda hem keselik, hem-de 

diklik boýunça burçlary bellemek mümkin, şeýle hem hereketsiz nokady 

pereklýuçatelleriň topary arkaly saýlamak mümkin. 

Obýektleri blokirleme 

Obýektiň tötänleýin özgerdilmeginiň öňüni almak üçin ony blokirlemek 

mümkin. Blokirlenen obýekti bellenişe goşmak mümkin, emma oňa hiç hili 

özgertmeler täsir etmeýär.  

Obýekti blokirlemek üçin ony bellemeli soňra Arrange > Lock Object 

(Монтаж > Заблокировать объект) buýrugy saýlamaly. Belleýiş ramkanyň 

markerleri gulpuň görnüşine eýe bolarlar.  

Blokirowkany ýatyrmak üçin Arrange > Unlock Object (Монтаж > 

Разблокировать объект) buýrugy ulanmaly. Resminamanyň hemme blokirlenen 

obýektlerinden blokirlemegi aýyrmak üçin olary bellemän Arrange t Unlock All 

Objects (Монтаж > Разблокировать все объекты) buýrugyndan peýdalanmak 

mümkin.  

Obýektleri belleme, göçürme we özgertme 

Bu gönükmäni ýerine ýetirmek bilen netijede aşakdaky surat alynmalydyr.  

1. Iş meýdanynda Transformation (Преобразование) ýanaşdyrylan penjiresini 

açyň.  

2. Nyşana meňzeş figura şeýle yzygiderlilikde gurulýar. Ilkibaşda islendik 

ölçegli tegelegi Ellipse (Эллипс) gural bilen Ctrl modifikatory arkaly guruň— soňra 

ýanaşdyrylan penjirede ýerleşen elementleriň kömegi bilen ony 40 mm diametrli 

tegelege özgerdiň. Ýerleşdirme dolandyryş elementleri arkaly onuň merkezini 

sahypanyň koordinata ulgamynda keselik boýunça 60 mm we diklik boýunça 220 

mm koordinataly nokada ýerleşdiriň.  

 
3. Nyşanyň beýleki tegeleklerini ölçegiň dolandyryş elementlerini ulanmak 

bilen dörediň. Munuň üçin pereklýuçatelleriň toparynda ortakysyna basyň, ölçegleriň 

proporsional düzügünini işlediň, islendik hasaplaýjynyň bahasyny 35 mm edip beriň 

we Apply To Duplicate (Применить к копии) düwmejigine basyň. Netijede ekranda 
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ondan kiçi tegelek emele geler, şu sul bilen her beýlekisiniň diametrini 5mm kiçeldip 

beýleki tegelekleri guruň.  

4. Bezier (Кривая Безье) guraly saýlaň weislendik uzynlykly kese çyzygy 

(Ctrl klawişasyny basyp) çyzyň. Atributlar paneliniň meýdanlaryny ulanyp çyzygyň 

uzynlygyny 50 mm ediň we onuň ortasyny konsentiriki tegelekleriň merkezine 

süýşüriň. Pick (Выбор) guraly saýlaň we bellenilen çyzyga ýene bir gezek basyň. 

Ctrl klawişasyny basyp saklap öwrüm markeriniň islendigini çyzyk dik bolar ýaly 

süýşüriň, emma syçanjygyň çep düwmejigini goýbermezden öň onuň sag 

düwmejigine basyň. Netijede çyzygyň göçürmesi oňa perpendikulýar bolup durar. 

5. Çyzylmaly şekiliň ortaky bölegi figura tekstiň asyl nusgasy we 8 sany onuň 

göçürmesi bolup durýar. Figura tekstiň bloguny dörediň. Pick (Выбор) guraly saýlaň 

we tekstiň bloguny nyşandan sagda ýerleşdiriň. Onuň diklik boýunça ýerleşişini 

atributlar paneli arkaly tekstiň ortasyny nyşanyň kese çyzygy bilen gabat getirip 

düzediň.  

6. Tekstiň 8 sany göçürmesini Transformation (Преобразование) penjiresiniň 

Scale and Mirror (Масштаб и отражение) düwmejigine basyp açylýan paneliň 

dolandyryş elementlerini ulanyp dörediň при. Meselem, asyl nusgadan çepde we 

ýokarda ýerleşen göçürmäni döretmek üçin, özgertmegiň hereketsiz nokady 

hökmünde ramkanyň çepki ýokarky markerini saýlap, serpikdirmegiň iki 

düwmejigine basyp we Apply To Duplicate (Применить к копии) düwmejigine 

basmaly. Soňra, nobatlaýyn burçlaýyn göçürmeleri saýlap, olaryň gyşarylmagyny 

penjiräniň Skew (Скос) düwmejigine basylyp açylýan paneliň elementleri arkaly 

ýerine ýetiriň. Göçürmeleriň her biri üçin hereketsiz nokady bellemeli.  

7. Çopantelpege meňzeş figura beýikligi 20 mm we ini 3 mm bolan dik duran 

elipsiň göçürmelerinden ybarat. Göçürme ramkanyň merkezine görä 13 mm göni 

aşak süýşürilen hereketsiz nokadyň daşyndan 9° burça öwürmek bilen gurulýar. 

Ilkibaşda başlangyç ellipsi guruň we oňa gerek bolan özlçegleri we ýerleşişi beriň. 

Gözçürçeli özgermegi Rotation (Поворот) düwmejigine basylyp açylýan paneliň 

elementleri arkaly ýerine ýetiriň.  

8. Hemme bilelikde çyzylan gülýapraklary belläň. atributlar paneliniň 

meýdanlary arkaly bellenilen ellipsleri bellenişiň merkezi nyşanyň merkezi ýerleşýän 

çyzykda ýerleşer ýaly süýşürmeli. “Çopantelpegiň” merkezinde 15 mm diametrli 

tegelegi çyzyň. onuň merkezi gülýapraklaryň öwrüliş merkezi bilen gabat geleninden 

soň guralyň görkezijisi bilen reňkleriň ekran palitrasynyň ak nusgasyna basyň 

(gülýapraklaryň uçlary ortadan görünmez ýaly). 

Tekstleriň bloklaryny özgertmeklik 

Figura tekstine özgertme ulanylanda, ol şol bloguň hem formasyny, hem-de 

teksti düzýän simwollaryň formasyny üýtgedýär. Ýönekeý tekstiň ramkasy 

özgerdilende diňe şol ramkanyň formasy üýtgeýär, tekst düzýän simwollar bolsa 

üýtgemän galar. Figura we ýönekeý tekstiň özgerdilmeginiň tapawudyny aşakdan 

görmek mümkin. Aşakky suratda birinji hatarda çepde figura tekstiň, sagda bolsa 

ýönekeý bloguň teksti ýazylan. 

Ikinji hatarda bu obýektleriň ikisi hem 30° öwrülen.  
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Üçünji hatarda iki obýekte koordinatalaryň iki oky boýunça ylaşylan masştablama 

özgertmegi 150 % koeffisient bilen ulanylan Figura tekstinde kegl we aralyklar 1,5 

esse artdy. Ýönekeý tekstiň ramkalary 1,5 esse ulalyp, kegl we interwallar üýtgemän 

galdy, şol sebäpli birinji abzasyň setirlere bölünişi üýtgedi. 4-nji hatarda 30° 

dolandyryjy parametrli gyşartma özgerdilşi ulanylan. Figura tekstiň blogunda bloguň 

özüniň formasy üýtgedi (şol sebäpli tekstiň setirlere biri-birine görä süýşsiler, şeýle 

hem her simwolyň hem formasy üýtgedi (olar çepe gyşardylar). Ýönekeý tekstiň diňe 

setirleri süýşdi. 

Obýektiň özgerdilmegini ýatyrmak 

Masştablamagyň, öwrülişiň, serpikdirmegiň we gyşartmagyň özgerdilmegini 

Arrange > Clear Transformations (Монтаж > Отменить преобразования) buýrugy 

arkaly ýatyryp bilýär, sebäbi bu amallaryň yzygiderliligi programmada ýatda 

saklanylýar. Bu amallary eýsem CorelDRAW resminamasy ýapylyp, soň açylan 

ýagdaýda hem amala aşyrmak mümkin.  

Emma ýrleşdirme özgertmegi ýatda saklanylmaýar we özgertmegiň 

dowamynda obýektiň döredilen göçürmeleri ýok edilmeýär. Özgerdilmegiň 

ýatyrylmagyny hem ýatyryp bolýar.  

Obýektleriň formasyny üýtgetmek üçin gurallar 

Bu amalary Shape (Форма) guralyň panelinde ýygnalan gurallar arkaly ýerine 

ýetirmek mümkin. 

  

 
 

Forma Bozgu
ç 

Çyrşama 

Päki Dyrmyk Erkin özgerdiş 
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Shape (Форма) guraly — obýektleriň formasyny redaktirlemegiň esasy guraly. 

Knife (Лезвие) guraly egrini iki aýry obýekte bölmegi mümkin edýär. Eraser 

(Ластик) guraly gurulan obýektiň bölegini pozmagy imitirleýän ýagdaýda 

obýektleriň formasynyň modifikasiýasyny amala aşyrýar. CorelDRAW-yň soňky 

wersiýalarynda soňky iki gural Crop (Обрезка) guralyň paneliniň düzümine girýär.  

Smudge (Размазывание) guraly ineraktiň düzgünde egriniň formasyny 

üýtgetmegi mümkin edýär.  

Roughen brush (Грабли) guraly tekzi egriniň formasyny onda üçburçluk 

çykytlary döretmegi mümkin edýär.  

Free Transform (Произвольное преобразование) guraly Transformation 

(Преобразование) penjiresini ulanman özgertmeleri diňe syçanjygyň görkezijileri 

arkaly manipulirlemek bilen geçirmegi mümkin edýär.  

 

Düwünleri Shape (Форма) guraly arkaly bellemek 

Düwüni bellemek üçin oňa degişli guralyň görkezijisi bilen basmak ýeterlikdir. 

Düwüni bellenilenlere goşmak üçin Shift klawişasyny basyp saklap oňa syçanjyk 

bilen basmaly 

Göniçyzykly segmentlere degişli bolan bellenilen düwünler reňksiz 

inedördüller bilen görkezilýär, egri çyzyklara bolsa – gara reňkli inedördüller bilen.  

Belleýişi egriniň birinji nokadyna geçirmek üçin Ноmе klawişasyna, iň soňky 

düwüne geçirmek üçin End klawişasyny basmaly. Tab klawişasynyň basylmagy 

belleýişi indiki düwüne geçoirýär, Shift+Tab basylmagy — ondan öňküsine.  

Egriniň hemme düwünlerini belemek üçin onuň düwünleriniň islendigini belläp 

Ctrl+Shift+Home klawişalaryna basmaly 

 

Düwüniň ugrukdyryjy nokatlaryny süýşürmek  

Çyzygyň düwünine girýän we ondan çykýan segmentleriň özüni alyp barşy 

ugrukdyryjy nokatlaryň ýerleşişi bilen kesgitlenýär. Düwün bellenilenden soň onuň 

bilen galtaşýan iki segmentiň hem özüni alyp baryşlaryny kesgitleýän ugrukdyryjy 

nokatlar görüner. Segmentiň formasyny düwünleri süýşürmän üýtgetmek üçin oňa 

degişli bolan ugrukdyryjy nokatlary Shape (Форма) süýşürmek gerek. 

Aşakdaky gönükmäni ýerine ýetirip biz düwüne galtaşýan segmentiň 

formasyny düzetmegi öwreneris we düwüniň görnüşi şol amalyň netijesine nähili 

täsir edýändigine düşüneris.  

1. Başda sinusoida meňzeş bolan egrini çyzmakdan başlalyň. Munuň üçin 

Bezier (Кривая Белье) guraly saýlalyň we sahypanyň boş ýerinde syçanjyk bilen 

basalyň. Syçanjygyň düwmejigini goýbermezden öň onuň görkezijisini ýokary we 

saga birnäçe aralyga süýşüreliň. Saga süýşüp ýene bir düwüni guralyň, indi bolsa 

guralyň görkezijisini aşak we saga süýşüreliň. Indi ýene saga süýşüp, edil birnjini 

ýaly üçünji düwüni guralyň. Netijede aşaky suratň ýokarky çep burçundaky şekil 

emele gelmeli. 
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2. Egeriniň göçürmesini sagda ýerleşdireliň. Munuň üçin wagtlaýyn Pick 

(Выбор) guraly probele basyp saýlap, bellenilen egrini çepe süýşürip syçanjygyň çep 

düwmejigini goýbermezden öň sag düwmejigine basalyň. Gaýtadan probele basyp 

Shape (Форма) guralyny işledeliň. Syçanjygyň görkezijisi bilen göçürmäniň ikinji 

düwünine syçanjygyň sag düwmejigi bilen basalyň. Netijede bellenilen düwüniň 

kontekst menýusy açylar (aşakdaky surat). Smooth (Сглаженный) buýrugyny ulanyp 

bellenilen düwüniň görnüşini üýtgediň. Şeýle usul bilen birinji göçürmäniň çep 

gapdalyndan egriniň ýene bir göçürmesini dörediň, soňra ikinji düwüni kontekst 

menýunyň Cusp (Точка излома) buýrugyny ulanyp döwüliş nokadyna özgerdiň. 

Netijede daş keşbi meňzeş üç sany egri çyzyk emele gelmelidir (ýokarky suratyň 

ýokarky setiri). 

3. Çepki egriniň ikinji düwüni belläň. Guralyň görkezijisini 

aşaky ugrukdyryjy nokada goýuň we ony egriniň ikinji we üçünji 

düwünleriniň ortasynda ýerleşer ýaly süýşüriň (ýokarky suratyň 

ikini hataryna a) serediň). Düwüniň ikinji ugrukdyryjy nokady 

hereketsiz galandygyna üns beriň. “Döwülış nokady” görnüşli 

düwüniň ugrukdyryjy nokadynyň süýşürilmegi egriniň diňe bir 

segmentiniň üýtgedilmegine getirýär. (ýokarky suratyň 3-nji 

setiri, а) ), emma, şonda düwünde egriniň döwüliş burçy 

üýtgeýär.  

4. Ediş şol redaktirlemegi egriniň beýleki göçürmesiniň ikinji 

düwüniniň üstünden geçiriň. Bu ýagdaýda biz düzlenen düwün 

bilen işläris, şol sebäpli bir ugrukdyryjy nokadyň sagat ugruna 

garşy süýşürilmegi ikinji ugrukdyryjy nokadyň edil şol burça şol 

tarapa süýşmegine getirer. Emma süýşürilýän ugrukdyryjy nokadyň düwüne 

golaýlaşdyrylmagy ikinji ugrukdyryjy nokadyň şol düwüne çenli aralygyna täsir 

a b ç 
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etmeýär. Netijde düwünde egriniň tekizligi saklanylýar, simmetriklik bolsa — 

bozulýar (suratdaky üçünji hatar b)).  

5. Şol redaktirlemegi sagdaky egri üçin hem ýerine ýetireliň. Bu gezek düwün 

simmetriki we iki ugrukdyryjy nokatlaryň süýşmegi deň bolýar. ( suratdaky üçünji 

hatar, ç)).  

Eger ugrukdyryjy noikat düwün bilen bir ýerde bolsa onda hut nokady 

bellemek üçin Shift klawişasyny basyp saklamaly. 

Düwünleri redaktirlemek 

Bellenilen düwünleri redaktirlemegiň buýruklary şol düwüniň kontekst 

menýusynda görkezilen. Menýunyň buýruklaryndan başga düwünleriň 

redaktirlenmegi bellenilen düwüne gabat gelýän atributlar paneliniň düwmejikleri 

arkaly mümkin. 

 

 

 

 

 

 

 

 

 

Düwünleri goşmak 

we aýyrmak 

Köplenç 

egrilere gerekli 

formany bermek 

üçin onda täze 

düwünleri 

ýerleşdirmek gerek. 

Muny ýerine ýetirmek üçin iň aňsat usul — düwüniň ýerleşmeli ýerinde Shape 

(Форма) guralynyň görkezijisi bilen iki gezek basmaklyk. 

Eger bar bolan düwün bellenulse we atributlar panelinde “plýus” nyşanly 

düwmejige basylsa onda täze düwün bellenilen düwünden öň gelýän segmentiň göni 

ortasynda ýerleşer, özem iki düwün hem (öň bar bolan we täze döredilen) bellenilen 

bolup galar. Düwünleri goşmaklygyň düwmejige gaýtadan basylsa ýene iki sany täze 

düwüniň emele gelmegine getirer.  

Egriniň düwünini ýok etmek üçin, ony belläp Del klawişasyna ýa-da atributlar 

panelinde düwünleri ýok etmek düwmejigine basmaklyk ýeterlikdir.  

Ýeke düwüni ony bellemän Shape (Форма) guralyň görkezijisi bilen iki gezek 

basmaklyk bilen ýok etmek mümkin.  

Egriniň düwüni ýok edilende egri bölünmeýär — düwün bilen bile oňa 

ýanaşýan segmentler ýok edilýär, olaryň deregine täze segment gurulýar. Iň soňky 

düwün ýok edilende egri bir segmente gysgalýar. 

Egrileri düzlemek 

Düwünleri ýok 
etmek 

Düwünleri 
goşmak 

Düwünleri 
birleşdirmek 

Egrini bölmek 

Göni çyzykly segment Egri çyzykly segment 

Döwüliş nokady Düzlenen düwün 

Simmetriki düwün 

Ugruny üýtgetmek Iň soňky (ýapyjy) 
segment 

Şahamçany aýry 
etmek 

Awtomatiki 
ýapma 

Düwünleri 
süýndürmek 

Düwünleri 
öwürmek 

Düwünleri 
deňleşdirmek 

Çeýe süýşüriş Hemme düwünleri 
bellemek 

Düzlenmegiň derejesi 
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Umumy ýagdaýda egri näçe az düwünleri saklasa şonça hem ol düz bolup 

görüner. Köplenç egri çyzygyň örän kän düwüni bolup, olar ulanyjynyň 

gözegçiliginden çykyp biler. Bu köplenç egriler «elden» çyzylanda we Eraser 

(Ластик) guraly ulanylanda bolup biler.  

Atributlar panelinde ýerleşen düzleme derejesiniň polzunogy, ulanyja özbaşdak 

egriniň düwünleriniň sanynyň we onuň formasynyň takyklygynyň arasynda 

kompromis şertlerini kesgitlemegi mümkin edýär.  

Eger egriniň hemme düwünleri bellenilip düzleme derejesiniň bahasy kem-

kemden ulanylsa CorelDRAW yzygiderli aýry düwünleri ýok edip başlar, özem 

egriniň maksimal ýagdaýda formasyny saklamaga ymtylar. Aşaky suratda başlangyç 

egri we onuň ahyrky netijesi (düzleme derejesi — 80 %). Bu ýagdaýda üç düwün ýok 

edildi.  

 
Egrini bölmek, düwünleri birleşdirmek we ýapmak 

Egrini bölmek amaly ýapyk egrini açmagy ýa-da ýapyk däl egrini iki şaha 

bölmegi mümkin edýär. Bellenilen düwünde egrini bölmek üçin kontekst menýuda 

Break Apart (Разъединить) buýrugy saýlamak ýa-da atributlar panelinde deň atly 

düwmejige basmaklyk ýeterlikdir. Bellenilen düwüniň ýerinde segmentler bilen 

birleşilmedik iki täze düwün emele geler.  

Iki bellenilen düwüni birleşdirmek üçin, kontekst menýuda Join (Объединить) 

buýrugy saýlamak ýa-da atributlar panelinde deň atly düwmejige basmaklyk 

ýeterlikdir.  

Birleşdirme amalyny diňe düwünler ahyrky bolan ýagdaýda ýerine ýetirmek 

mümkin. 

Bu ammalary özleşdirmek üçin kiçi gönükmäni ýerine ýetirmek gerek. 

1. Sahypanyň boş ýerinde tegelegi çyzyň we we ony atributlar panelindäki 

düwmejik arkaly (onda dört düwünli tegelek çyzylan) ýapyk egri çyzyga özgerdiň. 

Ýapyk egri bolan tegelekde dört düwün emele geler (surat, a).  

 
2. Sag düwüni belläň we onda egrini bölüň. Sag düwüni aşak we saga süýşüriň 

— onuň yzynda täze döredilen düwün görüner (surat, b).  

3. Egrini çep düwünde bölüň. Çep düwüni aşak we çepe süýşüriň (surat, ç).  

4. Egriniňaşaky şahasynyň ahyrky çep düwünini we ýokarky şahasyndaky 

ahyrky sag düwüni belläň. Bu düwünleri birleşdiriň. Netije suratda görkezilen, d.  

Düwünleri süýşürmek we öwürmek 

Shape (Форма) guraly arkaly bellenilen düwünlere süýndürmegiň, gysmagyň 

we öwürmegiň amallaryny ulanmak mümkin. Munuň üçin azyndan iki düwün 

bellenilmeli, degişli özgertmegiň ramkasyna geçmeklik bolsa syçanjygyň goşmaça 

a b ç d 
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basylmagy arkaly dälde atributlar panelindäki düwmejikler arkaly bolup geçýär. Bu 

amallaryň ýerine ýetirilişini özleşdirmek üçin aşakdaky gönükmäni ýerine ýetirmeli  

1. Sahypanyň boş ýerinde inedördül çyzyň we ony ýapyk çyzyga özgerdiň 

(surat, a).  

 
2. Shape (Форма) guraly saýlap ol arkaly hemme düwünlerini belläň, soňra 

bolsa olaryň arasyna täze düwünleri goşup düwünleriň sanyny iki esse artdyryň, (рис. 

surat, b) — munuň üçin atributlar panelindäki “plýus” nyşanly düwmejige basmak 

ýeterlikdir.  

3. Düwünleriň bellenilşini aýyryň we diňe täze döredilen düwünleri belläň 

(taralaryň ortasynda ýerleşen). Atributlar panelindäki düwünleri süýndürmegiň 

düwmejigine basmak bilen sündirmegiň we gysmagyň markerlerini saklaýan 

ramkany çykaryň. Belleýiş ramkanyň burçdaky markerini Shift klawişasyny basap 

merkeze atarap süýşüriň (takmynan orta aralyga). Inedördül 4 uçly ýyldyza öwrüldi 

(surat, ç).  

4. Düwünleriň bellenilşini ýatyrman atribut panelindäki düwünleri öwürmegiň 

nokadyna basyň. Indi markerler öwürmegiň we gyşartmagyň özgertmelerini ýerine 

ýetirmegi mümkin edýär. Islendik burçdaky markeri 90° sagat ugruna garşy süýşürip 

(Ctrl klawişasyny basyp), ýyldyzy suratdaky d görnüşe getiriň.  

Egrini ýapmaklyk 

Käbir ýagdaýlarda düwün bilen birleşdirmek — egriniň şahalaryny 

birleşdirmegiň iň gowy usuly bolup durmaýar. Şol sebäpli köplenç egrini ýapmagyň 

usullaryny peýdalanmaly 

Birinji usul egriniň iki ahyrky nokadyny belläp Extend Curve To Close 

(Замыкающий сегмент) düwmejigine basmakdan ybarat. Bellenilen düwünler göni 

çyzykly segment bilen birleşdirilerler. Eger diňe bir düwün bellenilen bolsa ýa-da 

bellenilen düwünleriň biri ahyrky däl bolsa, bu düwmejik el ýeterli däl bolýar. Ikinji 

usul egriniň hemme bölünen şahalaryna täsir edýär. Şahanyň ahyrky düwüniniň birini 

bellemek bilen Auto-Close Curve (Автозамыкание) düwmejigine basylsa egriniň 

hemme ýapylmadyl şahalarynyň başky we soňky düwünleri göni çyzykly segmentler 

bilen birleşdirilen bolar. 

Şahalaryň aýry edilmegi 

Eger egriniň düzümine birnäçe şaha girýän bolsa, olaryň islendigini özbaşdak 

egri edip bolýar. Adatça bu mesele Arrange > Break Curve Apart (Монтаж > 

Отделить ветви) buýrugy arkaly ýerine ýetirilýär. Emma şonda tutuş egri aýry 

şahalara bölünýär,1 ol şahalaryň her biri bolsa özbaşdak obýekt bolup durýar. Eger 

egriniň düzüminden diňe bir şahany çykarmaklyk gerek bolsa, bu usul ýaramly däl.  

a b ç d 
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Bu ýagdaýda şahanyň islendik düwünini belläp atributlar paneliniň Extract 

Subpath (Отделить ветвь) düwmejigine basmaly. Galan şahalar egriniň düzüminde 

galar.  

Düwünleri deňleşdirmek 

Düwünleriň deňleşmegi diýlip olaryň kese ýa-da dik ýagdaýda bir kese ýa-da 

dik göni çyzykda ýerleşer ýa-da doly gabat geler ýaly süýşürilmegine aýdylýar. 

Deňleşme diňe birden köp düwün bellenilen ýagdaýda mümkin. Birnäçe düwün 

bellenilen soň atributlar panelindäki Align Nodes (Выровнять узлы) düwmejigine 

basmaly we ekranda aşakdaky gepleşik penjiresi.  

 

 

 

 

 

 

 

 

 

Gepleşik penjiresinde deňleşdirme düzgünlerini dolandyrýan üç sany baýdajyk 

bar.  

 Align Horizontal (Выровнять по горизонтали). Bu badajyk goiýlanda egriniň 

hemme bellenilen düwünleri iň soňky düwünden geçýän kese çyzykda ýerleşer 

ýaly dikleýin süýşýärler.  

 Align Vertical (Выровнять по вертикали). Bu baýdajyk goýlanda egriniň 

hemme bellenilen düwünleri iň soňky düwünden geçýän dik çyzykda ýerleşer 

ýaly keseleýin süýşýärler.  

 Align Control Points (Выровнять направляющие точки). Bu baýdajygy diňe 

egriniň iki düwüni bellenilen bolsa we ondan ýokarky iki baýdajyk goýlan 

bolsa gurnamak mümkin. Deňlemegiň netijesinde öň bellenilen düwün ikinji 

düwün bilen gabat geler ýaly süýşýär we onuň ugrukdyryjy nokatlary ikinji 

düwüniň ugrukdyryjy nokatlary bilen gabat geler ýaly süýşýär.  

Egriniň düwünlerini deňlemegiň usullaryny özleşdirmek üçin uly bolmadyk 

gönükmäni ýerine ýetireliň. 

1. Tegeli çyzyň we ony Convert То Curves (Преобразовать в кривые) 

düwnejigi arkaly egri çyzyga özgerdiň. Kömekçi klawiaturada “plýus” nyşanly 

klawişa üç gezek basyp egriniň üç göçürmesini dörediň. Pick (Выбор) guraly bilen 

göçürmeleri asyl nusga bilen bir kese çyzykda ýerleşer ýaly ondan saga süýşüriň.  

2. Shape (Форма) guraly saýlaň we egriniň asyl nusgasynda иilkibaşda sag, 

soňra bolsa ýokarky düwüni belläň. Atributlar panelindäki Align Nodes (Выровнять 

узлы) düwmejigine basyň we Align Vertical (Выровнять по вертикали) baýdajygy 

aýyryň. Netijede ýokarky suratyň a şekilini alarys.  

3. Egriniň birinji nusgasynda ilkibaşda çep, soňra bolsa aşaky düwüni belläň. 

Atributlar panelindäki Align Nodes (Выровнять узлы) düwmejigine basyň we Align 

a b ç d 
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Horizontal (Выровнять по горизонтали) baýdajygy aýyryň. Netijede ýokarky 

suratyň b şekilini alarys.  

4. Ikinji göçürmede ilkibaşda sag, soňra ýokarky düwüni belläň. Atributlar 

panelindäki Align Nodes (Выровнять узлы) düwmejigine basyň, soňra bolsa göni 

ОК düwmejigine basyň. Üçünji göçürme bilen edil şol zady ýerine ýetiriň, emma OK 

düwmejigine basmazdan öň Align Control Points (Выровнять направляющие 

точки). baýdajygy aýryň. Netijeleri degişlilikde ýokarky suratyň ç we d şekillerinde 

görmek bolar. 

Düwünleriň çeýe süýşürilmegi 

Bellenilen düwünler bir wagtda süýşürilende olaryň her biri şol bir aralyga süýşer. 

Emma atributlar panelindäki düwmejik arkaly çeýelik düzügüni işledilende her 

düwüniň süýşmegi şol düwüniň süýşürilýän düwüninden bolan uzaklygyna ter 

proporsional bolup durýar.  

 
Ýokarky suratda iki egride hem süýşürilmezden öň sekiz sany düwün 

bellenilipdi. Ýokarky egri çyzyk üçin süýşürilme adaty düzgünde, aşakysy üçin – 

çeýe düzügnde geçirilipdi. Iki ýagdaýda hem iň ahyrky sag düwün süýşürilipdi. 

Shape guraly we tekst obýektleri 

Shape (Форма) guraly käbir ýagdaýlarda käwagt figura we ýönekeý tekstiň 

formatirlenmegini tiz amala aşyrylnagyny mümkin edýär. Meselem tekstiň 

simwollarynyň baza çyzygyndan şol guralyň görkezijisi arkaly süýşürilmegini has tiz 

edip bolýar, emma takyklyk ýitmegi mümkin.  

Shape (Форма) guraly saýlap tekst obýektine basylsa belleýiş ramkasy emele 

gelmez. Oňa derek tekst obýektiň aşagynda iki sany strelka emele geler — aşak we 

saga, tekstiň her bir simwoly üçin bolsa ekrana düwün çykarylar.  

 
Guralyň görkezijisi arkaly simwolalryň düwünlerini süýşürip, olary 

çetleşdirmek bolýar, olaryň strelkalaryny süýşürip bolsa — tekstiň 

formatirlenmeginiň dolandyryş parametrlerini üýtgetmek mümkin. 

Shape guraly bilen figura tekstiň blogy bellenilende kese strelka arkaly 

simwolara aralyk ütgedilende gabara ramkada üýtgeýär emma tekstiň setirlere 

bölünşigi saklanylýar (aşaky surat). 
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Ýönekeý tekstiň ramkasy bilen işlenilende bu amaly ýerine ýetirmek üçin 

Shape (Форма) işletmegiň zerurlygy hem ýok. Islendik guralyň görkezijisi ramkanyň 

sagdaky aşaky markeriň ýanyndaky strelkalara getirilende wagtlaýynça Shape 

(Форма) guraly işläp başlaýar (aşaky surat).  

 
Ýönekeý tekstiň ramkasynyň içinde tekstiň simeolara aralygy üýtgedilende 

werstkanyň şertleri üýtgemegi mümkin, ýagny tekstiň setrilere bölünşigi emma 

ramkanyň ölçegleri saklanylýar. 

Eger simwolara aralygyň üýtgedilşi Shift klawişasyny basyp saklap ýerine 

ýetirilse, diňe sözara aralyklar üýtgediler (ýagny probel simwolynyň ini). Eger 

munuň üçin Ctrl klawişasy ulanylsa netije ters bolar, ýagny simwolara aralyk üýtgäp, 

sözara aralyklar üýtgemez (aşaky surat). Birinji ýagdaýda sözara aralygy üýtgedilen. 

Ikinjide simwolara aralyk üýtgedilen.  

 
Shape (Форма) guraly arkaly setirara aralygy dolandyrmak mümkin 

(interlinýažy). Munuň üçin Shape (Форма) guraly bilen teksti belläp ýokary ugurly 

strelkany dikligine süýşürmek gerek. Aralygy ulatmak üçin görkezijini aşak çekmeli, 

kiçeltmek üçin ýokary çekmeli  

 
Simwollaryň formalaryny üýtgetmek 

Käbir ýagdaýlarda teksti çeperçilik ýagdaýda üýtgetmegi talap edýär. Bu 

ýagdaýlarda tekstiň simwolyny egriniň utgaşmasyna özgertme usulyndan 

peýdalanmaklyk maksada laýykdyr (Aşaky surat). 
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Egrilere özgertmekden öň başda tekstiniň özgerdilmeli bölegini aýry etmeklik 

ündelýär. Eger egri çyzyga özgerdilen simwolyň ölçeginiň üýtgemeginiň 

sinhronizasiýasyny üpjün etmeklik gerek bolsa, ony tekste ýörite simwol hökmünde 

goýmak mümkin.  

 
Knife guraly we obýekti böleklere bölmek 

Knife (Лезвие) guralyň düwmejigi Crop Tool guralyň panelinde ýerleşen.  

Knife (Лезвие) guraly diňe egrileri dälde, eýsem beýleki primitiwleri 

(ellipsleri, köpburçluklary, göniburçluklary, halkaçlary) ýa-da figura tekstleriň 

bloklaryny bölmegi amala aşyrýar we şol obýektler awtomatiki egri çyzyklaryň 

toplumy bolup durýar.  

Guralyň görkezijisi bilen egri çyzyga basylanda onda iki sany düwün emele 

gelýär we ýapyk bolmadyk egri çyzyk iki sany ýapylmadyk egri çyzyga bölünmeýär, 

ýapyk çyzyk ýapylmadyga öwrülýär. Bu düzgünler atributlar panelindäki iki 

düwmejikler arkaly kesgitlenýär (aşaky surat).  

 

 
 

 Leave As One Object (He отделять объект). Bu düzgün işledilende egriniň 

«kesilen» bölegi täze obýekt döredilmeýär (deslapdan), ol diňe başlangyç 

egriniň şahasy bolup durýar.  

 Auto-Close On Cut (Автозамыкание). Eger bu düzgün işledilen, onda guralyň 

işlemeginiň sikli içine bir dälde, egriniň nokadynda iki gezek basmaklygy 

alýar. Şonda şol iki nokady birleşdirýän «kesim» çyzygy egriniň segmenti 

bolup durýar.  

Kesimi ýerine ýetirmek üçin Knife (Лезвие) guraly saýlamaly we onuň 

görkezijisini syçanjyk bilen egriniň nokadyna getirmeli. Görkezijiniň egri bilen 

gabatlaşan ýagdaýynda ol öz formasyny üýtgeder — päkiniň eljagazy dik ýerleşer. 

Eger awtomatiki ýapylyş düzgüni öçürilen ýagdaýda kesimi ýerine ýetirmek üçin 

syçanjyk bilen bir gezek basmaly. Aşaky suratda ýapylmadyk egriniň kesilmeginiň üç 

tapgyry görkezilen: päkiniň egri çyzygyň ýanyna getirilmegi, päkini egriniň 

nokadyna goýulmagy basmaklyk we päkini aýyrmaklyk (kesilýän ýerde biri-biriniň 

üstünde ýerleşen iki düwün görülýär).  

 

Obýekti aýry etmeli däl 

Awtomatiki ýapylyş 
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Awtomatiki ýapylyş düzgüninde gurulýan kesiliş çyzygy hem göni, hem-de 

egri bolup biler (eger iki gezek basylma arkaly ýerine ýetirilse – göni, eger Freehand 

guraly ýaly çyzylsa - egri).  

Eger awtomatiki ýapylyş düzgüni işledilen we kesilen bölekleriň galdyrmagyň 

düzgüni işlenilmedik ýagdaýdaýda bir obýektiň düzüminde ýapyk däl egriniň 

kesilmegi ýerine ýetirilýän bolsa, onda kesilen bölekleriň diňe biri saklanylýar - 

düzüminde iň ahyrky burçlar galýan bölek. Ýok edilýän kesim bölegi kesilmegiň 

dowamynda çal reň bilen görkeziler (aşaky surat).  

 
Obýektleriň kesilmegi (gönükme) 

Bu gönükmäniň maksady — Knife (Лезвие) guraly bilen işlemeklik bilen 

tejribeligi berkitmek. Ony ýetirip biz çaňňalagyň şekili gurarrys.  

1. Ilkibaşda kese ýagdaýdaýda çekdirilen ellipsi çyzyň we ony egri çyzyga özgerdiň 

(aşaky surat, a).  

  
2. Shape (Форма) guraly bilen öňki elipsiň ýokarky we aşaky düwünlerini 

saýlaň we olary ellipsiň ininiň üçden bir bölegine çep tarapa süýşüriň (Ctrl 

klawişasyny basyp saklap). ýokarky surat, b.  

3. Knife (Лезвие) guraly saýlaň we awtomatiki ýapylyş düzgünini işlediň. 

Ikinji düzgüniň düwmejigi basylmadyk bolmalydyr. Guralyň görkezijisini egriniň 

ahyrky çep nokadyna süýşüriň we syçanjyga basyň. Syçanjygyň görkezijisini saga 

süýşüriň (onuň yzyndan bolmaly kesimiň çyzygy hem barar) we görkezijini egriniň 

ahyrky sag nokadyna süýşüriň, we şonda hem syçanjyk bilen ikinji gezek basyň. Egri 

çyzyk iki sany aýry ýapyk egri çyzyga bölünýär (ýokarky surat, ç).  

4. Pick (Выбор) guralyň görkezijisi ýokarky obýekti saýlaň. Transformation 

(Преобразование) penjiresini açyň we onda öwrümi sazlamagyň düwmejigine 

basyň. Öwrümiň merkezini aşaky çep burçda goýuň we öwrümiň burçuny 15° edip 

beriň. Apply (Применить) düwmejigine basylandan soň çaňňalyk gabsasyny açar 

(ýokarky surat, d).  

Eraser guraly 

Bozguç Corel Draw-da beýleki programmalara garanyňda başga rol oýnaýar, 

sebäbi egrilere ulanylanda ol olary pozmaýar-da, diňe formasyny modifisirleýär.  

Aşaky suratda Eraser (Ластик) guralyň atributlar paneliniň elementleri görkezilen.  

 Eraser Thickness (Размер). Bu hasaplaýjyda saklanylýan baha, inedördül 

bozgujyň tarapynyň ölçegini ýa-da tegelek bozgujyň dimaetrini saklaýar.  

d b a ç 
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 Auto-Reduce On Erase (Автосокращенпе). Bu düzgün işledilende bozguç 

bilen işlenede emele gelýän hemme egriler awtomatiki düzlenýär — egriniň 

düwünleriniň sanynyň azalyş düzgüni işleýär.  

 Circle/Square (Форма). CorelDRAW-da iki formaly bozguç göz öňünde 

tutulan— tegelek we inedördül. 

  

 
 

Eraser (Ластик) işledilende we onuň görkeziji görkezilen ýapyk egriniň üstüne 

getirilende CorelDRAW şol egriniň formasyny onuň içine “giren daşky jisimi” 

gurşap alar ýaly modifisirleýär. Aşaky suratda bozgujyň ellipse ulanylan mysaly 

getirilen.  

 
Eger egri çyzygyň abrisiniň formasy üýtgemän galyp, onuň içinde bir deşik 

döretmek gerek bolsa, onda Eraser (Ластик) guralyň görkezijisini obýektiň üstüne 

getirmeli we iki gezek syçanjygy basmaly.  

Eger bozguç bilen işlenende islenmedik üýtgemeler girizilen bolsa, onda Esc 

klawişasyny basyp guraly yza çekiň. Obýektiň formasy dikeler. Emma bu usul 

syçanjyk goýberilmäkä hereket edýär. Syçanjyk goýberilen soň tutuş amaly 

ýatyrmaly bolar.  

Eger bozguç ýapylmadyk egri çyzyga ulanylýan bolsa, onda ol hakykatdanam 

onuň bölegini pozýar. Bozguç bilen tutuş egrini, şeýle hem onuň şahasyny hem 

pozmak bolýar. 

Smudge guraly 

Smudge (Размазывание) guraly – çyrşama amaly amala aşyrýar. Çyrşama — 

bu interaktiw düzgünde egrini ýoýmagy mümkin edýän amal. Amalyň manysy 

obýektiň gyrasynyň elliptiki formaly gural bilen süýşürilmeginden ybarat. Ýoýmagyň 

derejesi we formasy guralyň atributlar panelindäki elementleri arkaly sazlanylýar 

(aşaky surat). Süýşme hem içine hem-de daşyna amala aşyrylyp bilner.  

 
Süýşme hem içine hem-de daşyna amala aşyrylyp bilner (aşaky surat)  

Ölçegi Formasy 

Awto azalyş 

Guralyň ölçegi Guralyň eňňitigi 

Guralyň öwrümi Peseliş koeffisienti 
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 Nib size (Размер инструмента). Bu hasaplaýjynyň bahasy guralyň ölçegini 

kesgitleýär. Ölçeg deslapdan saýlanylan ölçeg birliklerde berilýär.  

 Tilt (Наклон инструмента). Bu hasaplaýjynyň bahasy guralyň gabara 

ölçegleriniň gatnaşygyny kesgitleýär. Gradusda berilýär, 15°-den 90°-a çenli 

aralykda berilýär. Guralyň eňňitliginiň onuň iş böleginiň formasyna bolan täsiri 

aşaky suratda görkezilen.  

 
 

 Bearing (Разворот инструмента). Bu hasaplaýjy guralyň iş meýdanynyň dik 

oka görä öwrülişiniň ululygyny kesgitleýär. Bu parametriň täsiri guralyň 

eňňitligi uly bolmadyk ýagdaýda has güýçli bildirýär. Bu parametriň bahasy 

gradusda berilýär.  

 Add dryout (Коэффициент затухания). Bu hasaplaýjynyň bahasy nola deň 

bolsa, guralyň ölçegi egriden geldigiçe üýtgemeýär. Bu koeffisientiň položitel 

bahalary guralyň peselmegini, otrisateller bolsa — onuň ulamagyny aňladýar. 

Aşaky suratda koeffisient 0-dan 8-e çenli üýtgeýär.  

 
Aşaky suratda koeffisient -1-dan -5-e çenli üýtgeýär. 
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Tejribe işler 

Corel Draw programmasynyň gurallary bilen işlemek 

1) Sahypanyň parametrlerini üýtgetmek 

2) Göniburçlugyň burçlaryny tegelemek 

3) Ellipsleriň, halkalaryň we sektorlaryň çylmak we modifisirlemek 

4) Köpburçluklaryň gurmak we modifisirlemek 

5) Iki goňşy burumyň arasy 1 deň bolan 6 burumdan ybarat bolan halkaç 

gurmak 

6) 9 ujy bolan ýyldyz gurmak  

7) Superçyzyk arkaly ýylanyň suratyny çyzmak 

8) Çyzylan obýektiň ölçeglerini goýmak 

9) Çykaryş çyzyklary 

10) Birleşdiriji çyzyklary gurmak 

 

Corel Draw programmasynda konturlar bilen işlemek 

1) Ellipsiň konturyny redaktirlemek 

2) Tegelegiň konturyny redaktirlemek 

3) Inedördüliň konturyny redaktirlemek 

4) Halkajyň konturyny redaktirlemek 

5) Köpburçlugyň konturyny redaktirlemek 

6) Ýyldyzyň konturyny redaktirlemek 

7) Tekstiň konturyny redaktirlemek 

8) Poliçyzygyň kontury bilen işlemek 

9) Trapesiýanyň konturyny redaktirlemek 

10) Standart figuranyň konturyny redaktirlemek 

 

Corel Draw programmasynda reňk, belleýiş we tekst bilen işlemek 

 

1) Figura tekstiň atributlaryny üýtgetmek 

2) Figura tekstiň bloguny döretmek 

3) Figura teksti girizmek, redaktirlemek we formatirlemek 

4) Ýönekeý teksti döretmek we redaktirlemek 

5) Baglanan ramkalaryň yzygiderliligini döretmek 

6) Ýönekeý tekstiň atributlary üýtgetmek 

7) Tabulýasiýanyň parametrlerini üýtgetmek 

8) Reňk düzgüni üýtgetmek 

9) Tekstiň sütünleriniň parametrini üýtgetmek 

10) Figura we ýönekeý tekstiň özara özgertmelerini amala aşyrmak 

 

Grafiki programmalardan göçürilen maglumatlary bezemek 

1) Garaşsyzlyk baýramyna bagyşlanan banner döretmek 

2) Bitaraplyk baýramyna bagyşlanan banner döretmek 

3) Bahar baýramyna bagyşlanan banner döretmek 

4) Baýdak baýramyna bagyşlanan banner döretmek 

5) Aşgabat şäheriniň içinden bir parçaly banner döretmek 
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6) Gurulýan täze desgalaryň töweregini abadanlaşdyryp surat çekmek 

7) Aýry grafiki suratlary birleşdirmek 

8) Altyn öwüşginli sözleri ýazmak 

9) Bezegli çarçuwalary döretmek 

10) Nyşanlary çekmek 

 

Plotterler bilen işlemek 

1) Plotterleri dogry çatmak 

2) Plotterleri ulgama gurnamak 

3) Çapyň reňkli düzgünini goýmak 

4) Çapyň kagyzyny kesgitlemek 

5) Kagyzyň ugrukdyrylşyny doly saýlamak 

6) Çapyň hilini bellemek 

7) Kagyzyň formadyny bellemek 

8) suratyň kagyzda ýerleşmegini dogurlamak 

9) Plotteriň emeli näsazlyklaryny döretmek 

10) Plotteriň näsazlyklaryny düzetmek 

 

Page Maker, Photoshop, Corel Draw programmalarynda utgaşykda işläp 

maglumatlary biri birine geçirmek usullary 

1) CDR formaty JPG formata öwürmek 

2) CDR formaty PSD formata öwürmek 

3) CDR formaty TIFF formata öwürmek 

4) CDR formaty BMP formata öwürmek 

5) PageMaker-den Photoshop-a geçmek 

6) PageMaker-den Corel Draw-a geçmek 

7) Corel Draw-dan Photoshop-a import etmek 

8) Corel Draw-a Photoshop-dan eksport etmek 

9) Photoshop-dan Corel Draw-a import etmek 

10) Photoshop-a Corel Draw-dan eksport etmek 
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